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Preface

The Federal Emergency Management System (FEMIS) is an emergency management planning and
response tool. The following documents were devel oped to support system users. The audience for each
isidentified.

The FEMI S Installation Guide providesinstructions for installing and configuring the FEMIS software

package.

This FEMI S Data Management Guide provides the information needed to manage the data used to
support the administrative, user-environment, database management, and operational capabilities of
FEMIS.

The FEMI S System Administration Guide provides information on FEMIS system administrator
activities as well asthe utilities that are included with FEMIS.

The FEMI S Release Notes provide a description of what is new in the release, alist of known problems
and workaround suggestions, and any information specific to this release that was not available when
other documents were published.

The FEMISBIll of Materials defines FEMIS hardware, software, and communication requirements.
The FEMI S Online Help System explains how to use the FEMIS program, which is designed to help

civilian emergency management personnel to plan and respond to a Chemical Accident or Incident (CAI)
Event at amilitary chemical stockpile.
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Acronyms and Definitions

ANAD
APR
BOM
COTS
CSEPP
CTOO
D2PC
DAI
DBMS
DEI
DNS
E-mail
EMIS
EOC
ESIM
ESRI
FEMIS
GB
GID
GIS
GMT
HCL
ICG
IBS
IDYNEV
IP

KB
LAN
MB
Met
NFS
NTP
OoDBC
OREMS
PC
PPP
PNNL
RAM
RDBMS
SBCCOM
SMTP

Name of a FEMIS database (Anniston Depot)

Project file format (ArcView GIS)

Bill of Materias

Commercia -Off-The-Shelf

Chemical Stockpile Emergency Preparedness Program
Name of a FEMIS database (Tooel e County)
Chemical wind dispersion model used in FEMIS
Data Acknowledgment Interface

database management system

Data Exchange Interface

Domain Name Services

electronic mail

Emergency Management Information System
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1.0 Overview

The Federal Emergency Management Information System (FEMIS®)@ is an emergency management
planning and response tool that was developed by the Pacific Northwest National Laboratory®™ (PNNL)
under the direction of the U.S. Army Soldier and Biologica Chemical Command (SBCCOM). The

FEMI S Installation Guide providesinstructions for installing the FEMIS software package as well asthe
Commercia-Off-The-Shelf (COTS) software applications that are necessary for FEMIS to operate.

1.1 Point of Contact

We encourage you to contact us with suggestions or to ask questions. Y ou can contact us by mail,
telephone, fax, or E-mail:

Ranata L . Johnson

Pacific Northwest National Laboratory
P.O. Box 999, MSK7-28

Richland, WA 99352

Telephone: (509) 375-6311

Fax Number: (509) 375-3641

E-Mail address: ranata.johnson@pnl.gov

1.2 Document Organization

This document is organized into three sections and two appendices, which include details on the
installation and configuration of FEMIS.

Section1.0 — Overview — describes the point of contact, acknowledgment, document organization,
software products, installation environment and storage requirements, and FEMIS
directory structures.

Section2.0 - FEMISUNIX Installation —describesinstalling the UNIX operating system, the
UNIX-based COTS software, installing the FEMIS UNIX software, and creating the
FEMIS database.

Section 3.0 — FEMIS GIS Migration and Configuration — discusses the installation and configuration
for upgrading the FEMIS GIS from v1.4.5to v1.4.6.

Section4.0 — FEMISPC Ingtallation — discusses the installation, configuration, and validation of the

FEMIS application on client PCs.

(8) FEMIS software was copyrighted in 1995 by Battelle Memorial Institute.
(b) Pacific Northwest National Laboratory is operated for the U.S. Department of Energy by Battelle Memorial
Institute under Contract DE-AC06-76RL O 1830.
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Section5.0 - Remote Evacuee Registration and Point-to-Point Protocol — discusses the Remote
Evacuee Registration feature and establishing and setting up the Point-to Point (PPP)

Section 6.0 — Stand-Alone Installation of FEMIS v1.4.6 — discusses the installation configuration, and
validation of the FEMIS Stand-Alone application.

1.3 Software Products

FEMIS integrates the following COTS software products.

Softwar e Application Softwar e Company

ArcView GIS Environmental Systems Research Institute, Inc. (ESRI)
NFS Maestro Hummingbird Communications Ltd.

Solstice NFS Client Sun Microsystems, Inc.

Microsoft Windows NT Workstation Microsoft Corporation

Microsoft Project for Windows Microsoft Corporation

Oracle Oracle Corporation

SQL*Net, TCP/IP Adapter, and ODBC Driver  Oracle Corporation

Solaris Sun Microsystems, Inc.

FEMIS integrates the following government-furnished software products.

D2PC (February 2000) U.S. Army Soldier and Biological Chemical
Command (SBCCOM)
PARDOS v3.1 (May 1997) U.S. Army SBCCOM

Evacuation SIMulation Moddl (ESIM v2.1f13)  Oak Ridge National Laboratory

The following software products are optional.

ARC/INFO Environmental Systems Research Institute, Inc.
Corel WordPerfect Corel Corporation
Microsoft Office Microsoft Corporation

1.4 Installation
This section discusses the FEMIS environment and storage requirements.
1.4.1 Environment

For FEMISto operate correctly, thefirst step isto ingtall al of the COTS software, including Oracle
v8.1.6 on your UNIX system. FEMIS will not operate correctly if versions of the COTS software other
than those specified in the FEMI S Bill of Material (BOM) areinstalled.
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FEMIS uses SAMBA, NFS Maestro (a Hummingbird Communications Ltd. product), or Solstice NFS
Client (a Sun Microsystems product) as its Network File System for PC network communications. The
NFS Maestro client, Solstice NFS Client, and SAMBA have been tested by PNNL and are compatible
with FEMIS requirements.

Although other vendors may claim to offer afully standard NFS, or Service Message Block (SMB)

emulation, PNNL has not verified and tested any other NFS/SMB configurations for PCs, and thus,
cannot endorse such installations.

1.4.2 Storage Requirements

The FEMIS application requires disk space on both the client and server machines. PNNL has estimated
the disk space requirements for each.

1.4.2.1 FEMIS Server
Disk space on the FEMIS server is used for:

»  Server software (such as, the RDBMS [relational database management system] and the evacuation
model).

FEMIS application.

FEMIS server utilities (notification, database monitor, replication).

EOC databases (including archived and historic data).

Storage of the FEMIS COT S software and the original GIS maps.
The above items can require 15+GB of storage to properly support FEMIS.

There are two sources of disk space associated with a FEMIS server as defined by the FEMI S Bill of
Materials (BOM):

1. System disk(s) resident in the Sun Server.
2. Sun SPARCstorage Array connected to the Sun Server.

As stated in the FEMI S Bill of Materials (BOM), PNNL recommends that the FEMIS storage require-
ment be fulfilled by using arrayed storage disks (StorEdge Array, or an array-like cage system) to ensure
that speed and reliability are provided to the FEMIS operational system. PNNL expects the FEMIS
application to be placed in its entirety on the arrayed storage disks, which will enable the System
Administrators (and PNNL) to better manage the FEMIS product and the EOC databases. PNNL expects
the Sun SPARCstorage Array to be reserved solely for FEMIS use.
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The system disks are not directly used by FEMIS. The disks are used for the operating system and the
supporting applications. PNNL estimates that approximately 2GB of system disk space will be used for
the operating system and swap space. Additional system disk space should be used at the System
Administrator’s discretion.

1422 FEMISPC

Disk space on the client PC isrequired for the following:

» COTS software needed for FEMIS (Windows NT, ArcView GIS, Microsoft Project, Oracle Net8, and
other supporting applications).

*  FEMIS application.
» Site specific GIS maps.
The amount of space required by the FEMIS application and supporting software will vary depending on

the size of the GIS the user choosesto install. A FEMIS with a medium size GIS installation requires
approximately 900MB of disk space, COTS included.

1.4.3 Pre-installation Issues

Before you proceed with the ingtalation of FEMIS v1.4.7, the following are pre-installation issues that
should be addressed.

* Remove obsolete data such as unneeded exercises and obsol ete user accounts.

* Make sure your system has been backed up.

* Remove obsolete D2PC archive cases.

» Clean up any obsolete server data such as obsolete versions FEMI S packages.

» If ageneral hazard zone theme has not aready been added, the general hazard zone must be added
inv1.4.6. prior totheinstallation of FEMISCOTSand FEMISinv1.4.7. Existing General Hazard
functionality is supported in FEMIS v1.4.7; however, the scripts to add a general hazard zone theme

are not supported in v1.4.7. If you will be adding the County Zone layer, seethev1.4.6 FEMIS
Installation Guide, Section 5.0, Adding General Hazard Zones to the FEMIS Database.

1.5 FEMIS Directory Structures

The following figuresillustrate the FEMIS directory structure on the UNIX server and the directory
structure for an emergency management PC workstation.
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2.0 FEMIS UNIX Installation

The UNIX server isthe primary data and information storage and distribution component. Its primary
software elements consist of the Oracle database management system (DBMYS); the Evacuation
SIMulation (ESIM) model with supporting processes; the Notification Service; the command server; the
meteorology (Met) datareceiver; the FEMIS/IEMIS Data Exchange Interface (DEI); and the sockets
communications service.

The programs discussed require the UNIX environment on a Sun computer running Solaris 7 and
utilizing standard Berkeley or Berkley-like Sockets.

The FEMIS UNIX software installation consists of six major parts:

* Installing the UNIX Commercia-Off-The-Shelf (COTYS)
* Installing the FEMIS UNIX Software

e Ingtalling the FEMIS GIS and Database

e Checking the FEMIS Startup

» Utility to Add FEMIS User Account to the Database

* FEMIS AutoRecovery System.

The release media consists of files distributed on CDs, 8mm cartridge tapes, and on occasion, floppy
disks. Therelease materia contains the necessary scripts and data to perform an initial installation or to
upgrade existing FEMIS software to the current version. The Release Notes should be read before
proceeding with the UNIX installation.

The FEMIS package consists of the following:

« COTSCD
* FEMIS application tape
* Suite of FEMIS documentation.

In addition to the FEMIS package, the Sun Solaris 7 (SunOs 5.7) and Oracle media are necessary to
complete the UNIX ingtallation of FEMIS.

This guide iswritten assuming that your EOC isusing local host network files. If your EOC is using
some other facility, i.e., NIS/NIS+, then those facility-specific commands must be used.

@ per Sun's Release Notes (5/99), Solaris has changed the name of their latest release to Solaris 7 (SunOs 5.7)
instead of Solaris2.7. The FEMIS Bill of Materials (BOM), released on March 3, 2000, listed Solarisv2.7 as
required server software. For more information, see Sun’s web site —
http://docs.sun.com:80/ab2/coll.385.1/ @Ab2ColView?Ab2L ang=C& Ab2Enc=iso-8859- 1
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2.1 Installing and Configuring the UNIX COTS

It isimportant to coordinate the UNIX group numbers between FEMIS and other software applications
that are administered with NIS+. Possible conflicts may result in the FEMIS /etc/group file. To see
which group numbers are currently used for NIS+, use the following command while logged in as root:

niscat group.org_dir

If you are installing from a pre-existing NT account, then the corresponding UNIX account must be a
member of the UNIX femisrun group on the server. Also, when using the NIS/NIS+ dB, be sure the
letc/nsswitch.conf fileis properly configured to consult files aswell asNIS. FEMIS may still have
portions that expect entriesin the host files. Primarily, these are FEMIS specific entries in the
letc/passwd file and its components (shadow). The /etc/group fileis not specifically consulted, but any
group membership changes done for the current install user need to be done according to how the
nsswitch.conf is configured.

The following sections describe the installation of the UNIX COTS.

2.1.1 Installing the Operating System

STOP

Those sitesusing the Sun Volume Manager or Disksuite softwar eto manage disk arrays, that
wish to maintain array configuration and data throughout the Operating System (OS) upgrade,
may need to follow special instructions PRIOR to upgrading Solaris.

For upgrading the Volume Manager Softwaretothecurrent VERITAS Volume Manager,
specific instructions have been provided in Section 2.1.2, Upgrading Sun Volume M anager
Software.

For Sun Disksuite, consult your vendor supplied documentation prior tothe OS upgrade.

For installation or upgrade instructions, see the documentation provided with the operating system.
Additional installation information is available on the FEMIS Web site at http://www.pnl.gov/femis under
the Technical and User Support section.

Follow the instructions included with the Solaris 7 documentation. Section 2.1.1.1, Installing or
Upgrading Solaris 7, provides additiona information regarding the Solaris 7 installation process. If the
guantity of server customizations is considered large, the upgrade option is recommended. If server clean
up is preferred, then the new ingtall option can be taken instead of upgrading an existing installation.

Note: Installing operating system patches will require relinking the Oracle software. See
Section 2.3.3.4, Relinking the Oracle Software.
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Solaris Versions, Maintenance Updates, and Patch Clusters

FEMIS was tested on a Solaris 7 5/99 release with patch cluster updates noted below. Solaris 7 field
installations are encouraged to be the 5/99 release or |ater.

FEMIS was not tested on any particular Maintenance Update of Solaris 7. If asitedesiresto install a
current stable Maintenance Update, conflicts with Solaris Maintenance Updates and FEMIS are not
anticipated.

We have tested FEMIS v1.4.7 using the March 2000 patch cluster. Because all operating systems require
patches to improve security and fix bugs, PNNL strongly recommends installing Sun’s Solaris 7 patch
cluster. The Solaris 7 patch cluster does not always include all patches that may be preferred for
complete system functionality. Individual patch README files contain additional information regarding
related patches that may be desired for complete fixes to reported problems. Additionally, certain
hardware platforms may require specific patches that are not included in the patch cluster. Please consult
Sun Solaris documentation, specifically installation rel ease notes and Solaris™ 7 ... Release Notes
Supplement for Sun™ Hardware and/or Sun’s Web site http://sunsolve.sun.com for further information.
The patch cluster is strongly recommended as a minimum patch set for each system. This cluster is
typically updated twice a month by Sun Microsystems. Refresh installations of the patch cluster are
recommended on a periodic basis particularly for security enhancements.

If the patch cluster is not available, the following five patches must beinstalled for FEMISv1.4.7. Use
showrev —p to list your existing patches.

Kernel patch — 106541-10 or greater (requires quiescent system — see README)
Patchadd/patchrm patch — 107171-05

Cron patch — 107451-02

fsck patch — 107544-03

X Input & Output Method patch - 107636-03 or greater

Note: Check our web site (www.pnl.gov/femis/) for updates on patches that we have tested.
Volume Manager/Storage Array Firmware
PNNL iscurrently using VERITAS Volume Manager v3.0.2.
VERITAS Volume Manager v3.0.2 requires the Sun libthread patch 106980-05 (-10 is the latest at the
time this was written) and the Sun kernel patch 106541 (-10 isthe latest at the time this was written). The
106980 patch must be downloaded and installed separately after the cluster upgrade is completed asit is

not part of the Solaris 7 patch cluster.

Solaris 7 requires SPARC Storage Array (SSA) firmware to be at v3.12. To verify your current version,
use ssaadm display <controller> (where <controller> is the controller number, such asc1).
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If the SSA firmwareisnot at v3.12, it must be upgraded. This can be accomplished during the Solaris 7
upgrade process, after the upgrade is complete, but befor e rebooting the new Solaris 7 kernel.

If the boot disk isa SSA disk, seethe Solaris7 ... Sun™ Hardware Platform Guide section titled
“Installing the Solaris Operating Environment With the SPARCstorage Array” for further information.

To upgrade the SSA firmware,
1. Enter the following command:
ssaadm download —f /usr/lib/firmware/ssa/ssafirmware <controller>)
where <controller> is the controller number, such ascl)
Note: DO NOT INTERRPUT THE ABOVE COMMAND FOR ANY REASON!
2. Halt the system with /usr/sbin/init 0.
3. Click the SYS OK button on the back of the SSA(S) to reset.
4. Wait for the SSA to complete POST.
5. Boot the system by typing boot at the system ok prompt.
Patch Locations
Those patches discussed above and other patches are available from SunSolve Online at

http://sunsolve.sun.com/ or the SunService Public Patch Page at ftp:// metalab.unc.edu /pub/sun-info/sun-
patches.

2.1.1.1 Installing or Upgrading Solaris 7

For those sites desiring to do new installs of Solaris 7, rather than upgrading the existing Solaris v2.6, and
upgrading the current FEMIS ingtallation, rather than doing anew FEMIS install, severa steps must be
taken prior to the Operating System Installation to alow the upgrading of FEMIS later.

To accomplish the FEMIS upgrade, the FEMIS and various other packages must be removed prior to the
Operating System upgrade. The skeleton directories left must be preserved prior to the Solaris 7 new
install, and then restored to the system after the Solaris 7 ingtall so that the FEMIS upgrade can be
completed.

AutoRecovery and AutoRecovery Web reporting (if installed) must be removed. Y ou may wish to save
the /opt/local/bin/femis_watch.conf file for configuration of the new AutoRecovery package later. If the
lopt/local/bin/femis_watch.conf is saved for later, please be awarethat it is not a drop-in replacement for
the femis_watch.conf filein the new package. It isto be used for reference only.
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To remove AutoRecovery, complete the following steps.

1

Login asroot, and enter the following command.

# pkgrm FEM | Sar

To remove AutoRecovery Web Reporting, see Section 2.7.2.1 Removing the AutoRecovery Web
Reporting Package.

To continue preparing your system for a new installation of Solaris 7 and the upgrading of your current
version of FEMIS, complete the following steps.

1

5.

6.

Complete only Section 2.2.2, Upgrading the FEMIS Application. Make sure the <backupdir> created
in this step will bein an area or on a device unaffected by the Operating System installation.

Save what is left of the /home/femis directory tree to another disk or device that will be unaffected by
the Operating System installation. Use tar or ufsdump to save the image so file times are preserved.

Remove the Perl package. See Section 2.1.6.1 Removing the Perl Package.

Save the /var/opt/oracle directory tree to another disk or device that will be unaffected by the
Operating System installation. 'Y ou may wish to preserve the /apps/oracle tree (minus the product
directory) if it ison a partition that may be affected by the Operating System installation.

Complete the new Solaris 7 per the vendor’ s documentation.

Restore the trees saved in Steps 3 and 5 above as appropriate.

For those sites where an Operating System upgrade will occur, rather than a new installation of Solaris 7,
PNNL recommends the following method for disk partitioning and preserving data while running the
installation/upgrade program for Solaris 7.

1

2.

Use ufsdump to backup your file systems relating to the Operating System prior to upgrading.

Edit the /etc/vfstab file and comment out any entries relating to swap files (not swap partitions) and
storage array file systems.

Boot the Solaris 7 CD-ROM which launches the interactive installer.
Follow the prompts and/or instructionsto install/upgrade. Select no network unless you are

upgrading from aremote install/jumpstart server or booting from the network, then the server needs
to be considered networked.
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5. Check if the 64-bit button has been selected. If so, thisindicates your system can support running the
64-bit kernel. It will not be selected on systems where greater performance may not be realized, and
it will be grayed out (not selectable) on systems where the 64-bit kernel can not be run at al.
Selection, as allowed, isup to theinstaller.

Selecting the 64-bit support only means that the 64-bit support (i.e., for 64-bit application
development) will beinstalled. Even with 64-bit kernel support installed, the default kernel booted
will be the one supported by your hardware (as determined by the bootstrap software).

If the current partitions are sized correctly for Solaris 7 and the requested packages, then the installation
will complete without interruption.

If disk partitions are not large enough according to the interactive installer program’ s calculations, then
the More Space Needed window will display.

1. Select the Auto-layout button, and allow it to calculate the necessary new sizes. If Auto-layout
requires constraints to be changed, continue using it as atool to plan the correct layout and sizes.

Note: Do not allow Auto-layout to make partition backups and new layouts.

2. Make anote of the current partition size(s) and recommended new size(s). Exit the interactive
installation program at thistime.

3. Open acommand window and dismount the affected volumes that were mounted by installation
program.

3. Repartition and resize the disk layout or partitions using the command-line format tool (see the man
page on format) as recommended by the previously suggested sizesin Step 1.

4. Adjustment the swap partition, if desired.

5. Create new file systems on the affected partitions and remount the new partitions back on to the
installation file system.

6. Use ufsrestore —rf <dumpfile> to restore the affected file systems (backup previoudy created) onto the
new disk partitions.

7. Mount or go to the partition containing the actual system’s root file system. Edit the vfstab fileto
reflect any device changes made in Steps 3-6.

8. Remove any restoresymtable files created by ufsrestore, and dismount all file systems under the /a
path.
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9. Right click in the background workspace area, and select Restart Install. Proceed through the
installation process as prompted. Y ou may have to start from the beginning again, however, if disk
space partitions were correctly assigned, the upgrade should continue without error.

Partitioning

Separate partitions are not absolutely necessary for /, /usr, /var, and /opt. They can be combined into
one/ partition or split into various subsets. The /usr is static and does not usually contain dynamic data;
fvar is used for logging and temporary aress, so it grow considerably; and /opt is for optional software
package installations, so its size depends on the planned usage of the server.

The following packages are not functionally required in case of space limitations:

» Packages pertaining to manuals, especially developer manuals and/or software.
* DHCP server if not used by clients.

» developer profiled libraries

» Unnecessary device drivers (this may not be easily determined, use discretion).
* Documentation tools

* International locale and font support

»  Font server software (if not used)

* NISsupport (if not used — basic packages can not be desel ected)

* demos (binaries and software)

PCMCIA support (if not used)

e Point-to-point protocol (if not used)

»  Power management utilities (if not used)

*  Programming tools and libraries

WEBNFS (if not used)

» others(site dependant and based on Installer experience)

All packages not installed at upgrade time can be installed later if desired using avariety of package
management tool ¢/software.

Patching and Patching Order (see Array notes above)
The following patches must be installed.

e 106541 — requires quiescent system
e 107171-05 — isnecessary to correct certain patch order problems when installing cluster patches.
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32/64-bit Kernel and Firmware Updates
Flash Prom updates apply only to the following systems (output from “uname —i):

*  SUNW, Ultra-1
*  SUNW, Ultra-2
+  SUNW, Ultra-4
*  SUNW, Ultra-Enterprise

Prom version level can be determined with “prtconf —V".

If aFlash Prom updateis required, Solaris 7 will prompt you upon boot-up. Special stepsto write-enable
the Flash Prom are required, and the procedure to do this differs between hardware platforms. Inthe
Solaris 7 documentation, Solaris 7 ... Sun™ Hardware Platform Guide, see the section entitled
“Updating the Flash Prom on the Ultra 1, Ultra 2, Ultra 450, and Sun Enterprise 450 Systems’ (Chapter 4
in 5/99 rel ease documentation).

Utilities

Solaris 7 now incorporates traceroute and zip as bundled utilities. traceroute used to be added to the

system during installation. The PC utility called PK-Zip was re-written and released for multi-platform
usage. All patchesfor Solaris 7+ will be shipped in Zip archive format.

2.1.1.2 Automounting and FEMIS
Note: Using the automounter is optional, but strongly recommended by PNNL.

If FEMIS v1.4.5 or higher has successfully been installed, then the automount points
should have been set up. Review this section to verify they were set up correctly.

This section isintended to be an overview of automounting. Specific automounting instructions are
located in the following sections.

FEMIS uses the automounter scheme to automatically and transparently mount file system resources for
both home and application directories. The automounter uses a series of maps to define the file resources
to be mounted. Setting up the automounter consists of defining the maps and starting the automounter
program.

Master Map

The master map islocated at /etc/auto_master. Thisfile providesalist of al maps on the system. Itis
read by the automounter daemon at system startup. The map for FEMIS looks similar to the following.
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/net -hosts -nosuid,nobrowse
/home auto_home
lapps auto_apps
Ixfn -xfn

Indirect Maps

Indirect maps are used to mount file resources under a common directory. FEMIS needs two indirect
maps for automounting: 1) /etc/auto_apps and 2) /etc/auto_home. The map, /etc/auto_home, contains
the entries of the UNIX user login accounts to be mounted under /home. The indirect map for
letc/auto_home must look similar to the following.

Note: The current site map should list users and directory paths at your site. Remember to
replace system# with the name of your server. The hostname localhost may also be used
as the server name for directory structures collocated on the same server®.

femis -intr,rw,nosuid system1:/files3/home:&
femx -intr,rw,nosuid system1:/files3/home:&
usera -intr,rw,nosuid system1:/files5/home:&
userb -intr,rw,nosuid system1:/files5/home:&
userc -intr,rw,nosuid system1:/files5/home:&
userd -intr,rw,nosuid system1:/files5/home:&
usere -intr,rw,nosuid system2:/files5/home:&

The /etc/auto_home map gives us a consistent view of home directories across a network. All home
directories, whether remote or local, are mounted under each server’s /home directory. Asan example, a
UNIX account for usere, which has a directory on system2 on partition /files5/home/usere, is mounted at
/home/usere on the current system.
Theindirect map for /etc/auto_apps should look similar to following.

oracle -intr,rw,nosuid systeml:/files2/app:&

Automounter Map Availability

Changesto indirect maps are available right away. Changes to the /etc/auto_master are effective only by
restarting the automount daemon.

# /etc/init.d/autofs stop
# letc/init.d/autofs start

(®) Theterm localhost must be used carefully when the automount map is distributed viaNIS/NIS+ in a
multiple server configuration, or where PC clients can interpret NIS automount map information.
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Note: Automount cannot reflect new file systems in cases where the currently automounted file
system is moved out from underneath an actively automounted file systemin lieu of a
replacement file system. To replace a mapped automount file system, make sure no
processes are active in the automount tree by using fuser -nc <auto_mount_path>, and
that automount has rel eased the mount point before changing an automounted file system.

FEMIS Users

Note: Actual UNIX user accounts are created as needed. Steps are provided to create accounts
for Oracle and the FEMIS application in their respective installation sections.

If the automounter is being used, an entry is necessary in /etc/auto_home, for each new FEMIS user
added to the system. See Indirect Maps section above for more information. For additional information
on automounting and automount maps, see the man page on automount and the Solaris documentation.

2.1.1.3 Creating Users and Groups

This section provides an overview on guidelines and instructions for creating FEMIS UNIX user accounts
and groups on your server. Specific instructions are supplied in the Section 2.2.1, Creating UNIX
Accounts on the Server.

The following information is required to create a UNIX user account:

Username

User Identification Number

Group Identification Number or Name

User’'s home directory location (usually /home/<user>)
Preferred user shell (usually /bin/csh)

Password

Usernames
Note: The UNIX username must be the same as the corresponding Windows NT username.

Usernames, or login names, will allow the user to access the server with the appropriate access privileges.
A username should be

Unique within the organization

Contain two to eight letters or digits

One character must be lower case

First character must be a letter

May not contain a space or anew line (\n).
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User Identification Numbers

A user identification (UID) number is assigned to each username. It identifies the user to the system and
controls accessto files and directories. UIDs have several requirements:

UIDs must be unique for each user.
UIDs must be whole numbers between 100 and MAXUID (defined in /sys/param.h>).

Since many employers assign employees with unique employee numbers, System Administrators can use
or manipulate employee numbersto get unique UIDs in the appropriate range. UIDs, along with the rest
of the username data, is stored in the /etc/passwd file.

Password

Note: PNNL recommends that the UNIX password be the same as the corresponding Windows
NT password if NFS Maestro or SUNWpcnfd are being used at your site. Thisisnot a
requirement if Sambais being used on the UNIX server, and it is authenticating to the
same domain/NT server as the PC (assuming domain and/or Windows NT server
authentication isin use).

Each username must be assigned a password. Passwords have a big impact on systems security so follow
these minimum conventions when creating passwords. Passwords should

Be six to eight charactersin length

Include at least one digit or specia character such as $, &, #

Differ from the user login name

Be changed often

Avoid proper nouns, or any word a person could guess by knowing you
Avoid words found in the dictionary

Avoid Socia Security numbers, phone numbers, and car license numbers.

Group Identification Numbers

A group is acollection of users who share files and other resources. Each group has a group hame, a
group identification (GID) number, and alist of usernames that belong to the group. A primary group is
the group the operating system will assign to files created by the user. Each user belongs to one primary
group. The primary group must already exist when adding anew user.

User Home Directory

The user’s home directory is the space on the disk that is alocated for auser. Usethe full path name or
see Section 2.1.1.2, Automounting and FEMIS, if automounting home directories.
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Creating FEMIS User Accounts

All FEMIS accounts must be members of the UNIX group femisrun. The femisrun should aready exist
prior to adding users. See Section 12.1, Operating System Security, in the FEMI S System
Administration Guide for more information.

Note: Theuser ID listed below isan example only. Select auser ID that is unique for your
EOC.

1. Createthe UNIX user account.

# lusr/sbin/useradd -u NEWUID -g femisrun -¢ “A Name”-d login_directory_path -s /bin/csh
login_name

Example:
# lusr/sbin/useradd -u 4000 -g femisrun -c “John Doe” -d /filesl/home/jdoe -s /bin/csh jdoe
If automounting, the login directory path should be /home/login-name.

2. Create the appropriate home directories for the newly created accounts.

# mkdir -p login_directory_path
# chown login_name:femisrun login_directory _path

3. Set the account password.
# passwd login_name

If you are using the automounter, make the appropriate entry in the /etc/auto_home file. See
Section 2.1.1.2, Automounting and FEMIS, for more information.

For additional information on UNIX user accounts and groups, see the man pages on useradd, groupadd,
and passwd, as well as the Solaris documentation.

STOP

If AutoRecovery has previoudy been installed on the server and FEMIS, Oracle, or UNIX
COTS softwarewill beinstalled or upgraded, AutoRecovery MUST be stopped until the UNIX
installation is complete.

To stop AutoRecovery, edit the root crontab file and comment out the lines pertaining to AutoRecovery.

1. Loginasroot.
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2. Enter the following:
crontab -e

3. Comment out the lines following ##FEMISar.
Example:

##HFEMISar

#0**** | D_LIBRARY_PATH=$LD_LIBRARY_PATH:/files2/app/oracle/product/8.1.6/lib; export
LD_LIBRARY_PATH; /opt/local/bin/femis_watch > /dev/null 2>&1 #FEMISar

#30*** 1-5 LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/files2/app/oracle/product/8.1.6/lib; export
LD_LIBRARY_PATH; /opt/local/bin/femis_watch > /dev/null 2>&1 #FEMISar

#10,20,40,50 7-18 * * 1-5
LD_LIBRARY_PATH=3$LD_LIBRARY_PATH:/files2/app/oracle/product/8.1.6/lib; export
LD_LIBRARY_PATH; /opt/local/bin/femis_watch > /dev/null 2>&1 #FEMISar

#0 0 * * * sh /opt/local/bin/logit > /dev/null 2>&1 #FEMISar

When you have completed the UNIX installation process (upgrade or fresh install), be sure the linesin the
crontab file are uncommented and updated according to new paths. AutoRecovery isthe last UNIX item
to beinstalled/upgraded. Installation and upgrading instructions for AutoRecovery are in Section 2.6,
FEMIS AutoRecovery System Description and Installation.

2.1.2 Upgrading Sun Volume Manager Software

Note: Start the process of obtaining licensing (lead-time up to 5 working days). Current Sun
Volume Manager 2.5 license should move across, but a hardcopy version of thelicenseis
prudent in case the system needs to ever be rebuilt from scratch. Seeinstructionsin
VERITAS Volume Manager for Solaris I nstallation Guide section titled “ Obtaining a
License Key” for further information. The VERITAS product information (software
serial number) is packaged separately in a sealed envelope.

This section only includes instructions for upgrading Sun Volume Manager v2.5 software on Solaris v2.6
to VERITAS Volume Manger v3.0.2 on Solaris 7. For new installations and setup of the VERITAS
software or differing Operating System requirements, see the documentation and licensing supplied with
VERITAS.

Note: Theinstructions below must also be done prior to upgrading from Solarisv2.6 to
Solaris7.

To upgrade Sun Volume Manager v2.5 software on Solarisv2.6 to VERITAS Volume Manger v3.0.2 on
Solaris 7, compl ete the following steps.
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1. Backup the data on your system in single user mode, particularly the data located on the Storage
Array and /usr/lib.

2. Backing up the complete system using ufsdump to preserve file times.

3. Make surethat at least one plex for each of these volumes (if any of the file systems/, /usr, /var, or
/opt are defined on volumes) is formed from a single subdisk that begins on a cylinder boundary. See
VERITAS Volume Manager for Solaris | nstallation Guide section titled “Upgrading to VXVM
3.0.X and Solaris 2.5.1/2.6/7" for further information.

4. Load and mount the CD-ROM installation media. SPARC1000 (and possibly other older) server
CD-ROM drives may not read the VERITASv3.0.2 CD. In these casesit may be necessary to read
and dump the installation CD to some other medium (network or removable) from a system with a
newer CD-ROM drive, which is done to gain access to the installation software.

5. Runthe upgrade_start script to prepare the previous release of the VVolume Manager for removal.
upgrade_start islocate at <installation software path>/scripts/upgrade_start.

6. Change directoriesto /var/sadm/patch. Using the Is command, determine if you have any versions of
patch number 105463-xx are installed on the system. If they have been installed, they must be
removed. If multiple versions of the same patch exist, they must all beremoved. Remove the
highest numbered revision first, then the next, and so on.

7. Reboot to single user mode using the command init S.

8. Remove the following packages, if they are installed:

SUNWassa, SUNWvmman, , SUNWvxvm, SUNWvmdev, SUNWasevm
This can be accomplished on asingle pkgrm line:
# pkgrm SUNWassa SUNWvmman SUNWvxva SUNWvmdev SUNWasevm

9. Edit the /etc/vfstab file, and comment out any storage array lines under V olume Management control.

10. Reboot to the Solaris 7 installation media, and proceed with the Solaris 7 installation/upgrade.

11. Reboot to single user mode using the command init S.

12. Access/mount the VERITAS installation software, and add the VxVM 3.0.2 package:

# pkgadd —d <installation software path>/<OS_version>/pkgs VRTSvxvm

If this returns warnings that include the string /etc/vx, ignore them and continue.
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13.

14.

15.

16.

17.

Compl ete the upgrade by entering:
# <installation software path>/scripts/upgrade_finish
Edit the /etc/vfstab file, and uncomment the previously commented lines from Step 9.

Reboot to multi-user mode. Note any errors during reboot regarding drv/atf and drv/ses. If any errors
occur, edit the /etc/system file once the system is booted, and comment the lines at the end of the file
regarding the driversthat had errors. In /etc/system, a comment line begins with an asterisk (*). Be
sure to comment only those lines in the file relating to the force load errors recorded during boot.
These devices may be necessary for functionality beyond the scope of this section that is added and
configured at alater date. If this situation is planned, the lines can be uncommented later, or left asis
until the VERITAS configuration is complete.

Using pkgadd, install any or al of the additional packages VRTSvmsa, VRTSvmdoc, VRTSvmman,
and VRTSvmdev.

Note: Importing apre-3.x Volume Manager disk group does not automatically upgrade the disk
group version to the VXVM 3.x level. You may need to manually upgrade each of your
disk groups following aVxVM upgrade. See the section on disk tasksin the VERITAS
Command Line I nterface Administrator’s Guide for information on how to upgrade a
disk group.

Follow the instructions in the VERI TAS Volume Manager for Solaris I nstallation Guide for
“Setting Up and Starting the Storage Administrator”.

2.1.3 Installing and Configuring Samba

Note: Disable and/or remove any previous versions of Sambafrom the system. Save the old
configuration file for reference.

Samba may exist on a system in one of two forms.

It can be launched in a stand-alone mode in which case it isinitially started by /etc/init.d startup
scripts. To disablein this case, simply remove or rename the Samba startup scripts, and kill al smbd
and nmbd processes.

The other form islaunched from the inetd daemon. In this case, the startup lines must be temporarily

commented out of the /etc/inetd.conf file, and inetd signaled to reread its configuration file with akill
—HUP <inetd pid>. Then kill all smbd and nmbd processes on the system to disable.
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The location of the origina configuration file can then be determined either from the startup scripts or the
inetd.conf file. The smbd and nmbd binaries usually reside in a bin directory under the Samba main
installation root. The old configuration file will be typically located under the lib portion of thistree and
iscalled smb.conf. There may be additional information worth saving in the lib branch, so saving this
entire directory for future reference is recommended.

Be sure to create an automount location entry for /apps/samba. For example: in /etc/auto_apps:

samba -intr,rw,nosuid localhost:/vol02/app:&

Note: Be sure/vol02/app/samba exists. Createit, if necessary.

2.1.3.1 Installing Samba
Note: Wheninstalling a FEMIS package from the spool directory, it is possible to receive a Sun
Package installation error, Broken Pipe. Thiserror happens when the last package in the
list is not selected for installation. This error will not cause any problems with the
FEMIS installation. Continue with the installation.
Toinstall Sambav2.0.6, complete the following steps.
1. Loginasroot, and insert the FEMIS application tape into the tape drive.

2. Create atemporary spool directory.

# mkdir /<dir>/spool
# chmod 755 /<dir>/spool

3. Spool theinstallation package from the 8mm tape using the Solaris software install ation utility.
# pkgadd -s /<dir>/spool -d /dev/rmt/??

where ?? isthe device number of the tape drive. Select the packages desired and run the pkgadd
utility to install the FEMIS package.

# pkgadd -d /<dir>/spool
4. Select the Samba application for installation.
5. Answer the guestions as prompted:

» Thesource isthe original Samba source tree (unconfigured).
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TheWindows NT Domain will only apply to those sites using NT Domain services. Enter
anything if your siteis not using this capability.

The WINS address isan IP address of aWINS server. Enter d if you are not using this capability
at your site.

Enter the actual absolute path name for the automounted location of /apps/samba. For example:
Ivol02/app/samba as taken from the automount entry exampl e above.

6. Select y to continue when the following prompt displays. This package contains scripts which will be
executed with super-user permission during the process of installing this package.

7. Select g to quit after installing the Samba package.

8. Use pkgchk to verify the package was installed correctly.

# pkgchk -n SAMBA

If you only see the above output or get a prompt with no output, the package installed successfully.
Continue with the installation by configuring Samba.

2.1.3.2 Configuring Samba

Samba configuration can get quite complex because of the flexibility the software offers. Please refer to
the man page on smbd.conf for other options and combinations. A template configuration file is provided
by the package installation which will set up basic parameters and define basic FEMIS shares. However,
manual configuration isinevitable in order to bring the prior version’s definitions into place for
compatibility.

1. View the/etc/samba/smb.conf file. Edit the template as necessary according to your site specific
requirements. If you need to bring in configuration from a previous version of Samba, do that here.
Pay particular attention to the values for the following parameters:

hosts allow is set according to your site’ s subnet configuration.

security and password server are set according to the authentication method in use at your site
(domain, NT server, local smbpasswd, or UNIX). Edits done at thistime will override entries
requested by the package install scripts. Thiswill allow EOC customization beyond what the
default package installation deals with.

Uncomment the interfaces lineif you are running more than one interface on your server
(machineis arouter) if you want Sambato present itself on al interfaces. The device designation
le0...n isassumed, but can be changed to hme0...n (hme*) for those sites so configured.
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» Besurethe share entries for femis, femis_user, and user reflect the correct path for your site. The
rest of the configuration for these entries is recommended to remain as shipped.

2. Test the configuration by running the Samba testparm program.

This program will report on the currently defined configuration. It will point out any configuration
errors, and report assumed default values for the whole configuration. If this program does not return
errors, proceed to the next step. If it does, review and correct the configuration file and re-run
testparm.

# lapps/samba/bin/testparm

Load smb config files from /etc/samba/smb.conf

Processing section "[homes]"

Processing section "[printers]"

Processing section "[femis]"

Processing section "[femis_user]"

Processing section "[user]"

Loaded services file OK.

WARNING: You have some share names that are longer than 8 chars
These may give errors while browsing or may not be accessible
to some older clients

Press enter to see a dump of your service definitions

3. Join your Windows NT domain (if applicable):

Tojoin an existing NT domain, an entry containing the NetBIOS name of the server must be added to
the NT domain on the Primary Domain Controller using Server Manager for Domains.

Once the above is complete, enter the following command on the Samba server:
/apps/samba/bin/smbpasswd —j <domain_name> -r <primary domain controller>
Y ou should receive the following response:

<date/time stamp>: change_trust_account_password: Changed password for domain
<domain_name>.
Joined domain <domain_name>.

4. Enable Samba viathe /etc/inetd.conf configuation file. The package installation will have added new
lines to the /etc/inetd.conf file which specifies the Samba daemon startup. Signal inetd to reread its
configuration file to launch Samba.

# ps —ef | grep inetd
# kill -HUP <inetd pid>
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5. Verify client connectivity by attempting to connect to one of the default new shares defined in the
smb.conf file from a PC.

Samba source files are distributed with this installation and are located at /apps/samba/source if installed.
Under /apps/samba/source/docs is useful information regarding Samba operation and use, especialy in
integrating with Microsoft Windows environments. In addition, Samba provides detailed UNIX manual
pages on its primary components which are included with the package and are located under the default
path /apps/samba/man. Further information and up-to-date news regarding Samba can be obtained from
the Samba Web site: http://www.samba.org/ (locate a close mirror site from there).

2.1.4 Installing the NFS Authentication Services Daemon

For FEMISv1.4.7, either NFS Maestro v 6.1 or Sun PC NFS v1.2 can be installed as the authentication
service daemon. The following sections provide installation instructions for both NFS packages.

Note: If you have an older version of the NFS Maestro or Sun PC NFS package on your server,
you must removeit. If the NFS software wasinstalled manually (no packages were

used), determine from the entriesin /etc/init.d the location of the software and remove it
along with its start/stop scriptsin /etc/init.d and/or /etc/rd#.d directories.

2.1.4.1 Determining Version of NFS Daemon

If you do not know if NFS Maestro or Sun PC NFS has been installed as a package on your server, enter
the following commands:

# pkginfo -l HCLNFS
# pkginfo - SUNWpcnfd

2.1.4.2 Removing Previous NFS Daemon
To remove the old version of the NFS Maestro or Sun PC NFS package, enter the following commands:

# pkgrm HCLNFS
# pkgrm SUNWpcnfd

2.1.4.3 Installing Hummingbird NFS Daemon
Note: Wheningtalling the FEMIS package from the spoal directory, it is possible to receive a
Sun Package installation error, Broken Pipe. This error happens when the last package in
the list isnot selected for installation. This error will not cause any problems with the

FEMISinstallation. Continue with the installation.

The Hummingbird NFS Daemon (NFS Maestro v6.1) has been included with FEMISv1.4.7. Toinstal
the NFS Daemon, compl ete the following steps.
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1. Loginasroot, and insert the FEMIS application tape into the tape drive.

2. Create atemporary spool directory.

# mkdir /<dir>/spool
# chmod 755 /<dir>/spool

Spool the ingtallation package from the 8mm tape using the Solaris software installation utility.
# pkgadd -s /<dir>/spool -d /dev/rmt/??

where ?? is the device number of the tape drive. Select the packages desired and run the pkgadd
utility to install the FEMIS package.

# pkgadd -d /<dir>/spool

3. Select the HCLNFS application for installation.

4. Select y to continue when the following prompt displays: “This package contains scripts which will
be executed with super-user permission during the process of installing this package.”

5. Select g to quit after installing the HCLNFS package.

6. Use pkgchk to verify the package was installed correctly.
# pkgchk -n HCLNFS

7. Ignorethe following errors:

ERROR: /etc/init.d/hcinfs
Permission <0755> expected <0744> actual
Group name <other> expected <sys> actual

If you only see the above output, or you get a prompt with no output, the package installed
successfully.

8. Enter the following command to start the Hummingbird NFS daemon:
# sh /etc/init.d/hcInfs start
2.1.4.4 Installing Sun PC NFS Daemon

The Sun PC NFS Daemon (SUNWpcnfd) has been included with FEMISv1.4.7. Toinstal the Sun PC
NFS Daemon, complete the following steps.

1. Login asroot, and insert the FEMIS application tape into the tape drive.
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2. Create atemporary spool directory.

# mkdir /<dir>/spool
# chmod 755 /<dir>/spool

Spool the ingtallation package from the 8mm tape using the Solaris software installation utility.
# pkgadd -s /<dir>/spool -d /dev/rmt/??

where ?? is the device number of the tape drive. Select the packages desired and run the pkgadd
utility to install the FEMIS package.

# pkgadd -d /<dir>/spool
3. Select the SUNWpcnfd application for installation.

4. Select y to continue when the following prompt displays: This package contains scripts which will be
executed with super-user permission during the process of installing this package.

5. Select q to quit after installing the SUNWpcnfd package.

6. Use pkgchk to verify the package was installed correctly.
# pkgchk -n SUNWpcnfd

7. Ignore errorslike the following:

ERROR: /etc/init.d/SUNWpcnfd
Permission <0755> expected <0744> actual
Group name <other> expected <sys> actual

If you only see the above output, or you get a prompt with no output, the package installed
successfully.

8. Enter the following command to start the Solstice NFS daemon:

# sh /etc/init.d/SUNWpcnfd start
2.1.5 Installing an E-mail Package

Install your E-mail package according to documentation provided by the vendor.
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2.1.6 Installing Perl v5.004-04

If you are upgrading FEMIS, you will have a previous version of the Perl package that must be removed,
prior to installing Perl v5.004-04.

2.1.6.1 Removing the Perl Package
1. Loginasroot.
2. Enter thefollowing

# pkgrm Perl
3. Sdlect y to continue when the following prompt displays: Do you want to remove this package?

4. Alsoselecty for thisprompt: Removing installed package instance <Perl>. This package contains
scripts that will be executed with super-user permission during the process of removing this package.
Do you want to continue with the removal of this package [y,n,?,q].

5. Verify that the package was removed successfully.

2.1.6.2 Installing the Perl Package

The Perl application will require 15M B of disk space for aspool directory. Toinstall Perl, which has
been included with FEMIS v1.4.7, complete the following steps.

1. Loginasroot, and insert the FEMIS application tape into the tape drive.
2. Create atemporary spool directory.

# mkdir /<dir>/spool
# chmod 755 /<dir>/spool

3. Spool the installation package from the 8mm tape using the Solaris software installation utility.
# pkgadd -s /<dir>/spool -d /dev/rmt/??
where ?? isthe device number of the tape drive.

4. Runthe pkgadd utility to install the Perl package.

# pkgadd -d /<dir>/spool

o

Select the Perl application for installation.
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6. Select y to continue when the following prompt displays: The following files are already installed on
the system and are being used by another package: /opt/local/bin <attribute change only> * - conflict
with a file which does not belong to any package. Do you want to install these conflicting files.

7. Select y to continue when the following prompt displays: This package contains scripts which will be
executed with super-user permission during the process of installing this package.

8. Select q to quit after installing the Perl package.
9. Use pkgchk to verify that Perl installed correctly.
#pkgchk -n Perl

Note: The packagesinstalled successfully if no error output is displayed. Report any errorsto
PNNL.

10. Remove the spool directory.
# rm -r /<dir>/spool

11. Logout.

2.2 Installing the FEMIS UNIX Software

Before configuring the FEMIS UNIX software on the server, you must deter mine the FEMIS home
directory

Example: /home/femis

Using the Solaris software installation utility, pkgadd, the FEMIS application and support files will be
installed to the Sun server.

2.2.1 Creating UNIX Accounts on the Server
Note: If you have successfully installed FEMIS v1.4.5 or higher, then skip this section.

Y ou will need to create several new UNIX accounts on the server to prepare for the FEMIS package
installation.

1. Loginasroot.
2. Create the following accounts (numeric IDs are for example only):

# lusr/sbin/groupadd -g 30510 femisrun
# lusr/sbin/useradd -u 30508 -g femisrun -c “FEMIS Account” -d /home/femis -s /bin/csh femis
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If you are running DEI, create the following account only on the onpost server:

# lusr/sbin/useradd -u 30509 -g femisrun -c “FEMX Account” -d /home/femx -s /bin/csh femx

3. Create the appropriate home directories for the newly created accounts. Make sure each directory has
the correct owner and group.

# mkdir -p /<file system>/home/femis
# chown femis:femisrun /<file system>/home/femis

Note: Creating the femx directory should only be done on the onpost server.

# mkdir -p /<file system>/home/femx
# chown femx:femisrun /<file system>/home/femx

4. Set the account password.
# passwd femis
Note: Setting the femx password should only be done for the onpost server.
# passwd femx

5. Edit /etc/auto_home and add entries for both the femis and femx accounts, if your system uses
automount maps. The entries must ook similar to the following:

femis -intr,rw,nosuid systemname:path:&

femx -intr,rw,nosuid systemname:path:&

Example:

femis -intr,rw,nosuid mysystem:/<file system>/home:&
femx -intr,rw,nosuid mysystem:/<file system>/home:&

The colon and ampersand ( :& ) in the above examples may also have a/<map_key> instead. Either
method of map specificationisfine.

See Section 2.1.1.2, Automounting and FEMIS, for more information.
6. Add thefollowing line to the /etc/dfs/dfstab file, unless Sambais being exclusively used for FEMIS:
share -F nfs -0 rw /<disk>/home/femis

where <disk> is whichever device /home/femis ison.
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Note: Torestrict NFS access, see the man pages on share and share_nfsin your Solaris
documentation.

If you do not have any other entriesin the dfstab file, you will need to start the NFS server process. If
you do not start the NFS server process, you will see errors like “RPC: Program not registered” when

entering the shareall command (see below). To start the NFS server process, type the following:

# letc/init.d/nfs.server start
To make the /<disk>/home/femis directory available to NFS authentication services (daemon) type

# shareall

To check that the directory is available to NFS Maestro type
# share

Y ou should see output similar to the following:

#-  [<disk>'home/femis rw ““

2.2.2 Upgrading the FEMIS Application

Note: If you are doing anew install of FEMIS, then skip this section. If you have successfully
installed FEMIS v1.4.6 or higher, then you must complete this section.

To prepare for the new version (an upgrade) of FEMIS, check for the existence of required user accounts,
backup the FEMIS directory, and remove the old FEMIS installation.

1. Loginasroot.
2. Copy the site-specific directories to another location using the following commands:

Note: The <backup> directory in the following represents afile system of your choice on this
server where you can save a copy of the files. Y ou will need to restore the
/home/femis/user directory at the end of the Section 2.2.3, Installing the FEM IS Package.
The configd and etc directories are backed up in this step for redundancy only.

# mkdir <backupdir>

# cd /home/femis

# tar cf - user configd etc pc/femtools/femis.db | (cd <backupdir>; tar xf -)

Use these files to reference site-specific information, as needed.
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3. Make sure both the femis and femisrun accounts exist, if you are installing on the onpost server.
Otherwise, only the femis account needs to exist.

# logins -m -l femis
Y our output should look similar to the following:
femis 30508 femisrun 30510 FEMIS Account

If your output is blank, you need to add the femis and femisrun accounts. See Section 2.2.1, Creating
UNIX Accounts on the Server, to add these accounts.

If you are running DEI, the femx account should exist.

# logins -m -l femx
Y our output should look similar to the following:

femx 30509 femisrun 30510 FEMIX Account

Note: Some systems may show femx having supplemental group membership in the femis
group. Thefemis group, as of v1.4.7, is obsolete and may be removed from the system as
long as any files having femis as the group owner are changed to femisrun (or match
whatever the femis account’s primary group is). The exception is those deemed sensitive
for security reasons, such as/home/femis/etc/cmdserv.conf which should have group
ownership set to noaccess (see Section 12.1.6 No Access Filesin the FEMI S System
Adminigtration Guide).

If your output is blank, you will need to add the femx account. See Section 2.2.1, Creating UNIX
Accounts on the Server, to add this account.

4. Stop al FEMIS processes, such as DEI and Notification, before removing the FEMIS package.
Login asfemis.
On all servers
% stopnotify  Thiswill stop Notification.
Onpost Only

% femisdei -kill
% stopdai.sh

5. Remove the FEMIS application.
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Login asroot.
# pkgrm FEMIS
Y ou will most likely see warning messages about package dependencies similar to the following:

## Verifying package dependencies.

WARNING:
The <FEMISgs> package depends on the package
currently being removed.

WARNING:
The <FEMISdb> package depends on the package
currently being removed.

Dependency checking failed.

Do you want to continue with the removal of this package [y,n,?,q]
If this message appears, answer Yes by typing ay and pressing Enter.
6. Deletethe site-specific directories that you backed up in Step 2.

# rm -r /home/femis/user

# rm -r /home/femis/configd (Thedirectory may not exist).
# rm -r /lhome/femis/etc

2.2.3 Installing the FEMIS Package

Note: Wheningtalling the FEMIS package from the spoal directory, it is possible to receive a
Sun Package installation error, Broken Pipe. This error happens when the last package in
the list isnot selected for installation. This error will not cause any problems with the
FEMISinstallation. Continue with the installation.

Y ou will copy the FEMIS package(s) to a spool directory and install FEMIS by completing the following
steps. The FEMIS application will require 82MB of disk space for a spool directory.

1. Login asroot, insert the FEMIS application tape into the tape drive.

2. Enter the following command to mount the FEMIS installation directory, if you are using the
automounter.

cd /home/femis
3. Create atemporary spool directory.

# mkdir /<dir>/spool
# chmod 755 /<dir>/spool
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4. Spool theingtallation package from the 8mm tape using the Solaris software installation utility.
# pkgadd -s /<dir>/spool -d /dev/rmt/??

where ?? isthe device number of the tape drive. Select the packages desired and run the pkgadd
utility to install the FEMIS package.

5. Runthefollowing command again if exited above:
# pkgadd -d /<dir>/spool
6. Select the FEMIS application for installation.
Ignore any warning messages about disk space.
If the femx account was created prior to the installation, you will be asked if you want to install DEI.

If the server will be running the FEMIS DEI, select y to install the DEI options.

Select y to continue when the following prompt displays: This package contains scripts which will be
executed with super-user permission during the process of installing this package.

7. Select q to quit, after the FEMIS application has been installed.
8. Use pkgchk to verify the FEMIS package has installed correctly.
#pkgchk -n FEMIS
Ignore the following errors:
ERROR: /etc/init.d/femis
permissions <0644> expected <0744> actual group name <other> expected <sys> actual
ERROR: /home/femis

permissions <0755> expected <0775> actual owner name <femis> expected <femx> actual

If you only see the above output, or you get a prompt with no output, the package installed
successfully.

9. Remove the spool directory, unlessyou will beinstalling AutoRecovery or AutoRecovery Web.
# rm -r /<dir>/spool
10. Restore only the FEMIS application user directories in the /home/femis/user directory and the

femis.db file from the backup you made in Section 2.2.2, Upgrading the FEMIS Application (Step 2),
if you are upgrading the FEMIS application.
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# cd /home/femis/pc/femtools

# mv femis.db femis_orig.db

# cp —p <backupdir>/pc/femtools/femis.db .

# cd <backupdir>/user

# tar cf — “find . —type d \! -name . —prune’ | (cd /home/femis/user; tar xf -)

11. Set the setgid bit for the /home/femis/user directory.
# find /home/femis/user —type d —exec chmod g+xs {} \;

12. Remove the FEMIS application tape from the drive.

2.2.4 Installing Network Time Protocol (NTP)

This section describes the steps required to remove the Network Time Protocol (NTP) package bundled
with previous versions of FEMIS, and it steps you through configuring the NTP software bundled with
the Solaris operating system.

If you have any version of the FEMIS NTP package on your server, you will need to removeit. If you do
not know if NTPisingalled as a package on your server, enter the following command:

# pkginfo | grep XNTPD
A result similar to the following means the NTP package isinstalled on your server.
application XNTPD Network Time Protocol

Note: If you do not received aresponse to the above command, skip to Configuring NTP
below.

If you know you are already running the bundled Solaris NTP, proceed to Step4 under
Configuring NTP.

Removing the Old Version of NTP
1. Stop the NTP daemon.
# sh /etc/init.d/ntp stop
2. Savetheold ntp.conf file for reference.
# cp /etc/ntp.conf /etc/ntp.conf.old
3. Enter the following command to remove the old version of the NTP package.

# pkgrm XNTPD
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Select y to continue when the following prompt displays: “Do you want to remove this package?’

Also select y for this prompt: “Removing installed package instance <XNTPD>. This package
contains scripts that will be executed with super-user permission during the process of removing this
package. Do you want to continue with the removal of this package [y,n,?,q]"

Configuring NTP

Note: You do not need to configure NTP if you already have the Solaris version of NTP
configured.

NTPisincluded with the Solaris operating system. To configure NTP complete the following steps.

1

2.

Login asroot.

Enter the following:

cd /home/femis/install

Run the following script to configure an ntp.conf file in the /etc/inet directory and start the NTP
daemon (xntpd). Y ou may need information from the ntp.conf.old file in the /etc directory before
running this script. Then you may remove the ntp.conf.old file.

sh ntp_config

Theinstallation will ask if the server will get time from another server; select y if yes, otherwise
select n.

If you selected y above, the installation will prompt for the NTP server’s Internet Protocol (IP)
address. Make surethe NTP server is accessible (available on the network) as the installation will

attempt to ping the NTP server.

The message: “/etc/inet/ntp.conf already exists. It will not be reconfigured,” means the script found an
existing /etc/inet/ntp.conf file and exited without making any changes to the /etc/inet/ntp.conf file.

Check your NTP configuration.
ntptrace <servername>

It may take awhile before your output shows a traceback other than a“timeout”. Once the traceback
information displays correctly, NTP is configured.

For additional information on NTP see the Section 11.0, Server Network Time Protocol (NTP) Set Up, in
the FEMI S System Administration Guide.
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Note: If the server is not synching with any time source, you must change the file so NTP will
work. See Section 11.0, Server Network Time Protocol (NTP) Set Up, inthe FEMIS
System Administration Guide for instructions.

2.3 Installing the FEMIS GIS and Database

If thisisanew installation of FEMIS, you will need to install both the Oracle software (v8.1.6) and the
FEMIS GIS and database packages.

If you are upgrading to a new version of FEMIS, you will have to upgrade Oracle to v8.1.6 and install the
appropriate FEMIS GIS and database package from the tape, if FEMIS v1.4.6 has not previously been
installed.

In FEMIS, database topologies are defined either as NxN or NxM, which are number pairs that indicate
the number of EOC databases and the number of servers. For example, a3x3 (or NxN) configuration
indicates three EOCs on three servers. Likewise, an 8x4 (or NxM) configuration represents eight EOCs
on four servers.

On each server, Oracle schemas are created to store the EOC data. The schemas are broken into two
groups. 1) data owner schema or 2) snapshot owner schema. A data owner schema has the database
tables that store the datafor an EOC. A snapshot owner schema has a set of specialized snapshot tables
that are created to support the replication of data.

On every NxN configuration, there is exactly one data owner and N-1 snapshot owners per server. By
definition, NxM configurations have more than one data owner on at least one of the M serversin the
configuration.

The terms data owner and snapsnot owner will be used frequently throughout this section and as the
installation is performed. Y ou will need to know which server has which data owner within your

configuration.

To properly complete the installation for your site, follow the instructions in the Section 2.3.1, Installing
the GIS and Oracle Database through Section 2.3.5.7, Setting Up the Oracle Backups.

2.3.1 Installing the GIS and Oracle Database

Note: Complete thissection only if you are installing anew FEMIS GIS and database package.
If you are upgrading the existing database skip to the next section.

Oracle Release v8.1.6 requires a minimum of 128MB of RAM; if you do not have this
much memory installed, do not attempt to install Oracle v8.1.6. To check the amount of
memory available, issue the following command:

# lusr/sbin/prtconf | grep size
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Toinstall the GIS and database package, complete the following steps.
1. Insert the GIS and database tape into the tape drive.

Thisinstallation may require considerable disk space for a spool directory. To create atemporary

spool directory, run the following commands but only if you did not create the spool when you

installed the FEMIS package.

# mkdir /<dir>/spool

Spool the ingtallation package from the 8mm tape using the Solaris software installation utility.

# pkgadd -s /<dir>/spool -d /dev/rmt/??

where ?? isthe device number of the tape drive. Select the packages desired, and run the pkgadd
utility to install the GIS and database package.

# pkgadd -d /<dir>/spool
2. Select the numbers corresponding to your site’' s GIS and database using commas as separators.

3. Select g to quit, after the GIS and database have been ingtalled.
4. Use pkgchk to verify the packages were installed correctly.
#pkgchk -n <package name>
No output is expected as aresult of this command.
5. Remove the spool directory.
# rm -r /<dir>/spool

6. Remove the tape from the drive.

2.3.2 Database Cleanup Tasks

The following tasks describe how to prepare your existing database for an upgrade. Check each
subsection to see if it pertainsto your site.

2.3.2.1 Dropping Database Objects and Exporting Data Owners

Note: Complete thissection only if you have a previous version of FEMISinstaled. If you do
not have a previous version installed, skip this section and go to Section 2.3.2.2,
Removing Current Oracle Installation.
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1. Drop al the non-table objects. If you are upgrading on an NxM or NxN system, the master drop
script will drop objects from all serversin the configuration and only needs to be performed on one
Sserver.

Asoracle user:

% svrmgrl

SVRMGR>connect internal (system response should be Connected.)
SVRMGR>shutdown immediate (system response should be Oracle instance shut down.)
SVRMGR>startup (system response should be “Oracle instance started...”)
SVRMGR>exit

Asfemis user:

% cd /home/femis/database/eocdba
% sqlplus /nologin
SQL> @master_dr

Watch the progress of the master_dr.sqgl script. If you do not have any problems, press Enter after
each Pause statement is encountered.

2. Perform an export of al FEMIS data owners on each server. The export files created in this step will
be re-imported later if you need to reinstall Oracle. If you are not going to reinstall or upgrade
Oracle, then export this data as a safety precaution.

Note: To determinethe“dataowner” schemas, review the /home/femis/etc/eoclist.dat file. The
first column lists all EOCs for your site. Thethird column lists the server where the EOC
isadataowner. Perform an export for every EOC whose server matches your server.

% cd $/home/femis/database/exports/<site name>
% exp userid=<EOC_name>/<data owner password> file=<EOC_name>_<date (yyyymmdd)>.dmp
log=<EOC_name>_<date>.log

3. Repeat this export command for each data owner schemathat resides on this server. For example, if
you have eight EOCs at your site but only three EOC databases reside on this server, then you will
make three database exports on this server. 'Y ou must then export the remaining data owners from
each of the other serversin the configuration.

2.3.2.2 Removing Current Oracle Installation
Note: Thefollowing tasks are only required if you are upgrading to Oracle v8.1.6. If you are

installing Oracle for the first time or if you already have Oracle v8.1.6 installed, then skip
this section.
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1. Login asoracle user and enter the following to shutdown the old database, shutdown the listener, and
delete the old Oraclefiles.

% svrmgrl

SVRMGR>connect internal
SVRMGR>shutdown immediate
SVRMGR>exit

% Isnrctl

LSNRCTL>stop

LSNRCTL>exit

Note: Before removing the Oracle Product directory, confirm that al Oracle Instances (some
facilities have multiple instances running) have been shutdown. Use the ps and grep
commands to identify the Oracle processes. For example ps -ef |grep oracle | sort.

2. ldentify the location of the Oracle data and log files, and delete them.

% cd

% |s /*/app/oracle/oradata/*

% rm —rf /*/app/oracle/oradata/fi<#>/*
% cd $ORACLE_HOME

% cd ..

% rm -rf <oracle_directory>

The oracle_directory is named after the version number, for example, for Oracle v7.3.3 the directory
isnamed 7.3.3. To confirm the removal of this directory, enter

Is
3. Savethe current configuration filesin /var/opt/oracle.

% cd /var/opt/oracle
% mkdir bkp
% cp *.ora ./bkp

4. Comment out all database instancesin the /var/opt/oracle/oratab file. Thisisimportant; otherwise
you will have difficulty in creating a new instance with the same name as the old one.

2.3.3 Installing Oracle Software or Relinking Oracle
Note: If you do not have Oracle v8.1.6 (the version required for FEMISv1.4.7) installed,

carefully review each of the following sections and determine which sections pertain to
your site.
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If you aready have the Oracle v8.1.6 installed, you may need to relink the Oracle
software. To determineif relinking is necessary, go to Section 2.3.3.4, Relinking the
Oracle Software, and skip Sections 2.3.3.1, 2.3.3.2, and 2.3.3.3.

Before beginning the Oracle v8.1.6 installation, you should review the installation guide provided by
Oracle, Oracle8i Installation Guide Release 2 (8.1.6) for Sun SPARC Solaris. The following steps
arerequired to install Oracle and identify specific parameter settings required by FEMIS.

2.3.3.1 Creating the UNIX Environment for Oracle
Note: Numeric IDsin this section are for example only.

To create the UNIX environment for Oracle v8.1.6, complete the following steps.

1. Select adrive onwhichtoinstal Oracle (thiswill be referred to as <install_drive>). The drive must
have a minimum of 1000MB available. Select two additional drives on which to locate the FEMIS
database files (these will be referred to as <driveA> and <driveB>). Each of these drives should have
aminimum of 500MB available. It isrecommended that all drives used are RAID volumes. For
complete information on server drives, see the FEMI S Bill of Materials (BOM) or on the FEMIS

web site at http://www.pnl.gov/femis. The following command will alow you to view the drives and
their available storage space.

% df —k —F ufs
2. Logininasroot.

Check if there is a group named dba and a group named oinstall in the /etc/group file, and also
determineif oracle is a member of the dba and the oinstall group.

# egrep "“dba|™oinstall' /etc/group
Verify that output from the above command resembles the following:

dba:*:26001:oracle
oinstall::26002:oracle

If you do not the get the output above, use the following command to add a dba and/or an oinstall
group, as necessary:

# /usr/sbin/groupadd -g 26001 dba
# /usr/sbin/groupadd -g 26002 oinstall

2-35



Federal Emergency Management FEMIS Installation Guide
Information Systems (FEMIS) May 26, 2000-Version 1.4.7

Note: You may select any number for your group identification (GID) number that is not
currently being used. Be sure to check for the existence of a GID in both the /etc/group
fileand NIS+ (if your site uses NIS+).

Edit the /etc/group file, and add oracle to the group oinstall, as necessary.
3. Check if an oracle account already exists.

# logins —m —| oracle

The following is an example of output from the above command.

oracle 300 dba 26001 Oracle Account
oinstall 26002

If the line does not exist, use the following command to add the oracle user assigned to the dba
group:

# lusr/sbin/useradd -u 300 -g dba -c “Oracle Account” -d /<install_drive>/app/oracle -s /bin/csh oracle
Set the Oracle password to your desired value using the UNIX passwd process.
#passwd oracle

If an Oracle account already exists, verify that the login directory is correct. Change the password, if
desired.

4. Createthe following directories, if they do not already exist.

% su -

# mkdir -p /<install_drive>/app/oracle

# chown oracle:dba /<install_drive>/app/oracle
# chmod 755 /<install_drive>/app/oracle

# mkdir -p /<driveA>/app/oracle

# chown oracle:dba /<driveA>/app/oracle

# chmod 755 /<driveA>/app/oracle

# mkdir -p /<driveB>/app/oracle

# chown oracle:dba /<driveB>/app/oracle

# chmod 755 /<driveB>/app/oracle

5. Set up the automount map. If your system uses automount maps, edit /etc/auto_apps and add the
following line:

oracle -intr,rw,nosuid systemname:path
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Example:
oracle -intr,rw,nosuid Mysystem:/<install_drive>/app/oracle
See Section 2.1.1.2, Automounting and FEMIS, for more information.

6. Make surethereis adequate shared memory. Examine the following parametersin the /etc/system
file.
set shmsys:shminfo_shmmax=4294967295
set shmsys:shminfo_shmmin=1
set shmsys:shminfo_shmmni=400
set shmsys:shminfo_shmseg=36
set semsys:seminfo_semmni=256
set semsys:seminfo_semms|=600
set semsys:seminfo_semmns=1800
set semsys:seminfo_semopm=100
set semsys:seminfo_semvmx=32767

If there are no parameters, copy them from the template. Asroot, set them to the recommended
values shown above or as high as possible for the operating system.

A copy of the recommended values can be found in
/home/femis/install/oracle_template/kernel_parms.dat

Note: If any of these parameters are changed, you must reboot the server (asroot, use the init 6
command to reboot) before proceeding.

7. Veify thereisat least two times (preferably three) as much swap space as physical RAM (a
minimum of 400MB is recommended). If additional swap space isrequired, see your System
Administrator.

To determine how much physical RAM you have, enter the following command:
# prtconf | grep size
Note: At least 128MB of RAM arerequired for Oraclev8.1.6 installation.

To determine the available swap space, enter the following command:

# lusr/sbin/swap —s
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8. Verify that the necessary Solaris 7 patches and packages are installed prior to installing Oracle.
Solaris 7 107636-01
#> showrev -p | grep 107636
Packages
#> pkginfo -i SUNWarc SUNWbtool SUNWhea SUNWIibm SUNWIibms SUNWsprot SUNWtoo
If any of the patches and/or packages above are not displayed asinstalled, then install them.

9. Veify thereisalocal bin directory /usr/local/bin. If the directory does not exist, then it should be
created asroot.

10. Create the /var/opt/oracle directory, if it does not exist.

#> mkdir -p /var/opt/oracle

#> chown -R oracle /var/opt/oracle
#> chgrp -R dba /var/opt/oracle
#> chmod -R 755 /var/opt/oracle

11. Log completely off and back onto the server as oracle.
12. Copy the template files to the admin directory.

% cp -r /lhome/femis/install/oracle_template/* /<install_drive>/app/oracle/admin
% chown -R oracle /<install_drive>/app/oracle/admin

% chgrp -R dba /<install_drive>/app/oracle/admin

% chmod -R 755 /<install_drive>/app/oracle/admin

13. Create the product directories, if they do not exist.

% mkdir -p /<install_drive>/app/oracle/product/8.1.6
% chown -R oracle /<install_drive>/app/oracle/product
% chgrp -R dba /<install_drive>/app/oracle/product

% chmod -R 755 /<install_drive>/app/oracle/product

14. Copy the new Oracle UNIX setup fileto the installation directory.

Note: If you previously had FEMIS installed, you should compare your existing configuration
fileswith the new ones. If your existing files have been customized, then do not
overwrite them but perform Step 14 to make sure the values are still correct for this
server.
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15.

16.

17.

% cd /<install_drive>/app/oracle/admin

% cp -p oracle.mycshrc /<install_drive>/app/oracle/.mycshrc
% cp -p oracle.cshrc /<install_drive>/app/oracle/.cshrc

% cp -p oracle.oraclerc /<install_drive>/app/oracle/.oraclerc
% cp -p oracle.login /<install_drive>/app/oracle/.login

Make sure the following environment variables are correct in .oraclerc file.

ORACLE_TERM (set it to match the xterm for the given keyboard: xsun or xsun5)
ORACLE_BASE = /<install_drive>/app/oracle
ORACLE_HOME = /$ORACLE_BASE/product/8.1.6
PATH includes:
$ORACLE_HOME/bin
letc
{usr/local/bin
/bin
/usr/bin
{usr/ccs/bin
ORACLE_SID = fi<x>
ORACLE_DOC = $ORACLE_BASE/doc
CLASSPATH = $ORACLE_HOME/JRE:$3ORACLE_HOME/jlib
LD_LIBRARY_PATH = /usr/lib:/usr/dt/lib:/usr/ucblib:/usr/openwin/lib:3ORACLE_HOME/lib
ORACLE_EXPORT = /<driveA>/app/oracle/admin/fi<x>/exp
ORACLE_LOGS = /<driveA>/app/oracle/admin/fi<x>/logs
ORACLE_FULL = /<driveB>/app/oracle/admin/fi<x>/full
ORACLE_COLD = /<driveB>/app/oracle/admin/fi<x>/cold

Create the directories that Oracle uses for database backups.
% source .oraclerc
% cd /<install_drive>/app/oracle/admin

% ./dbbackup_setup

This executable will check on needed environment variables and then create directories. If any errors
are reported, correct them and then rerun the setup process.

Patch the dbstart script with the following commands (assumes you are still in
[<install_drive>/app/oracle/admin):

% cp dbstart SORACLE_HOME/bin

2.3.3.2 Installing the Oracle Software

Complete the following stepsto install the Oracle v8.1.6 software.
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1. Logcompletely off and back onto the server as oracle with the group set to oinstall.

% newgrp oinstall
% id should return something like uid=26000(oracle) gid=26002(oinstall)

2. Insert the Oracle8 Server v8.1.6 CD into the CD drive.
3. Mount the CD

$ cd /cdrom/oracle8i
4. Runtheingaler.

Jruninstaller &

5. Install the Oracle products. After the Universal Installer comes up, perform the following operations
at the indicated windows.

WELCOME — Click Next.

FILE LOCATIONS —Verify Destination path settings, then click Next.

UNIX GROUP NAME —Typein oinstall in the space provided. (Thiswindow may not display.)
AVAILABLE PRODUCTS — Select the Oracle 8i Enterprise Edition 8.1.6.0.0, then click Next.
INSTALLATION TYPES — Select Custom, then click Next.

AVAILABLE PRODUCTS COMPONENTS — Select the following components (a check mark
indicates a selected product); the plus (+) and minus (-) signs expand or contract the upper level
menus:

—™ Oracle 8l Enterprise Edition 8.1.6.0.0
—Product Options
—™ Oracle 8i Server 8.1.6.0.0
—Optional
M Oracle Database Configuration Assistant 8.1.6.0.0
[0 Oracle Data Migration Assistant 8.1.6.0.0
[0 Oracle Database Demos 8.1.6.0.0
M Advanced Replication 8.1.6.0.0
[0 Legato Storage Manager 8.1.6.0.0
[0 Migration Utility 8.1.6.0.0
M Oracle Intelligent Agent 8.1.6.0.0
[0 Oracle Partitioning 8.1.6.0.0
M Heterogeneous Services ODBC Connectivity 8.1.6.0.0
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—[1 Oracle Product Options 8.1.6.0.0
[ Oracle Time Series 8.1.6.0.0
[ Oracle Visual Information Retrieval 8.1.6.0.0 0
—[ Oracle Spatial 8.1.6.0.0
+Optional
O Oracle Advanced Security 8.1.6.0.0
—[0 Oracle interMedia 8.1.6.0.0
+Optional
— Net 8 Products 8.1.6.0.0
M Net 8 Client 8.1.6.0.0
M Net 8 Server 8.1.6.0.0
[ Oracle Names 8.1.6.0.0
M Oracle Connection Manager 8.1.6.0.0
O External Naming: NIS 8.1.6.0.0
M Oracle Protocol Support 8.1.6.0.0
-M Oracle Utilities 8.1.6.0.0
M Oracle Database Utilities 8.1.6.0.0
M SQL*Plus 8.1.6.0.0
-M Oracle Configuration Assistants 8.1.6.0.0
[ Oracle Database Migration Assist 8.1.6.0.0
M Oracle Database Configuration Assistant 8.1.6.0.0
-M Development Tools 8.1.6.0.0
M Oracle Call Interface (OCI) 8.1.6.0.0
M Object Type Translator 8.1.6.0.0
-M Oracle Java Products 8.1.6.0.0
M Oracle JDBC Drivers 8.1.6.0.0
M Oracle JDBC/OCI Driver for JDK 1.18.1.6.0.0
M Oracle JDBC/OCI Driver for JDK 1.28.1.6.0.0
M Oracle Thin Driver for JDK 1.18.1.6.0.0
M Oracle Thin Driver for JDK 1.28.1.6.0.0
M Oracle SQLJ 8.1.6.0.0
M Oracle Java Tools 8.1.6.0.0
+[] Oracle Enterprise Manager Products 8.1.6.0.0
—M™ Oracle Installation Products 8.1.6.0.0
M Oracle Universal Installer 1.7.0.18.0A
M Solaris Documentation 8.1.6.0.0
Click Next.

COMPONENT LOCATIONS — Click Next.
PRIVILEGED OPERATING SY STEM GROUPS (change to dba) — Click Next.

CREATE DATABASE — Select NO, then click Next.
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ORACLE PROTOCOL SUPPORT — Click Next.

SUMMARY — Review your selections. Y ou will probably see more products than you selected
(some are required to support your selections), but as a minimum, you should see the products that
were originally selected. Click the Install button if your selections are correct. If they need to be
revised, then click on the Previous button and revise selections.

Edit the root.sh file. Comment with a# any lines containing the text “$CHOWN root” and
“$CHMOD 6?7?72 or 4???" (where ??? = three permission digits).

As root, execute the root.sh. When prompted by the following: Enter the full pathname of the
local bin directory, accept the default path. When prompted, dismiss the Setup Privileges
window.

CONFIGURATION TOOLS — auto-defaults to NET8 CONFIGURATION ASSISTANT — Click
Cancel and confirm Yes.

ERROR (Triggered from the previous step —ignore) — Click OK.
CONFIGURATION TOOLS — Click Next, then Exit, and confirm Yes.
6. Create the database using the Database Creation Assistant.
At the O/S prompt, verify that you are part of the dba group by typing id and enter.

% newgrp dba
% id should return uid=26000(oracle) gid=26001(dba)

Then change directory to the new ORACLE_HOME and run the Database Creation Assistant.

cd $SORACLE_HOME/bin
Jdbassist &

7. After the Database Creation Assistant comes up, perform the following operations at the indicated
windows:

ORACLE DATABASE CONFIGURATION ASSISTANT
Select Create a database, and click Next.
Select Custom, and click Next.
Select Multipurpose, and click Next.
Change Concurrently connected users to 35, and click Next.
Select Dedicated Server Mode, and click Next.
Verify abox is checked for each of the following: Oracle JServer, Advanced Replication,
SQL*Plus Help
Click Next to continue.

2-42



FEMIS Installation Guide
May 26, 2000-Version 1.4.7

Federal Emergency Management
Information Systems (FEMIS)

Enter the Global Database Name, and click Next.

Example: fil

Note: If an Alert window regarding an instance is already in use, choose another instance name.
Acknowledge the Alert by clicking OK. Edit the /var/opt/oracle/oratab file to remove the
offending instance line, and click Next. Then, you may get the Alert window described

below.

If an Oracle Database Configuration Assistant Alert window appears, click the Yes
button and proceed. Thisremoves the old folder with the same instance name in the
$ORACLE_BASE/admin directory allowing the same instance name to be recreated.

Change the ControlFiles so that each control file has a different number in the /filesX line

whereX = 0....n.

Example: /files0, /filesl, /files2

Click Next.

Create tablespaces, for each tabbed tablespace input the following parameters (Create file locations

based on your best judgement of space available and disk usage).

SYSTEM

Size (MB): 400

File: (Verify the File Location)

Autoextend: YES

Next (KB): 1000

Min Extent (KB): 1000

% Increase: 0

Initial (KB): 100

Next (KB): 100

Min: 1

Max: Check “Unlimited”
TOOLS

Size (MB): 50

File: (Verify the File Location)

Autoextend: YES

Next (KB): 1000

Min Extent (KB): 1000

% Increase: 0

Initial (KB): 100

Next (KB): 100

Min: 1

Max: Check “Unlimited”
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USERS
Size (MB):
File:
Autoextend:

Min Extent (KB):

% Increase:
Initial (KB):
Next (KB):
Min:

Max:

ROLLBACK
Size (MB):
File:
Autoextend:

Min Extent (KB):

Initial (KB):
Next (KB):
Min:
Max:

INDEX
Size (MB):
File:
Autoextend:
Next (KB):

Min Extent (KB):

% Increase:
Initial (KB):
Next (KB):
Min:

Max:

TEMPORARY
Size (MB):
File:
Autoextend:

Min Extent (KB):

Initial (KB):
Next (KB):

5

(Verify the File Location)
OFF

1000

0

100

100

1

Check “Unlimited”

200

(Verify the File Location)
OFF

1000

1000

1000

2

Check “Unlimited”

(Accept the default)
(Accept the default)
(Accept the default)
(Accept the default)
(Accept the default)
(Accept the default)
(Accept the default)
(Accept the default)
(Accept the default)
(Accept the default)

50

(Verify the File Location)
OFF

1000

500

500

FEMIS Installation Guide
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Note: SYSTEM, ROLLBACK, and TEMPORARY should be on different disk devicesto

distribute |/O.

Click Next.

Ignore the Redo Log settings (these will be updated by post-generation modifications.), and

click Next.
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Ignore the Checkpoint settings, |eave the Enable Archive Log box unchecked, and click Next.
Change the following parameters as indicated:

Block Buffers 8192
Processes 300
Block Size 4096

Click Next.

Leave the Trace File Directory settings intact and click Next.

Select the Save information to a shell script setting, and click Finish. Inthe _popup window,
accept the default location and enter the file in the format of <sid>master.sh (Example:
filmaster.sh). Click OK to save thefile. Acknowledge the alert windows that indicate the status
of thefile creations.

8. Change directory to the location of the saved scripts generated in the previous step:

% cd $ORACLE_HOME/assistants/dbca
% Is -l fi*.sh

This should produce a listing of scripts as per the example below:

% Is -la fi*.sh

-rwxr-xr-x 1 oracle dba 214 Feb 10 20:22 filalterTablespace.sh
-rwxr-xr-x 1 oracle dba 639 Feb 10 20:22 filjava.sh

-rwxr-xr-x 1 oracle dba 548 Feb 10 20:22 filmaster.sh
-rwxr-xr-x 1 oracle dba 253 Feb 10 20:22 filreplicate.sh

-rwxr-xr-x 1 oracle dba 682 Feb 10 20:22 filrun.sh
-rwxr-xr-x 1 oracle dba 4004 Feb 10 20:22 filrunl.sh
-rwxr-xr-x 1 oracle dba 452 Feb 10 20:22 filrun2.sh
-rwxr-xr-x 1 oracle dba 188 Feb 10 20:22 filsqlplus.sh

9. Review and edit the scripts that are displayed in Step 8 above; make changes as indicated below to
the named scripts:

- fi*run.sh
Add the following under maxlogfiles 32.
maxlogmembers 4

Add the following text MAXSIZE 800M to the end of the line DATAFILE ‘<file>’ SIZE 400M
AUTOEXTEND ON NEXT 1000K.
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Replace the LOGFILE component with the following change, editing for the correct file and instance
names.

logfile

GROUP 1 (‘/<install_drive>/app/oracle/oradata/fi9/redo0la.log’,
'/<driveA:>/app/oracle/oradata/fi9/redo01b.log" ,
'I<driveB:>/app/oracle/oradata/fi9/redo01c.log") SIZE 10M,

GROUP 2
(/<install_drive>/app/oracle/oradata/fi9/redo02a.log’,
‘/<driveA:>/app/oracle/oradata/fi9/redo02b.log" ,
'I<driveB:>/app/oracle/oradata/fi9/redo02c.log") SIZE 10M,;

- fi*runl.sh
Make the following changes to the fi*runl.sh file:

1) Add the following text “MAXSIZE 200M” to the end of the line “CREATE TABLESPACE TOOLS
DATAFILE ‘<file>’ SIZE 50M REUSE AUTOEXTEND ON NEXT 1000K”.
2) Limit rollback segments to 6 (RBSO - RBS5); delete others

10. Verify the ORACLE_SID entry. If itisnot set, set it appropriately (instance name), change directory
to the pfile directory for the instance and review/change the init.ora script, as per the example below.

% setenv ORACLE_SID <fi#>
% cd $ORACLE_BASE/admin/$ORACLE_SID/pfile
% mv init<SID#>.0ra init<SID#>.0rg

Then copy the sample init.ora file and edit per the following example:

% cp /<install_drive>/app/oracle/admin/initfix.ora ./initfi<SID#>.ora
% vi init<SID#>.ora

where <SID#> is the instance number.
Edit the init.ora file to replace instance, and file specific values that are different from the origind file.
Verify that rollback segment, and control file names and locations are correct. Update the path for the
log_archive_dest_1 parameter (it should match $ORACLE_LOGS/arch).
Note: The control file disk spindlesin theinit.ora file must match the ones that were specified
in the Database Creation Assistant (dbassist). To verify they match, check the
init<SID#>.org file that you created above.
11. Verify that all database file directories exist before executing the database creation script.

% Is -la /*/app/oracle/oradata/$ORACLE_SID
% Is -la $ORACLE_BASE/admin/$ORACLE_SID (check for bdump, cdump, udump)
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12.

13.

14.

15.

Change directory to the location of the database creation scripts and execute the master script, as per
the example below:

Note: Thisisatime consuming task and may take up to severa hours, depending upon the
speed of your system. Y ou may see many ORA-04132 errors regarding nonexistent
objects. These will be created and are normal outpui.

% cd $ORACLE_HOME/assistants/dbca
% ./<SID>master.sh

Note: If during the process of creating the database, the orapwd fileis corrupt or missing it will
need to be recreated. To recreate the orapwd file, enter the following commands:

cd $ORACLE_HOME/dbs
orapwd file=orapw<SID> password=<create a password> entries=<a number>

Y ou will have to re-execute the master script at the beginning of Step 12.
Review database creation log files for errors.

% cd SORACLE_BASE/admin/$ORACLE_SID/create
% Is -lat *.log
% grep ORA- *.log | more

Change the password for the SYS and SYSTEM accounts, via svrmgrl, as per the example below:

SVRMGR> connect internal
SVRMGR> alter user sys identified by dba<SID#>; (for example for fi6 use dba6b)
SVRMGR> alter user system identified by dba<SID#>;  (for example for fi6 use dba6)

Create an oracle user account to permit scheduled exports, using svrmgrl, by copying and pasting the
following text into the svrmgrl session:

SVRMGR> connect internal

SVRMGR> CREATE USER "ORACLE" PROFILE "DEFAULT"
2> IDENTIFIED EXTERNALLY

3> DEFAULT TABLESPACE "USERS"

4> TEMPORARY TABLESPACE "TEMP"

5> QUOTA UNLIMITED ON TEMP

6> QUOTA UNLIMITED ON USERS

7> ACCOUNT UNLOCK;

SVRMGR > GRANT "CONNECT" TO "ORACLE";

SVRMGR > GRANT "EXP_FULL_DATABASE" TO "ORACLE";
SVRMGR > ALTER USER "ORACLE" DEFAULT ROLE ALL;
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16.

17.

18.

19.

20.

21.

Edit the oratab, as oracle, in /var/opt/oracle and change the third field from no (N) to yes(Y) so that
the database is brought up when the server isrebooted. Also make sure that the path is preceded by
ORACLE_SID parameter followed by a colon as shown below (the example isfor a database instance
with ORACLE_SID = fi1).

fil: /<install_drive>/app/oracle/product/8.1.6:Y

Login in asroot and copy afile named dbora into the /etc/init.d directory, if it does not already exist.

# cp /<install_drive>/app/oracle/admin/dbora /etc/init.d/dbora
# Is —la /etc/init.d/dbora

Link dbora by entering the following:

% In -s /etc/init.d/dbora /etc/rc0.d/K10dbora
% In -s /etc/init.d/dbora /etc/rc2.d/S99dbora

Remove any previous versions of Oracle startup scripts by completing the following:
# cd /etc/init.d
#rm oracle

#cd .
# rm -i rc?.d/[KS]*oracle

Reserve a port for the Net8 listener by making the following entry in the /etc/services file (insert this
in port number sequence).

listener_name 1521/tcp # Net8 listener

Copy the original SQL* Net files (sqlnet.ora, listener.ora, tnsnames.ora) from /var/opt/oracle to the
$ORACLE_HOME/network/admin directory (they are compatible with Net8).

% cd $ORACLE_HOME/network/admin
% cp /var/opt/oracle/*.ora .

Change the hostname, instance name, and $ORACLE_HOME path to the correct identity for the server
that you are working on.

If the copy command above fails, enter the following commands:

% cd /<install_drive>/app/oracle/admin
% cp -p listener.ora tnsnames.ora sqlnet.ora $ORACLE_HOME/network/admin

Modify thefilesin the destination path to match your site’s server and database instance names. Be
sure to include listener definitions for the whole site in the tnsnames.ora file.
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22. Veify the listener status.

% Isnrctl
LSNRCTL>status

If the response to the status command lists a summary of approximately 10 parameters, and one of
these is uptime, then the listener isrunning. Exit by typing:

Isnrctl>exit
If the listener is not working, then start it by typing:
Isnrctl>start

23. Switch user to femis and link the oracle environment parameter file to the femis home directory to
preserve environment file setting integrity.

% su - femis
% In —s ~oracle/.oraclerc

24. Switch user to oracle, and put the database in archive mode.

% su - oracle

% svrmgrl
SVRMGR> connect internal
SVRMGR> shutdown immediate
SVRMGR> startup mount;
SVRMGR> alter database archivelog;
SVRMGR> archive log list;
SVRMGR> shutdown immediate
SVRMGR> startup
SVRMGR> exit

2.3.3.3 Installing and Using Oracle Documentation
Note: Thefollowing application are required to view the Oracle documentation:

HTML: Netscape Navigator 3.0 (or higher) or Microsoft Internet Explorer 3.0 (or higher).
PDF: Acrobat Reader 3.0 (or higher) or PDFViewer Web browser plug-in 1.0 (or higher).

Complete the following stepsto install the Oracle v8.1.6 software.
1. Logcompletely off and back onto the server as oracle with the group set to oinstall.

% id should return something like uid=26000(oracle) gid=26002(oinstall)
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2. Insert the Oracle8i On-Line Generic Documentation CD into the CD drive.
3. Mount the CD

$ cd /cdrom/816_docs
4. Runtheinstaler. Click Next on the Welcome window.

runinstaller &

5. Select aproduct to install, when prompted by the installer, navigate to the CD-ROM, and |ocate the
file INSTALL/docs_816.jar. Select thisfile as your source.

Install the documentation into the SORACLE_DOCS directory that exists if a previous version of
Oracle has been installed. If the directory does not exist, see Step 3 in Section 2.3.3.5, Configuring
Existing Oraclefor Latest Version of FEMIS. If SORACLE_DOCS is set, the documentation will be
installed there regardless of the destination setting specified in this window.

Click Next to verify the product list is correct.

Click Install on the Verification window.

To view the HTML and PDF documentation from aloca installation or from the CD-ROM, follow
these steps:

1. Useyour browser to open the top-level index.htm file within the installed documentation directory.

Note: If you do not wish to launch the Information Navigator Java applet, open thefile
products.htm instead of index.htm.

2. Click on the category of documentation you wish to view (Server and Data Warehousing, Application
Development, Networking and Security, Parallel Server, interMedia, Java, or WebDB).

3. Click onthe HTML or PDF link, on the resulting product-level index file, corresponding to the book
you wish to view. Clicking the HTML link takes you to the table of contents for that book; clicking

the PDF link displays the appropriate document using your installed Acrobat products or your
browser's Acrobat plug-in.

2.3.3.4 Relinking the Oracle Software

Note: If you have Oracle v8.1.6 installed but were required to install, upgrade, or patch the
operating system, then complete this section to relink the Oracle software.

If you just completed the stepsin Section 2.3.3.2, Installing the Oracle Software, then
skip this section because Oracle has aready been relinked.
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1. Shutdown Oracle by logging in to UNIX as the oracle user and complete the following:

% svrmgrl

SVRMGR>connect internal
SVRMGR>shutdown immediate
SVRMGR>exit

2. Relink the Oracle software.

% cd $ORACLE_HOME/bin
% relink all

This process may take several minutesto complete. It will produce alarge amount of output, which
isnormal. Some error output will occur regarding portions of Oracle that are not installed, which is
normal. Aslong as the last messages prior to link completion do not indicate fatal errors, you can
assume the link was successful.

3. Restart Oracle.

% svrmgrl
SVRMGR>connect internal
SVRMGR>startup
SVRMGR>exit

2.3.3.5 Configuring Existing Oracle for Latest Version of FEMIS

Note: If you aready had Oracle v8.1.6 installed and are upgrading FEMIS, then you must
complete this section.

If you have just installed Oracle per the stepsin Section 2.3.3, Installing Oracle or Relinking
Oracle, then skip this section, and go to Section 2.3.4, Defining the Database Topol ogy.

1. Copy the template filesto the admin directory.

% cp -r /lhome/femis/install/oracle_template/* /<install_drive>/app/oracle/admin
% chown -R oracle /<install_drive>/app/oracle/admin

% chgrp -R dba /<install_drive>/app/oracle/admin

% chmod -R 755 /<install_drive>/app/oracle/admin

2. Copy the new Oracle UNIX setup filesto the installation directory.
Note: If you previously had FEMIS installed, you should compare your existing configuration
fileswith the new ones. If your existing files have been customized, then do not

overwrite them but complete Step 3 to make sure the values are still correct for this
Server.
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% cd /<install_drive>/app/oracle/admin

% cp -p oracle.mycshrc /<install_drive>/app/oracle/.mycshrc
% cp -p oracle.cshrc /<install_drive>/app/oracle/.cshrc

% cp -p oracle.oraclerc /<install_drive>/app/oracle/.oraclerc
% cp -p oracle.login /<install_drive>/app/oracle/.login

3. Make sure the following environment variables are correct. Also make surethat al directories
specified by the parameters exist and have their owner, group owner, and mode set to oracle, dba, and
755 respectively. These can be set using the chown, chgrp, and chmod commands.

ORACLE_TERM (set it to match the xterm for the given keyboard: xsun or xsun5)
ORACLE_BASE = /<install_drive>/app/oracle
ORACLE_HOME = /$ORACLE_BASE/product/8.1.6
PATH includes:
$ORACLE_HOME/bin
{usr/local/bin
/bin
/usr/bin
{usr/ccs/bin
ORACLE_SID = fi<x>
ORACLE_DOC = $ORACLE_HOME/doc
LD_LIBRARY_PATH=/usr/lib:/usr/dt/lib:/usr/ucblib:/usr/openwin/lib:/$ORACLE_HOME/lib
/usr/openwin/lib:
ORACLE_EXPORT = /<driveA>/app/oracle/fi<x>/export
ORACLE_LOGS = /<driveA>/app/oracle/fi<x>/logs
ORACLE_FULL = /<driveB>/app/oracle/fi<x>/full
ORACLE_COLD = /<driveB>/app/oracle/fi<x>/cold
CLASSPATH = $ORACLE_HOME/JRE:$3ORACLE_HOME/jlib

4. Switch user to femis and copy the oracle environment parameter file to the femis home directory.

% su - femis
% cd ~oracle
% cp .oraclerc /home/femis/.oraclerc

2.3.3.6 Modifying the Initialization Parameter

Due to changes in FEMIS, one of the Oracleinitialization parameters may need updating. To determine
if changes are necessary, log into UNIX as the oracle user and check the following:

% su - oracle
% cd $ORACLE_BASE/admin/$ORACLE_SID/pfile
% vi init<$ORACLE_SID>.ora

Look for an entry in thisfile, e.g., initfi2.ora, like open_cursors = 800. If thislineis not present, add it; or

if the line exists but the number isless than 800, change the value to 800. If changes are made, the
database must be shutdown and restarted (using the following commands) to make the change active.
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% svrmgrl

SVRMGR> connect internal

SVRMGR> shutdown immediate Wait until the database is down, then:
SVRMGR> startup

SVRMGR> exit

2.3.4 Defining the Database Topology

Note: Thissection must be completed regardiessif thisisanew or upgrade installation of
FEMIS.

Six configuration files are used to define a topology:

/home/femis/etc/eoclist.dat EOC List general topology
/home/femis/etc/grplist.dat Group List snapshot groups
/home/femis/etc/seqlist.dat Sequence List sequence Ids
/home/femis/etc/tablist.dat Table List Table privileges
/home/femis/etc/vuelist.dat View List Views
/home/femis/etc/eocnum.dat EOC Numbers for this site

The primary configuration fileisthe EOC List file, ./etc/eoclist.dat, which is used by many of the FEMIS
shell scripts. The other configuration files are used only by the Make Configuration (makecfg.sh) code
generator.

The EOC Ligt file consists of one record for each EOC database. Each record consists of eight space-
separated columns. Except for the Yes/No flag in column five, nothing should be uppercase.

1: EOC name name of the EOC and Oracle user account

2: Password initial password for the Oracle user account

3: Server server where the data is located

4: Listener Oracle listener name for the account

5: Onpost Y=onpost database, N=offpost database

6: EOC # EOC number used for sequence IDs

7: Port FEMIS notification port

8: Other EOCs Comma-separated list of other EOCs on this server, w/o white space. If none,

then O is used.
: Remote EOCs Comma-separated list of remote EOCs, w/o white space. If none, then 0 is used.

©

The Group List fileis used to define the database replication setup. It indicates which tables go in which
replication groups, plus which tables must have what kind of snapshots. It contains N major sections, the
first one normally for just the one onpost EOC (e.g., tead), and the remaining ones for the offpost EOCs
(e.g., ctoo and utst). The onpost section is different from the offpost sections, which are alike except for
the EOC name in the first column.

The Sequence List fileis used to define the Oracle sequence IDs in the database, which are used to
generate unigue keys when inserting records into the database.
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Thetablist.dat file controls table privileges for database users. It has one row for each tablein the
database. It is possibleto modify thisfile at the time of thisinstallation but extreme care must be taken.
See Section 4.5, Security Provisions, in the FEMI'S Data Management Guide for a description of the
format of thisfile.

The View List fileis used to define which views are created on which tables. The views combine data
from other EOCs into a site-wide version of shared tables. For example, the S_FACILITY view isa
combination of the Facility tablesin each of the EOC databases.

The eocnum.dat fileisthe basic file that determines the names of the EOCs at a site and assigns an EOC
number to each. Thisfileis used by the Build Topology Program, bldtopo.sh and is placed into the

/home/femis/etc directory as part of theinitial installation of a site’s database package. It is preserved
throughout the installation of the FEMIS package (Section 2.2.2, Upgrading the FEMIS Application,

Step 2).
2.3.4.1 Running the Build Topology Program

To define atopology, you must create the configuration files and put them in a standard location using the
Build Topology program.

1. Login asfemis.
2. Copy the eocnum.dat fileif you have never installed a database package.

% cp /home/femis/database/exports/<site name>/eocnum.dat /home/femis/etc
3. Createthe configuration files, and place the filesin a standard location.

%cd ~femis/etc
% ~femis/database/dba/bldtopo.sh

The Build Topology program prompts you for information to define the general topology-the EOC List
file. If at any point you do not specify something, the program will exit.

How many servers? ==>

Enter the number of serversin the topology. For example, for a 3x1, enter 1; for a 6x6, enter 6; or for a
8x4 enter 4.

The build topology program reads the eocnum.dat file and displays the information back to the window.

Enter server name for <eoc_name> ==>
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Each time you get this prompt, you must enter the name of the Sun server where the FEMIS database for
the EOC that islisted will reside. For example, for the CTOO database, enter tcemsun.

Enter listener for <eoc_name> ==>
Enter the Oracle listener name for that server. For example, fi3.

The loop then repeats, asking for the next server and listener until you have supplied al of them. If you
have specified an Nx1 topology, then the script will ask you for the server and listener name only once.

After you answer dl the prompts, the Build Topology program creates the remaining topology files
automatically.

2.3.4.2 Setting Up the EOC DBA Directory (as femis)

Asreleased, FEMIS contains a ~femis/database directory that has a number of subdirectories, none of
which should be changed. However, for your own use, you need aworking copy of some of thefiles.
Plus, you need to generate brand new SQL scriptsthat are specific to your database topology. When you
have completed the following steps, you will have your own ~femis/database/eocdba directory with all
the scripts you will need to manage your FEMIS database.

1. Login asfemis.

2. Create aworking directory, eocdba, for your own use.

% cd ~femis/database/dba
% mkeocdba.sh

3. Generate the scripts used to load the stored procedures.

% cd ~femis/database/eocdba
% makeproc.sh

This shell script creates the driver scriptsto create (master_cr_procedures.sgl) and drop
(master_dr_procedures.sql) the stored proceduresin all the FEMIS EOC database schemas. The
shell script also creates all the actual server-specific files, cr_procedures_ SERVER.sqgl and
dr_procedures_SERVER.sql.

4. Generate the scripts used to manage and control the database.

% cd ~femis/database/eocdba
% makecfg.sh

This shell script creates avery large number of SQL scripts.
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Note: Itisessential that all FEMIS server s use the same database topology. Besureto
copy the eocdba and etc directoriesto all serversin the configuration since every
server needs the samefiles.

2.3.5 Creating or Updating the FEMIS Database
Complete the following sections to create or update the FEM S database.

2.3.5.1 Creating the Database Schemas
The following steps must be completed on each server in the site configuration. Verify that thefilesin
both the /home/femis/etc and /home/femis/database/eocdba directorieswere copied to all servers
(See Section 2.3.4.1, Running the Build Topology Program). Complete the following steps to create the
database schemas.
1. Login asfemis.
2. Change to the ~femis/database/eocdba directory.
% cd ~femis/database/eocdba
3. Skipthisstep if you are updating the database; the tablespaces already exist.
To place thefilesin the desired directory(s), edit thecr_db_ts_<sever name>.sql file. If possible,
place the fmain and findex tablespaces on different disk drives. Place the fsnapshot and fsnaplog

tablespaces on different disk drives aswell. For example:

fmain.dbf /<driveA>/app/oracle/oradata/fi<x>  300M
findex.dbf /<driveB>/app/oracle/oradata/fi<x> 400M
fsnapshot.dbf /<driveA>/app/oracle/oradata/fi<x> 500M
fsnaplog.dbf /<driveB>/app/oracle/oradata/fi<x> 200M

Note: An Nx1 configuration will not have the last two shapshot definition lines above.
4. Runthe Master Create Database script for either a new installation or an update.

Note: Before continuing, this script must be executed at each server in the configuration while
logged onto the server locally as femis.

This script creates the new tablespaces and schemas. If you are performing an update, then you will

receive error messages stating that the tablespaces and some of the data schemas already exist.
Disregard these messages during the update.
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Note: InFEMISv1.4.7, Oracl€ ssys schemaisrequired to run the master_cr_db script.
In some previous versions, the system schema was required to run this script.

% sqlplus /nologin
SQL> @master_cr_db_<server name>.sq|l

Enter <Sys Password> when prompted.

2.3.5.2 Loading Data (as femis)

Note: Depending on what installation steps you have previoudly completed, you will either
update the datain your database, or import data from one of two places and perform the
update. Please review this section carefully.

If you installed Oracle v8.1.6 and had a previous version of FEMIS installed, then you will want to import
the data that was exported in Step 2 of Section 2.3.2.1, Dropping Database Objects and Exporting Data
Owners.

If you did not have a previous version of FEMIS and have installed the GIS and database package
(Section 2.3.1, Installing the GIS and Oracle Database), then you will want to import the data found in the
/home/femis/database/exports/<site name> directory.

Note: Remember that you need to know where each of the N data owners are for your NxN or
NxM database configuration. Y ou will import the data for each data owner exactly one
time across al the servers at your site. If you have an NxN configuration, you will
perform one import on each server; but for an NxM configuration, some servers will have
more than one data owner. You will not import any datainto any of the snapshot owners.

1. Login asfemis.

2. Complete the Oracleimport function.
% cd /home/femis/database/exports/<site name>
% imp <USER1>/<PASSWORD> file=<EOC_name>_<EOC_date>.dmp log=<USER1_today’'s
date>.log
% imp <USER2>/<PASSWORD?> file=<EOC_name>_ <EOC_date>.dmp log=<USER2_today's
date>.log

...and so on

The actual name of the .dmp files will be specific for your site and may contain a date stamp, e.g.,
anad_19961210.dmp.

Thefollowing is an example for an 8x8 Alabama configuration on a server with the ANAD data owner
schema and seven snapshot owner schemas.

% imp anad/anad file=anad _19961210.dmp log=anad_<today's date>.log
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2.3.5.3 Upgrading Database from Previous Versions of FEMIS

STOP
Before continuing, make sure that the imports for all EOCs have been compl eted.

Note: Perform the following upgrade only if you had FEMIS v1.4.6 installed, and you are
upgrading to v1.4.7. When these upgrade scripts are executed the database structure will be
modified for all EOCs at your site. Therefore this upgrade process only needsto be
performed once at one EOC.

1. Run the update structure/data scripts to update all the owner schemas and create the scripts for the
upgrade from FEMISv1.4.6 tov1.4.7. All databases must be up and available during this operation.

% su - femis
% cd /home/femis/database/upd/V1.4.6_V1.4.7
% makerun.sh

Note: If you prefer to run the update in its entirety and review it later for errors, then you can
use the makerun_nopause.sh script to create the update scripts without any pause
statements.

2. Runthe master_run.sgl script when you are sure the makerun.sh script executed successfully. The
update scripts will now be run one at atime. There are pause statements scattered liberally
throughout the scripts. Watch closely for errors as each script is run.

% sqlplus /nologin
SQL> @master_run

Note: If you used the nopause shell script and find errors, you may have to start your build
process over from the time of the imports.

2.3.5.4 Creating Objects that Share Data (as femis)

STOP

Befor e continuing, make sure all serversareonline, and the databasesfor all EOCsare
configured for FEM1Sv1.4.7.

At this point, you should have schemas on all servers and have loaded the data. Y ou are now ready to
create views, snapshots, synonyms, and other replication-support items.

Note: Thiscreate process needsto be performed once, but it must be done on the server that
hosts the onpost EOC.
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The Master Create SQL script (master_cr.sql) runs scriptsthat create the following:

sequence humbers (All)
alternate views (All)
snapshot logs (NXN, NxM)
snapshots (NXN, NxM)
snapshot groups (NxN, NxM)
synonyms for onpost tables  (All)
site views (All)

replication tablesand code  (NxN, NxM)

To run the Master Create SQL script, which can take hours to complete on a multi-server configuration,
complete the following:

1. Login asfemis.

% cd ~femis/database/eocdba
% sqlplus /nologin @master_cr.sql

Y ou need to watch its progress and occasionally press Enter when prompted. If errors occur, use Ctrl-C to
stop the script so you can determine what caused the errors.

2.3.5.5 Creating FEMIS Schema Synonyms

The Oracle FEMIS schema at each instance in the database configuration requires a set of synonyms.
Upon the successful running of the master_cr.sql script in the previous section, these synonyms have
been created for the onpost server only. For each of the offpost servers, complete the following
instructions once for each server.

1. Login asfemis.
% cd ~femis/database/eocdba
%sqlplus /
SQL> @cr_femis_<eoc code>_syn.sql
SQL> exit
where the <eoc code> is any one of the data owners located at the server being used.
2.3.5.6 Fixing the EOC Table (as femis)
Run the following script once for all EOCs. It will change the Notify port, the UNIX port, the Server

name, and EOC number to match the EOC List file. This process needs to be performed once at one EOC
to change the EOC datafor al EOCs.
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1. Login asfemis.

% cd ~femis/database/eocdba
% fixeoc.sh -fix

2.3.5.7 Setting Up the Oracle Backups
Note: Thefollowing needsto be performed once on all servers.

To set up the crontabs to perform automatic database backups and exports, complete Steps1and 2. To
perform afull cold backup, complete Step 3.

1. Switch to the femis user, and enter the following:
su — femis
% cd ~oracle/admin
% crontab femis.crontab
Edit the crontab to replace $SHOME with /apps/oracle.

2. Switch to the oracle user.

su - oracle
% cd ~oracle/admin
% crontab oracle.crontab

3. Perform afull backup to another directory by entering the following commands:

% cd /<install_drive>/app/oracle/admin
% dbbackup_cold

For more information on the Oracle backups, see Section 13.0, Backup Strategy for FEMIS, in the
FEMIS System Administration Guide.

2.3.5.8 Starting Replication (as femis)
Since neither an NxN nor an NxM configuration store data for all EOCs on each server, the data must be
replicated by Oracle to make all of the data accessible to all servers. The following script startsthe
replication process for your configuration.
If you have an Nx1 database configuration, then skip this step.

Note: Thefollowing only needsto be performed once at one EOC.

Do not start replication until all the FEMIS databases have been installed and configured on
all serversat the site.
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To start replication, run the Master Start Replication script.
1. Login asfemis
% cd ~femis/database/eocdba

% sqlplus /nologin
SQL> @master_rep_start.sql

2.3.6 Configuring the FEMIS Files (as root)

Note: Thefollowing needsto be performed once on all servers.
This section explains how to configure the FEMIS files to accommodate the database topology by
running the FEMIS configuration script. Before you run this script, you will need to determine some site-

specific values.

Determine the Oracle settings

ORACLE_SID (Example: fi4)
ORACLE_BASE (Example: /filesl/app/oracle)
ORACLE_HOME (Example: /filesl/app/oracle/product/8.1.6)

The above values can be determined from the Oracle account environment file /apps/oracle/.oraclerc,
or by logging into the Oracle account briefly and running the env command.

If DEI wasinstalled, decide upon the following items

FEMX Home Directory  (Default: /home/femx)
EMIS Host Computer (Example: teadsun)
EMIS User-Name (Default: femx)

EMIS Password (Example: femxfer)

The FEMIS configuration script uses the /home/femis/etc/eoclist.dat, System settings, the
/home/femis/install/femis_info file, and Oracle database settings to create the FEMIS configuration files,
which will be placed in the ./nome/femis/etc and /home/femis/configd directories.

Note: Before configuring FEMISfiles, you must know the EOC name, the EMIS transfer
account password, and your UNIX server netmask.

To configure the FEMISfiles:
1. Loginasroot.

2. Change the directory to the FEMIS install directory, usually /home/femis/install.
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3. Edit the femis_info file so the values match the system setup.

The Oracle environment variables should be set to match the values given in the ~oracle/.oraclerc file.

Note: You must include the explicit file path for the Oracle directories listed in thisfile.
Automount pointswill not work in this context.

The FEMIS DEI variables only need to be st if the server will be running DEI.
EMIS_HOST should be set to the server name and the EMIS_USER must be set to emisx.
4. Change the directory to /home/femis/install/femis_template/etc.

5. Edit the femisdei.cfg file. Remove or comment out (by placing a“#” character at the beginning of the
line) the line that starts with ORACLE_USER.

6. Change the directory back to /home/femis/install.
7. Executethe ./configure_files.sh script. Follow theinstall prompts for EOC name(s), EMIS transfer

account password, UNIX server netmask, and whether Samba paths are generated instead of NFSfile
paths.

2.3.7 Copying files to the /Thome/femis/user directory

Several fileslocated on the shared directory that PCs map to the M:\ drive are used to patch files and
update the Oracle data sources on each PC.

To set this up, you must copy the following files from /home/femis/configd to /nome/femis/user.
fupdate.tpl
Also, you must copy the following files from /home/femis/pc/femmisc to /home/femis/user.

odbcsub.vbs
pfemis.vbs

Rename fupdate.tpl to fupdate.bat. When logging in, the FEMIS startup script will execute the
FUPDATE.BAT batch file. FUPDATE.BAT can be used to update any file(s) on al FEMIS PCs such as
the HOST file or GIS datafiles. View FUPDATE.BAT for specific instructions.

2.3.8 Correcting Group Ownership

Verify the group ownership is correct on the /home/femis, /homeffemis/user, and /home/femis/pc/femtools
and that they are in the femisrun group. If it is not correct, enter the following command at the UNIX
prompt logged in as root.
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# chgrp femisrun /home/femis /home/femis/user /home/femis/pc/femtools
Verify user account directories group membership with the following command.
# find /home/femis/user \! —.group femisrun —Is | more

Typicaly, this command should not return anything. If it does, then the return will be alist of filesand
directories that do not have femisrun group membership. This situation may be occurring by design to
protect datain certain accounts. Consult the local administrator to determine if thisisthe case. If this

situation was not intended, then correct with the following command.

# find /home/femis/user \! —group femisrun —exec chgrp femisrun {} \;

To correct individual users or groups of users use an argument list and/or wildcard notation for the
directory list argument(s) to find. For example, to just correct files belonging to the FEMIS users info
and train, the following command would work.

# find /home/femis/user/info /home/femis/user/train \! —group femisrun —exec chgrp femisrun {} \;

2.3.9 Verifying the Configuration Files (as femis)

Having run the FEMIS configuration script (Section 2.3.6, Configuring the FEMIS Files), you must now
verify whether the configuration filesit created are correct.

1. Login asfemis.
2. Check that the femis account is setup correctly.

% env
USER=femis
HOME=/home/femis
SHELL=/bin/csh
FEMIS_HOME=<full path>
LD_LIBRARY_PATH=/usr/lib:/$FEMIS_HOME/lib:/usr/ucblib

Note: Because of the integration of the contents of .oraclerc file into the femis environment,
some paths may be duplicated in LD_LIBRARY_PATH, or PATH (below). The
duplication does not cause any known problems and can be left asis. What iscriticd is
that the /usr/lib path be before any /usr/ucblib paths, particularly in the
LD_LIBRARY_PATH environment variable.

The ORACLE_SID and ORACLE_HOME environment variables must be set. The valuesfor these are
site/server dependent. The ORACLE_SID should be set to the string “fi* followed by a server-specific
number. The ORACLE_HOME environment variable will point to the home directory of your Oracle
installation.
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The PATH environment variable, as a minimum, includes the following:

.:/home/femis:/bin:/usr/bin:/usr/sbin:/$0ORACLE_HOME/bin:/etc:/usr/ccs/bin:$FEMIS_HOME/bin:$FE
MIS_HOME/database/dba

Note: ThePATH variable may include /usr/local/bin on those sites where this directory exists so
that remote Secure Shell utilities will work for the femis UNIX account.

3. Verify your have the following files if thisis an onpost installation.

/home/femis/etc/femisdei.cfg
/home/femis/etc/femisdei.prf

4. Vadlidate the /homeffemis/configd/hosts file: The HOSTS file should be configured with the correct
host names and |IP addresses. Thisfile should be a copy of /etc/hosts on the UNIX system.

5. Vadidate the /nome/femis/configd/addodbc.bat file: FEMIS uses the home/femis/configd/addodbc.bat
batch file to add al the necessary ODBC (Open Data Base Connectivity) values. Verify that the
mapping from EOC code to listener ID is correct in each line. Copy good version of addodbc.bat to

/home/femis/user.

See Section 4.2.8, Validating I'\USER Directory, for instructions on copying thisfile so that all the
FEMIS PCs are setup with the correct ODBC values.

6. Vaidate the /home/femis/pc/xntp/ntp.conf file: the ntp.conf file should be configured with the correct
IP address for the time server.

The line beginning with “server” must have the correct |P address of the NTP server, which should be
one of the UNIX servers on the WAN.

7. Check the system filesto verify the FEMIS entries were added.

letc/services
/etc/inetd.conf

In the /etc/services file, you should see a service hamed femis setup for port 1776. Inthe
letc/inetd.conf file, you should see a femis entry pointing at the full file path of the femisd executable.

8. Check the FEMIS startup/shutdown script.
[etc/init.d/femis
9. Check the FEMIS dot files.

/home/femis/.femisrc
/home/femis/.oraclerc
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2.3.10 Setting Up the Command Server Configuration File

The access block in the command server configuration file needs to be set up. This set up isnot done
automatically during installation and needs to be set up manually. If this step is not performed and
completed correctly, FEMIS Evacuation and any other program needing the command server will
terminate with an Access Denied error.

During FEMIS UNIX ingtallation, the command server configuration file cmdserv.conf is copied to
/home/femis/etc. Verify that thisfile exists.

In the cmdserv.conf file, locate the access block. This block begins with [ACCESS] and ends with [END].
The required directives within the access block are deny and allow. Each directive can contain an IP
address and an IP subnet mask. These arguments define the range of |P addresses that are to be alowed
or denied access to the command server. Also refer to Section 4.0, FEMIS Command Server, in the
FEMI S System Administration Guide for details on command server syntax.

The correct set up isto deny access by clients on all 1P addresses except the ones that specificaly areto
be allowed. To accomplish this, thefirst directive should be deny 0.0.0.0, and the remaining directives
should be combinations of allow and deny to establish the allowed |P address ranges.

Theinstaller needs to obtain the IP address and subnet mask of the LAN on which the UNIX server was
installed, along with the same information for al other LANS on the Wide Area Network (WAN).

As an example, the following block is valid for the Oregon/Washington network:

[ACCESS]

Deny 0.0.0.0 # deny all except
Allow 198.176.0.0 255.255.248.0 # oregon

Allow 199.233.108.0 255.255.255.0 # benton county
Allow 199.47.32.0 255.255.255.0 # washington
Allow 131.92.39.0 255.255.255.0 # umcd

[END]

The above example access block is used on all six Oregon/Washington WAN servers.

To allow additional ranges of 1P address to access the command server, simply add the appropriate alow
directives in the access block.

Do not copy thisfile from host-to-host, as the file contains host/site dependent fields, such as host name,

site name, Oracle instance name, and full Oracle path. Instead, edit each cmdserv.conf file on each host
one at atime.
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2.3.11 Setting Up femis_event

Note: If al of the UNIX hostsin your WAN have one and only one |P address, then this section
can be disregarded. However, if any of the UNIX hosts have dual ethernet interfaces
(i.e., they perform router functions, or have multiple IP addresses), then pay special
attention to the following workaround.

Interconnections between notification servers are accomplished by including the service port and UNIX
host name on the startup command line, e.g., A> femis_event -c 9020@B 9020@C where A, B, and C are
names of UNIX hosts. For this example of setting up femis_event, assume that host B has multiple IP
addresses, and that all such addresses are included in the /etc/hosts files on A and other nodes on the
network.

First determine which IP addresses for B, and all multiple IP address hosts in the network, is the primary
IP address for host B. Log into B’s femis account, and run femis_event with only the -i option. You
should get aresponse such as the following:

B% femis_event -i

Last build .......... Thu Oct 17 11:54:08 PST 1996
Host nameis ..... B

IP address is ..... 111.111.111.111

Port number is ... 9020

Next, on al nodes where notification servers are to be executed, ensure there is a unique name in the
letc/hosts which resolves to the | P address reported above. For example:

A% grep B /etc/hosts
111.111.111.2111 B
111.111.222.222 B

Be sure to substitute the actual host namesfor A, B, and C. Edit and modify the host’ sfile, adding a host,
e.g., BB, name which resolvesto a unique IP address. For example:

A% grep BB /etc/hosts
111.111.111.111 BB

From this step forward, you should always refer to the server with multiple |P addresses by the unique
name associated with the IP address found in the femis_event-i command. In this example, BB isthe IP
address name.

Note: Failing to implement the above workaround for UNIX hosts having multiple IP addresses
can have disastrous results. Under some conditions, afemis_event process can terminate
with abus error after running out of file descriptors if this workaround is not
implemented as described.
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2.4 Checking the FEMIS Startup

To check the FEMIS startup, you will need to reboot the server and verify the FEMIS programs are
running.

2.4.1 Rebooting the Server (as root)

To activate some of the system-level changes that the FEMIS UNIX Installation script makes, complete
the following steps to reboot the server.

Note: If you have an Nx1 database configuration, then skip Steps 1 and 4.
1. Login asfemis, and stop master replication.

%cd /home/femis/database/eocdba
%sgplus /nologin @master_rep_stop.sql

2. Loginasroot.
3. Enter the following on a Solaris machine:

# letc/init 6

As the server reboots, note the status messages during the startup of the FEMIS processes.
4. Login asfemis, and start replication.

%cd /home/femis/database/eocdba
%sgplus /nologin @master_rep_start.sql

2.4.2 Verifying the FEMIS Programs (as femis)
After the server has rebooted, verify that the FEMIS programs are running.
Login asfemis.
For an NxN configuration, there should be one FEMIS Notification Server process running. For an Nx1
configuration, there should be N of them running. For an NxM, there should be one FEMIS Notification

Server process for each EOC per server in the configuration.

% ps -ef | grep femis_event
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If it is not running, restart it with logging turned on.
% startnotify -log

Then use the Show Notify utility.
% shownotify aux

Refer to Section 3.0, FEMIS Notification Service, in the FEMI S System Administration Guide for more
information.

If DEI should be running, check it aso.
% ps -ef | grep femisdei

If it is not running, check the log file home/femis/log/femisdei.log, to see what happened. The most
common problem occurs when DEI cannot connect to Oracle. Check the configuration file,
/home/femis/etc/femisdei.cfg, and restart DEI by typing femisdei. Refer to Section 7.0, FEMIS Data
Exchange Interface (DEI), in the FEMI S System Administration Guide for more information.

2.5 Utility to Add FEMIS Login Account to the Database

The adduser utility enables you to add a FEMIS login account for a FEMIS user to the database. To use
the utility, follow the procedure in the example, substituting the new login account name for wayne.

Note: Theadduser.sh script will try to add an account to each database specified using the
database password found in /home/femis/etc/eoclist.dat. The second columninthisfileis
the password column. If the database password has been changed for security or other
reasons, then thisfile is kept deliberately out of date. If you need to run adduser.sh
against a particular database that has changed its password, temporarily update the
/home/femis/etc/eoclist.dat file to contain the proper database password in the second
column before actually running the adduser.sh script. After running the script, restore
the /home/femis/etc/eoclist.dat to its original condition.

To create a FEMIS login account for wayne, compl ete the following steps.

1. Login asfemis.

2. Run the adduser.sh script with the appropriate command line parameters.
To add alogin account for a specific EOC, run

% adduser.sh -user wayne -eoc <eochame> -run

where <eocname> must be in lower case.
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or
To add alogin account on all EOCsin the configuration, run
% adduser.sh -user wayne -all -run

This script will create and run an SQL script to add the user to the database and give the new user all
privileges. It takesalong timeto run.

The script does the following:

e Addsamostly empty record for the user to the PERSON table.
» Addsarecord to the FEMIS_USER table.
*  Adds many records (>200) to the USER_MODE_PRIV table.

Y ou should then be ableto login to FEMIS on the PC as the new user (wayne) with the password femis.

2.6 FEMIS AutoRecovery System Description and
Installation

Note: You must have the FEMIS Perl package installed to use AutoRecovery, see Section 2.1.6,
Installing Perl v5.004-04.

The FEMIS AutoRecovery systemis used to monitor the FEMIS server and application.
The following files are used, generated, or they indirectly affect the FEMIS AutoRecovery system:

/opt/local/bin/femis_watch
/opt/local/bin/femis_watch.conf (typical path)
/opt/local/bin/logit

/var/log/femislog[1-7]

/tmp/.auto.debug

/tmp/.autorecovery.pid
/var/tmp/.autorecovery.run
/home/femis/etc/eoclist.dat

letc/syslog.conf

Thetwo files, femis_watch and femis_watch.conf, are Perl scripts that comprise the heart of the FEMIS
AutoRecovery system.
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The FEMIS AutoRecovery systemis run by cron. The run scheduleis set in the root crontab. The default
scheduleis

Mon thru Fri

7:00a to 6:00p - run AutoRecovery every ten minutes
6:00p to 7:00a - run AutoRecovery every half hour
Sat & Sun - run AutoRecovery hourly

To change the run schedule, edit the root crontab. Seethe UNIX man page on crontab before proceeding.

% su -
# crontab -e

2.6.1 Messaging Service

The AutoRecovery system uses three messaging services: logging, E-mail, and FEMIS Notification
Service. By default the three messaging services are enabled.

To disable any of the messaging services, comment out the appropriate linein thefile:
/opt/local/bin/femis_watch.conf

For example, to disable syslog messages, comment out the following line:
$syslog_it = 1;

To disable E-mail messages, comment out the following line:
$mail_it = 1;

To disable natification through the FEMIS Notification Service, comment out the following line:
$notify it = 1;

2.6.2 Logging

AutoRecovery logging is performed through syslog and can be configured with the following levels:

warn — log only warning messages
notice — log warning messages and restart messages
info — log all reported messages

The default log level isinfo.
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To log both warning and restart messages, compl ete the following steps.
1. Edit /etc/syslog.conf and change:
local7.info to: local7.notice

Log archiving is performed by the script /opt/local/bin/logit. This script isrun nightly from the root
crontab. The default number of logs archived is 7 days. The number of days archived can be
configured by changing the value for NUM_OF_DAYS_TO_ARCHIVE in the /opt/local/bin/logit script.

Thelogfileisset in /etc/syslog.conf. The default log fileis /var/log/femislog. The log file can be
changed by editing /etc/syslog.conf and /opt/local/bin/logit.

2. Restart syslogd.

% su -
# sh /etc/init.d/syslog stop
# sh /etc/init.d/syslog start

2.6.3 Sending E-mail

AutoRecovery sends all warning messages via E-mail to the root user by default. This configuration can
be changed or added to by editing the file /opt/local/bin/femis_watch.conf and changing or adding E-mail
addresses to the $Custodian line. A single space separates each E-mail address. See the example below
for clarification:

$Custodian = ‘root femis admin@smtp.foo.com’;
E-mail can be sent to any valid SMTP recipient. For instance, addresses can beto real users, local and

remote server aliases, other mail gateways, and to files and/or programs for filtering. For syntax, and
mail configurations to support expanded E-mail capability, consult your site’s mail server documentation.

2.6.4 Running Processes

AutoRecovery verifies certain processes are running. The processes are defined in
lopt/local/bin/femis_watch.conf. The format isasfollows: daemon name, minimum number of processes,
maximum number of processes, time value, restartable flag, and restart command.

The following line is the default configuration for the syslog daemon. The line defines the syslog daemon
process syslogd. A minimum of one processisto be running, and not more than three. Also, thetime
value specifies a one second wait before attempting to verify that a restart of the daemon was successful.
The daemon is restartable, and the restart command is "sh /etc/init.d/syslog start".

["syslogd”, 1, 3,1, 1, "sh/etc/init.d/syslog start"],
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Thefollowing lineis the default configuration for only one NFS Magestro daemon, and it will restart the
daemon if the number of processesis less than one.

[ “helnfsd”,1, 1, 1, 1, “sh /etc/init.d/hcinfs stop; sh /etc/init.d/hcinfs start” ],

Note: To effectively disable process monitoring (which we do not recommend), set minto 0,
and max to a high number, such as 500.

The time value, mentioned above did not have functionality in previous versions of
FEMIS (formerly known as the status flag). In thisversion the value specifiesatimeto

wait (in seconds) before verification of aprocessrestart is attempted. This appliesto all
so-defined restartable processes.

2.6.5 Monitoring Swap and Disk Space

AutoRecovery monitors used disk and swap space. The thresholds are defined in
/opt/local/bin/femis_watch.conf and can be customized for each server.

The following are two examples of configuration changes.

1. Complete the following steps to change the swap space monitoring to report 60% full instead of 80%
full:

Edit /opt/local/bin/femis_watch.conf
Change $swap = 80; to $swap = 60;

2. Complete the following steps to change the disk space monitoring to report when / (root file system)
iS90% full:

Edit /opt/local/bin/femis_watch.conf.

Look for the “@disks = ( “ section.

Edit the line by changing [ “/” ,80], to[“" ,907,
2.6.6 Remote Host Auto-Carve and Auto-Insert
The database design in FEMIS version 1.4.7 now allows AutoRecovery to dynamically remove and
reinsert remote serversin asite configuration on the fly. Thisinsertion and deletion primarily affects

replicated database data, but also affects messages that AutoRecovery sends out. Four parametersin
femis_watch.conf control how these functions behave. They are
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$auto_carve = 1; # Allow auto_carve if defined
$auto_insert =1;  # Allow auto reinsertion if defined

# Auto Carve threshold - meaningless if $auto_carve is not defined
$ac_threshold =5; # Defined in terms of number of AutoRecovery runs
# Auto Insert threshold - meaningless if $auto_insert is not defined
$ai_threshold = 1;  # Defined in terms of number of AutoRecovery runs

auto_carve and auto_insert define whether each respective featureis enabled. Thisiscontrolled with a
zero (disabled) or one (greater than zero - enabled) value. The threshold val ues define the number of
AutoRecovery runs required befor e the specific action occurs, and are defined in terms of AutoRecovery
runs. Zero can be valid values for either threshold, although it is not highly recommended to use this
value. Generally, the values shown are recommended.

auto_carve will remove a host from database push replication if the host is down (not reachable, or
experiences listener and/or database process errors) for the number defined in $ac_threshold of
AutoRecovery runs. For example, on the sixth consecutive failed run with the above set definitions,
AutoRecovery will remove the problem server from push replication.

Conversely, as soon as the host becomes available again, on the second successful run of good status, it
will be reinserted back into the database replication push configuration.

Please refer to Section 2.1, AutoRecovery, in the FEMI S System Administration Guide for further
information.

2.6.7 Remote Process Monitoring

Previous versions of AutoRecovery did not allow any configuration to determination if aremote system
was good or bad based on the processes running on that system. This version now has a section in the
femis_watch.conf file which defines thresholds and values of processes on remote systems for
determining if aremote systemis*good” or not. The definition table is caled @femismon_proc. This
table must not have the entry order changed, nor any entries removed. Ignoring a particular process
altogether is accomplished with an ignore flag which is set or cleared in the array definition. The table
columns are defined as follows:

<descriptive daemon name>, ignore_flag, min, max
Toignore an entry, set ignore_flag to 1= 0.

For example:
["OraArch", 1,1, 1],

defines the eighth row in the @femismon_proc array. The ignore flag is greater than zero, so this

value will be ignored when determining if aremote server is“good” or not. If it were not ignored, an
error would be generated if there were less than, or greater than, one remote OraArch processes, and
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the remote server would not have been considered available. The string “OraArch” has no bearing in
this array on how the remote search is conducted. It is merely just a descriptive string name for
output in the error message.

2.6.8 AutoRecovery’s WatchDog Timeout Parameter
AutoRecovery now has a configurable timeout value. In the event that AutoRecovery were to hang
because of problems completing a command or spawned process, it will now force itself to abort
processing if it is active for longer than the value defined in
$watchdog_timeout = 480; # 480/60 = 8 minutes
where the value is defined in seconds.
Note: Setting the timeout value to something greater than the smallest crontab interval is an
acceptable practice; however, subsequent AutoRecovery runs will complain about a
previous run of AutoRecovery not completing and will exit if arun gets stuck. This will

continue until the hung AutoRecovery process times out as defined. PNNL recommends
that to avoid confusion, the value be set less than the smallest croninterval.

2.6.9 Installing AutoRecovery
Remove the previous version of the AutoRecovery package.

# pkgrm FEMISar
The FEMIS AutoRecovery system has been included with the FEMIS software distribution. FEMIS
AutoRecovery requires the FEMIS packaged Perl version 5.004 to run. To install, see Section 2.1.6,
Installing Perl v5.004-04. Toingtal FEMIS AutoRecovery, you will need to create a spool directory that
will require approximately 1IMB of disk space.
1. Logininasroot.

2. Insert the FEMIS tape into the tape drive, and enter the following commands as root:

# mkdir /<dir>/spool
# chmod 755 /<dir>/spool

3. Spool theinstallation package from the 8mm tape.
# pkgadd -s /<dir>/spool -d /dev/rmt/??
where ??is the device number of the tape drive.

Select FEMISar from the available package list.
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4. Run the pkgadd utility to install the FEMISar package.
# pkgadd -d /<dir>/spool
Select FEMISar and follow the prompts through the installation.
5. Use pkgchk to verify that FEMISar were installed correctly.

#pkgchk -n FEMISar

Note: The packagesinstalled successfully if no error output is displayed. Report any errorsto
PNNL.

6. Remove the spool directory.
# rm -r /<dir>/spool
7. Logout.
2.6.10 Configuring AutoRecovery
To configure FEMIS AutoRecovery, complete the following steps.
1. Login asfemis.
2. Edit the AutoRecovery configuration file /opt/local/bin/femis_watch.conf. Example:

% chmod u+w femis_watch.conf
% vi /opt/local/bin/femis_watch.conf

Enable/disable Auto-Carve/Auto-Insert as desired and set appropriate thresholds, if necessary.
Verify the restart commands are correct for al restartable processes.

Add additional $Custodians to receive E-mail when a problem is detected.

Verify the SENV{FEMIS_HOME} variable points to the FEMIS instal lation directory.

Verify the SENV{ORACLE_HOME} variable points to the Oracle installation directory.
Modify disk thresholds and default disk names; add disks as necessary.

Replace the host entries in the @network list with the other servers at your site.
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Verify the two linesin the %oracle_tablespaces definition match the following:

SYSTEM => 100,
TOOLS => 100,

Save and exit thefile.
Enter chmod u-w femis_watch.conf.
3. Edit the FEMISar linesin the root crontab.

% suU -
# crontab -e

Change volXX inthe LD_LIBRARY_PATH = $LD_LIBRARY_PATH : /volXX/ environment variable to
reflect the correct Oracle path.

Uncomment the FEMISar execution lines.

The FEMIS AutoRecovery should start running at the next scheduled FEMIS AutoRecovery
(femis_watch) cron event. To verify it isrunning, check the log file for recent entries.

% tail /var/log/femislog

2.7 AutoRecovery Web Reporting Application

AutoRecovery monitors the FEMIS server and reports any errors to your System Administrator, using a
standard E-mail message. Y our System Administrator must log into E-mail and examine the messages to
determineisa server has aproblem. PNNL developed the AutoRecovery Web Reporting application to
provide a more generic way for your System Administrator to examine the status of their systems.

Using the AutoRecovery Web Reporting application, messages can be sent to a central E-mail account.
The E-mail is processed by AutoRecovery Web Reporting and displayed by aweb server. Your System
Administrator can view the status of your server using any browser application. AutoRecovery Web

Reporting can be expanded to receive E-mail from each EOC. Using this capability allows all System
Administrators to status their EOC server messages without installing a web server at each EOC.

2.7.1 Software Requirements
AutoRecovery Web Reporting requires the following applications:

* FEMIS AutoRecovery v2.2
* PERL v5.004-04
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* MailToolsv1.13 (a PERL extension included in the FEMIS PERL package)
* Apache Web Server v1.3.12

FEMIS AutoRecovery and PERL are packaged separately. The Apache Web Server, and the
AutoRecovery Web Reporting scripts are included in the FEM1Sarw package.

2.7.2 AutoRecovery Web Reporting

If you are upgrading FEMIS, you must remove the previous version of the AutoRecovery Web Reporting
package.

2.7.2.1 Removing the AutoRecovery Web Reporting Package
1. Loginasroot.
2. # pkgrm FEMISarw
Select y to continue when the following prompt displays: Do you want to remove this package?

Also select y for this prompt: Removing installed package instance <FEMISarw>. This package
contains scripts that will be executed with super-user permission during the process of removing this
package. Do you want to continue with the removal of this package [y,n,?,q].

3. Veify that the package was removed successfully.
2.7.2.2 Installing AutoRecovery Web Reporting

Note: This package has dependencies on the Perl 5.004. The Perl package must beinstalled
before you caninstall AutoRecovery Web Reporting.

To instal AutoRecovery Web Reporting, which has been included with FEMIS v1.4.7, complete the
following steps.

1. Loginasroot.
2. Insert the FEMIS application tape into the tape drive.
To create atemporary spool directory, run the following:

# mkdir /<dir>/spool
# chmod 755 /<dir>/spool
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Spool the installation package from the 8mm tape using the Solaris software installation utility.
# pkgadd -s /<dir>/spool -d /dev/rmt/??

where ?? isthe device number of the tape drive. Select the packages desired and run the pkgadd
utility to install the FEMISarw package.

# pkgadd -d /<dir>/spool
3. Select the FEMISarw application for installation.

4. Select y to continue when the following prompt displays: This package contains scripts which will be
executed with super-user permission during the process of installing this package.

5. After installing the FEMISarw package select g to quit.

6. Use pkgchk to verify the package was installed correctly.
# pkgchk -n FEMISarw

7. Ignorethe following or similar errors:

ERROR: /etc/init.d/apache
Permission <0700> expected <0744> actual

Note: If you only see the above output or your system prompt appears with no output, the
package installed successfully.

8. Remove the spool directory.

# rm -r /<dir>/spool
9. Remove the tape from the drive.
2.7.3 Configuring AutoRecovery Web Reporting
To configure AutoRecovery Web Reporting, complete the following steps.
1. Loginasroot.

Two new users, femisar and www (if they do not already exist), are created with the installation of the
FEMISarw package.

2. Besureto set thefemisar password. Example: passwd femisar.
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10.

11.

Edit /opt/local/apache/htdocs/index.html. Change YOUR_SYSTEM_NAME_HERE to your
servername (e.g., tornado.pnl.gov).

Edit /opt/local/apache/conf/httpd.conf. Change the Server Admin variable to reflect the E-mail
address of your System Administrator.

Edit /opt/local/apache/htdocs/femis/mb/index.pl. Change root\@localhost to the System
Administrator’ s E-mail address (e.g., admin\@pnl.gov).

Edit /opt/local/apache/home/femisar/bin/mail.pl. Change root@localhost to the System
Administrator’s E-mail address (e.g., admin@pnl.gov).

Edit al html filesin the /opt/local/apache/htdocs/femis/help directory. Change http://tornado.pnl.gov

to http://Y OURSERVERNAME.Y OURDOMAIN. Change the E-mail address from root@localhost
to the System Administrator’ s E-mail address.

Run /opt/local/apache/bin/setup_femisarw. When prompted, enter the name of each server that will
send AutoRecovery E-mail messages. The script will create a directory for each server with the
appropriate permissions.

Start the web server.

sh /etc/init.d/apache start

Test the application with aweb browser. The address should be
http://Y OURSERVERNAME.Y OURDOMAIN (e.g., http://tornado.pnl.gov).

Edit the /opt/local/bin/femis_watch.conf on each server from which you will receive AutoRecovery E-
mail, and add femisar to the Custodian list. (e.g., $Custodian = ‘femisar@yoursystem.yourdomain’).

AutoRecovery Web Reporting is now available for you to use.

2.7.4 Customizing AutoRecovery Web Reporting

To customize AutoRecovery Web Reporting, complete the following sections.

2.7.4.1 Setting the $retainFlag Variable

The variable $retainFlag in /opt/local/apache/home/femisar/bin/clean.pl is used to control how old
messages are removed from the MessageBase. The string is comprised of three parts. Thefirst partisa
single letter that specifies what method to use to remove the messages.

If the letter isap (pruned), then messages that are older than the current date minus the specification
in the next two parts are removed.
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» If theletter isat (truncated), messages are removed at atime that is a multiple of the unit
specification and modulus of the unit specification. In other words, if the span and unit specification
isald (1 day), then the messages that are older than midnight GMT of the previous day would be
removed.

The next two parts are the number of units and the type of the unit. The number must be a positive whole
number or 0. The unit code may be one of the following: s, m, h, d, or w, which stand for seconds,
minutes, hours, days, or weeks. These number and type of units could be used in a specification, such as
t0d that would remove all messages before the current day (GMT).

The default is set to p24h.

2.7.4.2 Changing the Refresh Rate

To change the refresh rate of the AutoRecovery Web Reporting application, edit

/opt/local/apache/htdocs/femis/mb/index.pl. The default is set to 60 seconds. To change the default
value, change content="60" to your preferred refresh rate.

2.7.4.3 Accurate System Time

Proper operation of a public web server requires accurate time keeping, since elements of the HTTP
protocol are expressed as the time of day.

2.7.4.4 Customizing the Apache Web Server

For additional information on customizing the Apache Web Server, see the online manual at
http://Y OURSERVERNAME/manua or go the Apache Web Page at http://www.apache.org.
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3.0 FEMIS GIS Migration and Configuration

This section provides the instructions to migrate/upgrade and configure the FEMIS GISto v1.4.7. This
process can occur without overwriting any customization that has been done for your EOC.

Thev1.4.7 migration and configuration of GIS files on the servers should proceed as follows:
» For each server at the site, determine which of the following three situations applies.
1. Theserver contains FEMIS v1.4.6 GISfiles that have not been customized or altered in any way.

2. Some customization changes have been made to the v1.4.6 GIS files on the server, but the EOC
does not wish to preserve those customizations.

3. Some customization changes have been made to the v1.4.6 GISfiles on the server, and the EOC
wishes to preserve those customizations.

* Ononeof theserversin Group 1, perform a complete GIS server upgrade (Section 3.1, Migrating the
FEMIS GISfromv1.4.6t0 1.4.7).

»  On each of the remaining serversin Group 1 and al of the serversin Group 2, delete all of the
existing GIS files and replace them by copying all of the GIS files from the server on which the initial
GIS server upgrade was performed (see previous bulleted item). See Section 3.2, Copying thev1.4.7
GIS Filesto the Other Servers, for detailed instructions.

*  On each of the servers (if any) in Group 3, perform an individual GIS server upgrade (Section 3.1).
Thisis necessary to preserve customization changes.

Note: Asaprecaution, you should backup the /home/femis/gis directory, which hasv1.4.6 on

the server, using cp -rp /home/femis/gis /home/femis/gis146 before making any changes
to the GISfiles.

3.1 Migrating the FEMIS GIS from v1.4.6 to v1.4.7

The FEMIS Setup program will not be able to install the GIS to the PCs until the GIS upgrade has been
completed. The GIS upgrade will be performed from a PC with FEMIS V1.4.6 installed and the
upgraded files will be written to the server.

Note: If possible, select aPC on which the GIS has not been customized for performing this
migration process.
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1. Ingtal thev1l.4.7 PC COTSon one PC. See Section 4.1, Installing the PC COTS, for instructions.
For the FEMIS GIS migration from v1.4.6 to v1.4.7 to proceed, the PC that the v1.4.7 FEMIS GIS
migration is performed on must havethev1.4.7 PC COTS, av1.4.7 Oracle database, and a valid
C:\WINNT\FEMIS.INI file. If thereisnot acurrent C:\WINNT\FEMIS.INI file, see Section 3.1.5.4,
Editing the FEMIS.INI File for the GIS Upgrade.

2. Open atelnet window from a PC, and login as user femis.

3. Gotothe FEMIS GIS directory.
cd /home/femis/gis

4. Runthe chmod_gis.sh script
chmod_gis.sh

5. Exit the telnet window.

6. Mapi:\ drive on the PC to the server /nome/femis/ directory. Connect to the drive as the user femis.

7. Copy thei:\gis\femisgis_utilities.apr file to the local GIS directory.

3.1.1 Upgrading the femisgis.ini Files to v1.4.7

Complete the following steps to upgrade the femisgis.ini files to v1.4.7 from a PC with FEMIS v1.4.6
installed, v1.4.7 COTS, and avalid C:\WINNT\FEMIS.INI file as specified in Step 1 above.

Note: Thefollowing steps may encounter files permissions on destination files placed on the
UNIX server. Adjust permissions accordingly on the UNIX file server to allow file

placement to occur.

1. Mapi:\ drive on the PC to the /nome/femis directory on the server if not done so already. Connect to
the drive as the user femis.

2. Open the FEMISGIS_UTILITIES.APR on the PC by double clicking on the file using Windows
Explorer. Thefileisusually located in C:\femis\gis directory but can be on a different drive if the GIS
was installed in a different location than the default. Thiswill start ArcView GISv3.1.1.

3. Select Upgrade INI V146 -> V147 from the Utilities menu.

A file dialog box displays requesting the name of an ini file on the UNIX server.

4, Find and sdlect i:\gis\<site code>_apr\fgis_lg.ini. Click OK.

A file dialog box displays requesting the name of an ini file on the UNIX server.
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5. Find and select i:\gis\<site code>_apr\fgis_md.ini. Click OK.

A file dialog box will open requesting the name of an ini file on the UNIX server.

6. Find and select i:\gis\<site code>_apr\fgis_sm.ini. Click OK.

3.1.2 Checking the Upgraded v1.4.7 femisgis.ini Files

1. Mapi:\ drive on the PC to the /nome/femis directory on the server, if not done so already. Connect to
the drive as the user femis.

2. Open the FEMISGIS_UTILITIES.APR on the PC by double clicking on the file using Windows
Explorer. Thefileisusually located in C:\femis\gis directory but can be on a different drive if the GIS
wasinstalled in a different location than the default. Thiswill start ArcView GISv3.1.1.

3. Select Check INI Themes from the Utilities menu. A file dialog box displays. Find the Large
femisgis.ini file (fgis_Ig.ini) and click OK. Thiswill create a message box and error log file of missing
themes from the femisgis.ini filesin thelocal GIS directory. Click OK. If there are any missing
themes reported, see Section 3.1.5, Troubleshooting the Migration.

A message box will appear reporting any duplicate theme names or theme legend namesin the
femisgis.ini file. If there are duplicate theme and/or legend names, open atext editor and change the
theme name and/or legend name to a unique name. Save the file and repeat Step 3 of above.

4. Repesat Step 3 for the Medium (fgis_md.ini) and Small (fgis_sm.ini) files.

Note: If thereare INI filesfor each EOC (e.g., Maryland), the fgis_sm.ini, fgis_md.ini, and
fgis_Ig.ini files must be upgraded for each EOC.

3.1.3 Upgrading the Zone Theme
Note: Thefollowing steps may encounter files permissions on destination files placed on the
UNIX server. Adjust permissions accordingly on the UNIX file server to allow file

placement to occur.

1. Mapi:\ drive on the PC to the /nome/femis directory on the server, if not done so already. Connect to
the drive asthe user femis.

2. Copy i:\gis\femisgis_utilities.apr to the local GIS directory on the PC from which the upgrades will be
performed if not already done so in previous steps.
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3. Open the FEMISGIS_UTILITIES.APR on the PC by double clicking on the file using Windows
Explorer. Thefileisusually located in C:\femis\gis directory but can be on a different driveif the GIS
was installed in a different location than the default. Thiswill start ArcView GISv3.1.1.

4. Select Upgrade Zone Theme from the Utilities menu.
5. Select the CSEPP On-Post EOC Code at the database |ogin window, and click OK.

6. Login at the ODBC Login prompt with the Database user name (<Application Schema>a) and
password.

7. Atthe Enter Zone Filename prompt, select the zone theme name. Due to varying naming
conventions, the zone theme name and path differs by CSEPP site. To find the zone theme name,
check thei\:gis\<sitecode>_apr\femisgis.ini file Zone entry. The Path field will contain the zone
theme name.

8. Verify thetableis populated with new fields. The zone theme table will be updated with data from
the FEMIS database and the zone theme table fields will be rebuilt. After the database has been
gueried, and the zone theme table is updated, click on the Tables icon in the femisgis_utilities.apr
project and open the new table. The table should be populated with new fields (Shape, Zone_id,
Zone, Type, Par_pad, Risk_area, Objectname, Objectttype, Objectid, and Population) and records for
each zone. If not, see Section 3.1.5.2, Checking the Zone Theme Upgrade.

3.1.4 Upgrading the General Hazard Zone Theme
Note: Thefollowing steps may encounter files permissions on destination files placed on the
UNIX server. Adjust permissions accordingly on the UNIX file server to allow file

placement to occur.

Note: Perform the following stepsonly if ageneral hazard zone theme has been added to your
Site.

1. Mapi:\ drive on the PC to the /nome/femis directory on the server if not done so aready. Connect to
the drive as the user femis.

2. Copy i:\gis\femisgis_utilities.apr to C:\FEMIS\GIS on the PC from which the upgrades will be
performed.

3. Openthe FEMISGIS_UTILITIES.APR in ArcView GISv3.1.1.
4. Select Upgrade County Zone Theme from the Utilities menu.

5. Select the EOC Code of the Owner of the General Hazard theme (usually the State EOC that contains
the depot) at the database |ogin window, and click OK.
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6. Loginat the ODBC Login prompt with the Database user name (<Application Schema>a) and
password.

7. Atthe Enter Zone Filename prompt, select the general hazard zone theme name. Due to varying
naming conventions, the general hazard zone theme name and path differs by CSEPP site. To find
the general hazard zone theme name, check the i\:gis\<sitecode>_apr\femisgis.ini file county entry.
The Path field will contain the general hazard zone theme name.

8. Veify thetableis populated with new fields. The general hazard zone table will be updated with data
from the FEMIS database. After the database has been queried, and the general hazard zone theme
table is updated, click on the Tables icon in the femisgis_utilities.apr project and open the new table.
Thetable should be populated with new fields (Shape, Zone_id, Zone, Type, Par_pad, Risk_area,
Objectname, Objectttype, Objectid, Eoc_name, and Population) and records for each zone. If not, see
Section 3.1.5.3, Checking the General Hazard Zone Theme Upgrade.

9. Closethefemisgis_utilities.apr.

3.1.5 Troubleshooting the Migration

Note: If you have not encountered any problems with the GIS migration, you should skip this
section and proceed to Section 3.2, Copying v1.4.7 GIS Files to Other Servers.

If the GIS Migration from v1.4.6 to v1.4.7 did not run successfully, you may have experienced one of the
following errors:

» If there were errors experienced during the migration of the femisgis.ini filesto v1.4.7 while
performing the proceduresin Section 3.1.1, Upgrading the femisgis.ini Filesto v1.4.7, then see
Section 3.1.5.1, Checking the v1.4.6 femisgis.ini File.

» |If there were errors experienced during the migration of the Zone theme to v1.4.7 while performing
the procedures in Section 3.1.3, Upgrading the Zone Theme, then see Section 3.1.5.2, Checking the
Zone Theme Upgrade.

* |If there were errors experienced during the migration of the General Hazard Zone themeto v1.4.7

while performing the proceduresin Section 3.1.4, Upgrading the General Hazard Zone Theme, then
see Section 3.1.5.3, Checking the Genera Hazard Zone Theme Upgrade.

3.1.5.1 Checking the v1.4.6 femisgis.ini File
The migration of the femisgis.ini filesfrom v1.4.6 to v1.4.7 consists primarily of changes to the data

records and minor formatting. Errorsin the migration of the v1.4.6 femisgis.ini fileswill be aresult of:
1) the migration scripts cannot find/read the files or 2) the v1.4.6 files are not in the correct format.
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Perform the following checks.
e Thei:\driveis mapped to /home/femis as user femis.
*  When prompted, the files selected to be upgraded are

i\gis\<sitecode>_apr\fgis_Ig.ini
i\gis\<sitecode>_apr\fgis_md.ini
i:\gis\<sitecode>_apr\fgis_sm.ini

* Thevl.4.6filesare not read-only.

* Thefemisgis.ini filesarein avalid v1.4.6 format (see next section below).
File Format for v1.4.6 femisgis.ini

Thefirst lines of the femisgis.ini file are commented out using a single apostrophe at the beginning of the
line (‘). Theselinesareignored.

[FEMIS_VERSION] — This portion contains information about the version and size of the file. The
version should be 1.4.6, the size should be SMALL, MEDIUM, or LARGE and both should have an equa
sign (=) asadeimiter. Seethe example below and in the example v1.4.6 femisgis.ini file at the end of
this section.

[FEMIS_VERSION]
FEMIS Version=1.4.6
FEMISGIS Size designhation=MEDIUM

[SITE CODE] — This portion should be the 4-character CSEPP site code. The delimiter is an equal sign
(=). Seetheexample below and in the example v1.4.6 femisgis.ini file at the end of this section.

[SITE_CODE]
SiteCode=ANAD

[DEFAULT_HAZARD_THEME] — This portion is the default GIS theme. The theme should be zone. The
delimiter isan colon ( : ). Seethe example below and in the example v1.4.6 femisgis.ini file at the end of
this section.

[DEFAULT_HAZARD_THEME]
Theme Name: zone

[PROJECTION_PARAMETERS] — This portion is the projection information for the GIS. The femisgis.ini
file must have information for the Central Meridian, Reference Latitude, False Easting, False Northing,
Scale, and Spheroid. Each parameter isfollowed by a colon ( : ) and then the parameter information. See
the example below and in the example v1.4.6 femisgis.ini file at the end of this section.
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[PROJECTION_PARAMETERS]

Central Meridian: -87

Reference Latitude:0

False Easting: 500000

False Northing: 0

Scale: 0.99953

Spheroid: SPHEROID_CLARKE1866

[AREA_OF _INTEREST] — This portion is the extent of the area of interest. Each parameter is followed by
acolon ( :) and then the parameter information. See the example below and in the example v1.4.6
femisgis.ini file at the end of this section.

[AREA_OF INTEREST]
origin: -126.00| 23.00
size:  58.00| 27.00

' C. Theme parameters — This portion of the femisgis.ini file contains an explanation of the recordsin the
[STATIC_THEMES] and [DYNAMIC_THEMES] sections. All linesin the Theme Parameters section,
including the Theme Parameter heading, must be commented with a single quote character (* ). Seethe
example below and in the example v1.4.6 femisgis.ini file at the end of this section.

' C. Theme parameters
‘each line of the input table contains the following theme data in sequence:
'0 "Theme", Theme name in the FEMIS Database Femis Object table. Null "™ otherwise.

[STATIC_THEMES] — This portion of the femisgis.ini file contains the theme attributes for each static
themein the GIS. See the Theme Comments section for more information about each parameter. There
should be 21 items with 20 pipe character (|) delimitersin each record. The fieldsin the femisgis.ini file
are Theme Name, FEMIS Accessible, Type, Load Flag, Visible Flag, Display Order, Label Field, Object
Lookup Category, Default Legend, Classification Field, Min Scale, Max Scale, Legend Name, Customize
Flag, Symbol, Color, Size, Back Color, Outline Color, Path, and Alternative Prefix. Seethe examplev1.4.6
femisgis.ini file at the end of this section.

[DYNAMIC_THEMES] — This portion of the femisgis.ini file contains the theme attributes for each
dynamic themein the GIS. See the Theme Comments section for more information about each
parameter. There should be 21 items with 20 pipe character ( |) delimitersin each record. Thefieldsin
the femisgis.ini file are Theme Name, FEMIS Accessible, Type, Load Flag, Visible Flag, Display Order,
Label Field, Object Lookup Category, Default Legend, Classification Field, Min Scale, Max Scale, Legend
Name, Customize Flag, Symbol, Color, Size, Back Color, Outline Color, Path, and Alternative Prefix. See
the example v1.4.6 femisgis.ini file at the end of this section.

3.1.5.2 Checking the Zone Theme Upgrade

The migration of the zone theme from v1.4.6 to v1.4.7 depends on avalid v1.4.6 zone theme and av1.4.7
Oracle database. Errorsinthe migration of the v1.4.6 zone theme will be aresult of: 1) the migration
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scripts cannot find/read the zone theme files, 2) the v1.4.6 zone theme files are not in the correct format,
or 3) the FEMIS v1.4.7 database was not found.

Perform the following checks.

e Thei:\ driveis mapped to /home/femis as user femis

*  When prompted, the file selected to be upgraded is
i\gis\<sitecode>\zone\<zone_theme_name>.shp *

* Thevl.4.6file (<zone theme name>.dbf) is not read-only.

« Thezonethemetablefilesarein avalid v1.4.6 format. The v1.4.6 zone theme file should contain the
following fields: Shape, Zone_id, Zone, Type, Par_pad, Risk_Area, Objectname, Objecttype,
Obijectid.

»  The zone names (Zone and Objectname records) must have a one-to-one correspondence with the
zonesin the FEMIS database’ s ZONE table. To verify, open the FEMIS Data Manager, select ZONE
from the list of tables and click Open.

*  There must be a one-to-one correspondence with the number of records in the GIS zone theme and
the FEMIS database’'s Zone table. The GIS zone theme table may not have more than one record
with the same Zone field record or Objectname field record. (For agiven record, the Zone field
record must match the Objectname field record of the same record.) For example, a zone theme table
cannot have two Zones named 3-A; however, if the zone table has a Zone field and an Objectname
field, both should contain 3-A.

* Usersmust log into the FEMIS database as user name <Application Schema>a and password. If a
user name <Application Schema> is entered, the migration will not complete successfully.

Note: Dueto varying naming conventions, the Zone theme name differs by CSEPP site. To

find the Zone theme name, check the femisgis.ini files Zone entry. The Path field will
contain the Zone theme name.

3.1.5.3 Checking the General Hazard Zone Theme Upgrade

Note: Thissection only appliesto those sites that have added a general hazard zone theme (e.g.
county-based genera hazard zone.)

The migration of the general hazard zone theme from v1.4.6 to v1.4.7 depends on avalid v1.4.6 general

hazard zone theme and av1.4.7 FEMIS database. Errorsinthe migration of the v1.4.6 general hazard
zone theme will be aresult of: 1) the migration scripts cannot find/read the general hazard zone theme
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files, 2) the v1.4.6 general hazard zone theme files are not in the correct format, or 3) the FEMISv1.4.7
database was not found.

Perform the following checks.
e Thei:\driveis mapped to /home/femis as user femis.
*  When prompted, the file selected to be upgraded is
i\gis\<sitecode>\< general hazard path>\<general hazard zone_theme_name>.shp *
* Thevl.4.6file (<general hazard zone theme name>.dbf) is not read-only.

* Thegenerd hazard zone themefilesarein avalid v1.4.6 format. Thevl1.4.6 genera hazard zone
theme file should contain the following fields: Shape, Zone_id, Zone, Type, Par_pad, Risk_Area,
Objectname, Objecttype, Objectid.

» Thegenerd hazard zone names (Zone and Objectname records) must have a one-to-one
correspondence with the general hazard zones in the FEMIS database’ s ZONE table. To verify, open
the FEMIS Data Manager, select ZONE from the list of tables and click Open.

* There must be a one-to-one correspondence with the number of recordsin the GIS general hazard
zone theme and the FEMIS database’ s Zone table. The GIS general hazard zone theme table may not
have more than one record with the same Zone field record or Objectname field record. (For agiven
record, the Zone field record must match the Objectname field record of the same record.) For
example, ageneral hazard zone theme table cannot have two genera hazard zones named Jackson;
however, if the genera hazard zone table has a Zone field and a Objectname fields, both should
contain Jackson.

* Usersmust log into the FEMIS database as user name <Application Schema>a and password. If a
user name <Application Schema> is entered, the migration will not complete successfully.

Note: Dueto varying naming conventions, the general hazard zone theme name and path differs

by CSEPP site. To find the general hazard zone theme name, check the femisgis.ini files
Zone entry. The Path field will contain the general hazard zone theme name.

3.1.5.4 Editing the FEMIS.INI File for the GIS Upgrade
Since the FEMIS Setup program could not be used to install the GIS, some manual editing of the FEMIS

configuration files may be needed. Edit the %WINDIR%\FEMIS.INI filein atext editor to set the GIS
paths asfollows:
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Go to the [FemisGis] section and edit the following parameters, if they are not correct. Add the valuesif
they do not exist.

[FemisGIS]

GISTopDirPC=<DRIVE>\FEMIS\GIS\<SITE CODE>
ViewmarkDir=M:\GIS\Viewmark
GISEditScript=<DRIVE>\FEMIS\GIS\<SITE CODE>\FEMISGIS.APR
GISTopDirNFS=X:\GIS

GISTopDirUNIX=/home/femis/gis

GisSize=unknown

where <DRIVE> isthe drive specification for the GIS installation, such as C:\.
Add or edit the following parameters as needed, in the [FEMIS Misc] section.

[FEMIS Misc]
ExerciseNum=0

Site Code=<site code>
EOC Code=<eoc code>

Add or edit the following parameters as needed, in the [<site code>] section.

[<site code>]

_GISTopDirPC=<DRIVE>\FEMIS\GIS\<SITE CODE>
_ViewmarkDir=M:\GIS\Viewmark
_GISEditScript=<DRIVE>\FEMIS\GIS\<SITE CODE>\FEMISGIS.APR
_GISTopDirNFS=X:\GIS

_GISTopDirUNIX=/home/femis/gis

Save the file and exit.

3.2 Copying v1.4.7 GIS Files to Other Servers

Copy the GISfiles from the server on which you performed the first GIS migration/upgrade to al of the
other severs that do not have customization changes which need to be preserved.

1. Preservethe old GIS data on each server. Log into the remote server(s) and enter the following
commands:

% cd /home/femis/gis
% mkdir bkp
% mv <site code>* bkp
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2. Create atar file of the upgraded GIS. This may take awhile.

% cd /home/femis/gis
% tar cf - <site code>* | compress > <site code>_gis.tar.Z

3. UseFTP to copy thetar file to the target server.

%ftp <server name>

Name: femis

Password: <femis password>
ftp> cd /home/femis/gis

ftp> bin

ftp> put <site code>_gis.tar.Z
ftp> bye

where <site code> isyour site code (lower case), such as anad.
<server name> is the host name of the server you are copying to.
Theaserisk (*) isaliteral asterisk for wild card expansion.

Note: Alternative methodsto FTP may be used to distribute the tar file, especialy at larger sites
where the number of FTP transfers would be high . However, these methods involve
opening security doors that may require EOC-to-EOC coordination to accomplish. One
mechanism that can work especialy well isthe UNIX servers automount capability and
the /net file system. These aternative methods require a good consistent network
connection to work well. If thisis questionable at a site, use the above described FTP
method.

4. Logontothe server to which you copied thetar file and extract the tar file with the following
commands:

% telnet <server name>
login: femis
password: <femis password>

% cd /home/femis/gis
% zcat <site code>_gis.tar | tar xf -

5. Repeat Steps 2-4 for all of the servers that do not have customization changes that need to be
preserved.

3.3 Completing the Installation on This PC

Go to Section 4.4, Configuring the PC, to continue and compl ete the installation on this PC.
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Example of aFEMIS GISINI file.
'fgis _lg.ini ("large" femisgis.ini for ANAD) -- 01/19/99 (IEM)

[FEMIS_VERSION]
FEMISVersion=1.4.6
FEMISGIS Size designation=LARGE

[SITE_CODE]
SiteCode=ANAD

[DEFAULT_HAZARD_THEME]
Theme Name: zone

[PROJECTION_PARAMETERS]

Central Meridian: -87

Reference Latitude:0

False Easting: 500000

False Northing: 0

Scale 0.99953

Spheroid: SPHEROID_CLARKE1866

[AREA_OF_INTEREST]
origin: -126.00| 23.00
size.  58.00] 27.00

' C. Theme parameters

‘each line of theinput table contains the following theme data in sequence:

'0 "Theme", Theme name in the FEMIS Database Femis Object table. Null "* otherwise.

'l "FEMIS Access', Featurethemes: Yesor no flag of whether the themeisin the Femis object table Image themes: None or the name of an image catalog to be created. The image catalog should be
' described in one of the entries of thisini file.

'2 "Type", Theme feature type; it must be one of: Image, ImgCat, point, line, polygon, event.

'16.LoadFlag Load the theme ("Yes"), do not load the theme ("No").

'3 "Status”, Theme visibility status when forming the apr.

'17 DisplayOrder #1 is the theme at the top of the table of contents, and is loaded last (on top of all the other themes).

'4 "Labd Field", Field name used as the default labeling field.

'5 "Obj Category" Femis theme category; it must be one of the types listed in the_ HOME\lookup\obj_type.lut file. Currently: zone, abpc, igloo, facility, tcp, road, siren, known_p. If it is "None", then the
‘ theme may not be classified using the ook up tables. The classification field should also be set to "simple".

'6 Default legend. Enter "simple" for a simple legend to show up, or "classify" for a classification legend.

"7 "Classification Field", Thefield nameto be used in a classified legend. The classified legend will be loaded provided it exists, otherwise it will be created and then loaded. This may happen when the user
‘ wants to toggle the simple/classified legend.

'8 "Min Scale", Below the minimum scale, the theme is not displayed.

'9 "Max Scale", Above the minimum scale, the themeis not displayed.

'10 "Legend Name", Name desired for the legend.

'18 Customize The Customization Flag is meaningful only in the Dynamic themes:"Yes" Yes -- Use the current symbolization parametersin thistheme linein the INI file (do not overwrite when

' dynamic theme is updated). No --> Allow symbol parametersin this line of the INI to be ‘ overwritten with values from DB when dynamic themeis updated. N/A isfor static themes.
'11 "Symbol", Symbol number to be used in asimple classification.

'12 "Color", Foreground and outline color for theme symbols, if they can be colored.

'13"Size", Symbol size.

'19 BackGround Color BackGround Color of polygonal symbols
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'20 Outline Color

'14 " Path"

'15 "Alternate prefix"

Outline Color of polygonal symbols
Appended to the Home value specified in the femis.ini file for the gis data.

'21 Dynamic Theme

[ STATI C_THEMES]

' Thene FEM S
' Nane Access
anad500k | None
anad_250k| None
anad100k | None
cat 24k | None
330b.tif |cat24k
river | no
anad_luc | no
flood_al | no
anadc30 | no
cedbl ock | yes
anad_pl | no
anad_nctd | no
anad_pc | yes
anad_ab | no
anad_ut | no
zone | yes
anad_paz | no
anad_irz | no
county | yes
cstc_fd | no
bg_d_pop | no
stream | no
| ake | no
anad_rm | no
anad_rr | no
ctal _rta | no
cstc_rta | no
anad_hw | no
anad_ex | no
anad_pn | no
igloo_p | yes
zone_dep | no
nettower | yes

[ DYNAM C_THEMES]

' Thene
' Nane

kpol y_anad|
FLOOD_anad|
kpol y_aena|
FLOCOD_aens|
kpol y_ccal |
FLOOD_ccal |
kpol y_ccl a|
FLOOD_ccl a|
kpol y_ccl e|
FLOOD_ccl e|
kpol y_cet o|

FEM S
Access

yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes

Type

| mage |
| mage |
| mage |
I ngCat |
| rage |
Li ne |
Pol ygon|
Pol ygon|
Li ne |
Pol ygon|
Pol ygon|
Pol ygon|
Pol ygon|
Pol ygon|
Li ne |
Pol ygon|
Pol ygon|
Pol ygon|
Pol ygon|
Pol ygon|
Pol ygon|
Li ne |
Pol ygon|
Li ne |
Li ne |
Li ne |
Li ne |
Li ne |
Point |
Point |
point |
Pol ygon|
point |

Type

Pol ygon|
Pol ygon|
Pol ygon|
Pol ygon|
Pol ygon|
Pol ygon|
Pol ygon|
Pol ygon|
Pol ygon|
Pol ygon|
Pol ygon|

Load
Fl ag

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

Yes
Yes
Yes
Yes
Yes
Yes
Yes

Yes
Yes
Yes
Yes

Yes
Yes
Yes
Yes
Yes
Yes
Yes

Yes

Load
Fl ag

yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes

Vi sible Obj ect

Flag Display Label Lookup
O der Field Cat egory
| off | 72 | None | None |
| off | 71 | None | None |
| off | 70 | None | None |
| off | 69 | None | None |
| off | 68 | None | None |
| off | 66 | Pnane | None |
| off | 65| O ass | None |
| off | 64 | None | None |
| off | 62 | Contour | None |
| off | 59 | Blk | None |
| off | 58 | MCD name | None |
| off | 57 | MCD_name | None |
| off | 56 | Wedgetype | abpc |
| off | 55 | Name | None |
| off | 54 | None | None |
| on | 53 | Zone | Zone |
| off | 52 | Zone | Zone |
| off | 51 | Zone | Zone |
| on | 50 | Ovbjectnane| None |
| off | 49 | Nanme | None |
| off | 38 | Blkgrp_id | None |
| off | 33 | Fename | None |
| off | 32 | Laname | None |
| off | 31| Nanme | None |
| off | 30 | Fenane | None |
| off | 29 | Route | None |
| off | 28 | Route | None |
| on | 27 | Name | None |
| off | 26 | Objectnane| None |
| off | 25 | Name | None |
| on | 24| Igloo_Nane| igloo|
| on | 23 | nbjectnane| None |
| on | 22 | Nanespeed | None |
Vi sible Obj ect

Fl ag Display Label Lookup
O der Field Cat egory
| off | 21 | ObjectNane| None |
| off | 20 | Objectnane| None |
| off | 19 | ObjectNane| None |
| off | 18 | ObjectNane| None |
| off | 17 | ObjectNane| None |
| off | 16 | ObjectNane| None |
| off | 15 | ObjectNane| None |
| off | 14 | ObjectNane| None |
| off | 13 | ObjectNane| None |
| off | 12 | ObjectNane| None |
| off | 11 | ObjectNane| None |

dassifi-
Def aul t cation
Legend Field
None | None |
None | None |
None | None |
None | None |
None | None |
sinple | None |
classify| Cass |
sinple | None |
sinple | None |
sinple | None |
sinple | None |
sinple | None |
cl assi fy| Wedget ype|
classify| Type |
sinple | None |
classify| Type |
classify| Type |
classify| Type |
sinple | None |
sinple | None |
sinple | None |
sinple | None |
sinple | None |
sinple | None |
sinple | None |
sinple | None |
sinple | None |
sinple | None |
sinple | None |
sinple | None |
classify| Content |
Sinple | None |
sinple | None |

dassifi-
Def aul t cation
Legend Field
sinple | None
sinple | None
sinple | None
sinple | None
sinple | None
sinple | None
sinple | None
sinple | None
sinple | None
sinple | None
sinple | None

Mn
Scal e

400000
150000
50000
5000 |
10000
400000
150000
24000
100000
2000 |
5000
12000
20000
20000

|
|
|
|
|
|
|
|
|
|
|
500 |
|
|
|
|
|
|
|
|
|
|
|

Mn
Scal e

| 1000
| 1000
| 1000
| 1000
| 1000
| 1000
| 1000
| 1000
| 1000
| 1000
| 1000

| 15000000
| 15000000
| 15000000
| 15000000
| 15000000

| 15000000

Max
Scal e

1000000
400000 |
150000
50000 |
50000 |
25000000
2000000
2000000
2000000
300000 |
15000000
15000000
15000000
15000000
1500000
15000000
15000000
15000000
0
15000000
1500000
1000000
2500000
20000000
25000000
20000000
20000000
20000000
20000000
1000000
2000000
15000000
2000000

Max
Scal e
2000000
2000000
2000000
2000000

2000000

Used as a prefix to the "Path" instead of the Home value. Only the load themes script uses this prefix to locate and read alternate source directory for big files. Any auxiliary
fileswill be written using the Home prefix.
True or false flag set by the location of theme in the ini file. (in the static or dynamic theme section)

Qutline
Cust om ze Col or Back Col or Al ternate

Legend Nane Flag Synbol Size Col or Pat h Prefix
Map | mage 1: 500K | NA| 0O | 0| O] 0| 5| inmges\anad500k.tif | none
Map | nage 1: 250K | NA| O | 0| O] 0| 5| inmges\anad250k.tif | none
Map | nage 1: 100K | NA| 0O | 0| O] 0| 5| inmges\anadl00k.tif | none
Map | nage 1:24K | YA|] O | O] O| O] 5| inmages\im24k\cat24k.dbf | none
Map | nage 1:24K | NA|] O | O] O] O] 5] |
Ri ver Reaches | YA O | 28 0| O] 5| water\river | none
Land Use Land Cover | VA| 5 | 100 1| O| 5| environnent\anad_luc | none
St at ewi de Fl oodpl ai ns | NA| 4 | 7| 1| 0| 5| water\flood_al | none
30m El evation Contours | NNA| O | 52| 1| O | 5| environnent\anadc30 | none
Census Bl ocks | NA| O | 4| 1| 0| 5| cedblock\anad_tb | none
Census Designated Places| NNA| 4 | 45 1| 0| 5| cedblock\anad_pl | none
M nor Givil Divisions | YA|] O | 5] 1| 0| 5| boundaries\anad_ntd | none
Accident Based Plan Cat.| NYNA| O | 3| 1| 0] 5| abpc\anad_pc | none
Adnini strative Boundary | NNA| O | 0| 1| 0| 5| boundaries\anad_ab | none
Uility Lines | NA|] O | 52l 1| 0| 5| utilities\anad_ut | none
Enmer gency Zones | NA| O | 16| 2| 0| 5| zone\anad_ez | none
Protective Action Zones | NA| O | 2| 2| 0| 5| zone\anad_paz | none
| medi ate Response Zones| NNA| O | 7| 2| 0| 5| zonelanad_irz | none
County Boundaries | YA| 5 | 0] 3| 0| 44| boundaries\anad_sc | none
St.Cair Fire Districts | NA| 0 | 0] 1| O| 5| fire_dis\cstc_fd | none
Wor kpl ace Bl ock Group | NA| 5 | 4| 2| 0| 5| cedblock\bg_d_pop | none
Streams | NA|] O | 57/ 1| 0| 5| water\stream | none
Lakes & Rivers | NA| 3 | 57/ 1| 0| 5| water\lake | none
Maj or Roads | VA 2 | 8] 1| O| 5] transportation\anad_rm| none
Rai | roads | VA O | 321 1| O| 5| transportation\anad_rr | none
Tal | adega Route Alerts | NA| 0 | 5] 1] O| 5| rta_ctal\ctal _rta | none
St. Clair Route Alerts | VA| O | 5] 1| O] 5| rta_cstc\cstc_rta | none
Interstates | NA| O | 8| 2| 0| 5| transportation\anad_hw | none
Interstate Exits | NA| 159| 10| 10| 0 | 5| transportation\anad_ex | none
Pl ace Nanes | NA| 4 | 35 6| 0| 5| landmarks\anad_pn | none
I gl oos | VA| 14| 8| 10| 0| 5| igloo_p\anad_ip | none
Chem Linited Area | YA| O | 10| 2| 0| 5| zone\anad_dep | none
Met Towers | VA 75| 5| 12| 0| 5| nettower\anad_nt | none

Qutline
Cust om ze Col or Back Col or Al ternate

Legend Nane Fl ag Synbol Si ze Col or Pat h Prefix
ANAD Known Pol ygons | No| 8| 44| 2| 0] 53| kpoly\kpoly_anad | none
ANAD Fl ooded Areas | No| 36| 28| 2| 0] 34| kpoly\flood_anad | none
AENMA Known Pol ygons | No| 8| 44| 2| 0] 53| kpoly\kpoly_aenma | none
AEMA Fl ooded Areas | No| 36| 28| 2| 0] 34| kpoly\flood_aenma | none
CCAL Known Pol ygons | No| 8] 44| 2| 0| 53| kpoly\kpoly_ccal | none
CCAL Fl ooded Areas | No| 36| 28| 2| 0| 34| kpoly\flood_ccal | none
CCLA Known Pol ygons | No| 8] 44| 2| 0| 53| kpoly\kpoly_ccla | none
CCLA Fl ooded Areas | No| 36| 28| 2| 0] 34| kpoly\flood_ccla | none
CCLE Known Pol ygons | No| 8| 44| 2| 0] 53| kpoly\kpoly_ccle | none
CCLE Fl ooded Areas | No| 36| 28| 2| 0] 34| kpoly\flood_ccle | none
CETO Known Pol ygons | No| 8] 44| 2| 0| 53| kpoly\kpoly_ ceto | none
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CETO Fl ooded Areas
CSTC Known Pol ygons
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CTAL Known Pol ygons
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Sirens
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No | 8
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4.0 FEMIS PC Installation

The following sections describe the steps needed to install FEMIS on a PC.

4.1 Installing the PC COTS

The order for installing the COTS on anew FEMIS PC is as follows:
1. Windows NT Workstation v4.0 and Windows NT Service Pack 5
2. Hummingbird NFS Maestro v6.2 and v6.2.0.2 patch or Solstice NFS Client v3.2
3. Oracle Net8 Client v8.1.5 and ODBC Driver v8.1.5.5
4. ArcView GISv3.1 and v3.1.1 patch
5. Microsoft Project 98 Service Release 1
Installing the following COTS products is optional .

E-mail application (if applicable)

Word processor (if applicable)

Spreadsheet (if applicable)

Graphics presentation  (if applicable).

At the end of this section, PNNL has provided two checklists that can be used for each PC installation.

e FEMIS PC Installation Checklist
« FEMISPC Validation Checklist.

Note: If you have aprevious version of FEMIS installed, verify that your COTS software
packages are the same version asthose listed in the FEMI S Bill of Materials (BOM). If

they are the same, proceed to Section 4.3, Installing the FEMIS Client Software, to install
the FEMIS application.

4.1.1 Installing Windows NT v4.0

4.1.1.1 Before Installing Windows NT

Issues you should consider before beginning the Windows NT installation include hardware requirements,
multi-boot capabilities, instalation tips, and storage device detection.
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Hardware Requirements

There are two sets of information, which you must consider regarding hardware requirements for
Windows NT. First, you must check the Windows NT Hardware Compatibility List (HCL) published by
Microsoft. This document covers every type and model of hardware that has been tested for compatibility
with Windows NT. Thelist isupdated regularly and can be accessed at Microsoft’s Web site
(http://www.microsoft.com/hwtest/hcl/default.ntm). Check the HCL to verify that every major
component of your computer system is compatible with Windows NT. If one or more components are
not listed, contact Microsoft or the hardware vendor to see if new drivers or compatibility aids are
available. If not, you should think twice before installing Windows NT on your computer.

The second requirement that must be considered is minimum hardware requirements, which can be found
in the FEMI S Bill of Materials (BOM). If your computer does not meet these minimum
requirements, it is unlikely that Windows NT will work acceptably on this system.

Multi-Boot

Windows NT can coexist with other operating systems, including MS-DOS, Windows for Workgroups,
and Windows 95/98. The Windows NT installation program can detect these operating systems and
include them on the Windows NT bootup menu. However, MS-DOS and 16-bit Windows are only
supported if they were installed first, before Windows NT. Installing them afterward is strongly
discouraged by Microsoft and can cause unreliable Windows NT operation.

Windows NT Installation Tips

Installing Windows NT can be avery intimidating experience. There are many points where the operator
must make a choice, but very little information is available about how to choose or the potential
consequences of achoice. Fortunately, this problemis not insurmountable. If you plan ahead and collect
the necessary information before you begin, the installation processis much easier. Be sureto select
Custom installation.

After you select Custom installation for Windows NT v4.0, you will be given the following installation
options:

e Set Up Only Components Y ou Select

»  Set Up Network

* SetUpLoca Printer

»  Set Up Applications on the Hard Disk

»  Gathering information about your computer
e Installing NT networking

* Finishing Setup.

For modular installation, enable the Set Up Only Components You Select and Set Up Network options
and disable the others so you will be ableto install printer support and set up applications later.
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Storage Device Detection

During the Hardware Setup phase, the Windows NT installation program displays a list of mass storage
devices found on your computer. Thislist includes SCSI adapters and CD drive devices but does not
include IDE components. Do not worry--I DE devices are indeed recognized and will be supported by the
installation.

Gathering Configuration Information
Prior to installation obtain the following information from your System Administrator:

*  Computer name (for each machine)

» IPaddress (for each machine)

*  Subnet mask

» Default Gateway

*  Workgroup

* Domain

* DNS (Domain Name System) service search order
*  WINSservers, if applicable

* FEMIS server name

* FEMIS server IP address.

If thisinformation is unavailable from the System Administrator, it can be determined by using the steps
below to check a previously installed machine—provided one is available. It isimportant that you have
thisinformation prior to installation. Thisinformation allows you to setup your NT Networking.

4.1.1.2 Running the Installation Program

Note: Beforeyou install Windows NT from the FEMIS COTS CD, read Section 4.1.1.1, Before
Installing Windows NT.

Y ou will need to know the 10-digit CD Key number to enter during the Windows NT
installation. The CD Key number islocated on your licensed Windows NT installation
disk.

The CD driveisusualy your D:\ drive and will be referred to as the D:\ drive in the
following instructions.

Y ou will need to create aformatted DOS partition within the first 2GB of the primary

disk on the system you areinstalling. Use tp DOS boot floppy and use the fdisk utility to
create the partition. Use the format command to format the drive.

4-3
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1. Placethe FEMIS COTSCD into the CD drive, and enter \I386\WINNT /B at the C:\ prompt.

Note: Besuretoinclude/B or you will be prompted to insert three formatted disks.

2. At theD:\ prompt, enter \I386, and the Windows NT Setup window will be displayed. Please wait
while Setup copies filesto your hard drive.

3. Restart the computer and continue with the Windows NT Setup.

4. PressEnter to continue setting up WINNT per the Welcome window that displays.

5. PressEnter to continue installation. Windows NT Setup displays alist of mass storage devices found
on the computer. Thislist includes SCSI adapters and CD drive devices but does not include IDE
components. The <SCSI Adapter> and <CD drive devices> will display. Thisindicates that Setup
has recognized mass storage devices in the computer.

6. Page down and select F8 to agree when the Windows NT Licensing Agreement window displays.

7. PressEnter to continue when the Windows NT Setup displays the computer’ s hardware and software
components.

8. Install Windows NT on the desired partition
9. Setup will install Windows NT on the partition. Leave the current file system intact (no changes).

10. Setup will install WINNT files on the hard disk. Choose the location where you want these filesto be
installed, a common location is\WINNT.

11. Setup can aso examine the hard disks for corruption.

* Toalow Setup to perform an exhaustive secondary examination, press Enter.
* Toskip this step, pressthe Esc key.

Though thisis not necessary and takes several minutes, we recommend you compl ete this step.
12. Restart the computer once this portion of the Setup has completed successfully.
The Windows NT Setup is gathering information about the computer. Advanced users can customize
all available setup options. Y ou will be prompted regarding the next three parts of the Setup:
1) Gathering Info, 2) Installing Windows NT Networking, and 3) Finish Setup.

Part One of Setup—Gathering Info

13. Select 1. Gathering Info, and click Next. On the Setup Options window, select Custom, and
click Next.

4-4
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14.

15.

16.

17.

18.

19.

20.

Enter the name and organi zation associated with the computer. Click Next.

Enter the 10 digit, CD Key. The Windows NT registration number islocated on the back of the
Windows NT CD cover.

Enter the computer name.

Enter the Administrator password for the Windows NT Administrator account. Repeat this step to
confirm the password.

It is recommended that you create an Emergency Repair disks for each computer on which Windows
NT v4.0 isbeing installed.

» Select Yes to create an Emergency Repair disk
» Select No if you do not want to create an Emergency Repair disk.

Click Next.

Click Next to accept the default list of components on the Select Components window that displays.

Part Two of Setup—Installing Windows NT Networking

21.

22

23.

24,

25.

26.

Select 2. Installing NT Networking. Click Next.
Click Next accept the defaults: This computer will participate on a network and Wired to the network.

Select Start Search to allow Setup to locate the default network adapter. Once the default network
adapter has been located click Next.

Select TCP/IP Protocol for the networking protocols that are used on your network. Thisisthe
protocol used to connect to the Internet and Wide Area Networks (WANS). Check with your System
Administrator to seeif any additional protocols should be selected. Click Next.

Click Next to accept the default—All Network Services. Install the selected components

* RPC Configuration
* NETBIOS Interface

*  Workstation
e Server
Click Next.

Check with your System Administrator about special settings that may be required for the network
adapter card and in addition to host name resolution. If there are none, accept the default values
associated. Click Continue.

4-5
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27. Select use Network Parameters, even if they cannot be verified.
28. Click No to use DHCP on the TCP/IP Setup Window that displays.

29. Enter the IP Address, Subnet Mask, and Default Gateway val ues specified by your System
Administrator.

30. Check with your System Administrator to seeif the domainis required for Domain Name System
(DNS). Select the DNS tab, and enter the domain, if required. The Hostname will have been entered
by default when the computer was named. If necessary, select Add DNS Search Order.

31. Select Add Primary and Secondary WINS Servers, if required, for the Windows Internet Name
Services (WINS).

32. Accept the default—Enable LMHOSTS Lookup. Check with your System Administrator to seeif this
isrequired.

33. Enable DNSlookups, if required. Check with you System Administrator regarding DNS setup
configuration.

34. Check with your System Administrator to seeif Routing isrequired. Click the Routing tab, and
enable the IP forwarding. Click Apply and OK.

35. Accept the defaulted network components that will communicate using this protocol. Check with
your System Administrator to see which items should be selected. The Show Bindings window will

display.

» Click Next to accept the default—All Services.
* Click Next again to start the network.

36. Select Workgroup, and enter the value.
Part Three of Setup—Finish Setup
37. Select 3. Finishing Setup. Click Finish.

38. Select the appropriate Time Zone, and check Automatically adjust clock for daylight savings time on
the Date and Time Properties window that displays. Click Close.

39. Accept the default if the system found a video adapter for the computer. Click OK.



Federal Emergency Management FEMIS Installation Guide
Information Systems (FEMIS) May 26, 2000-Version 1.4.7

40. Select Test to preview settings from the Display Properties window that displays. The GIS operates
optimally with a Color palette set to 65536 colors.

The new mode will betested. Click OK and wait 5 seconds to determine whether it works properly.
Click Yes and OK.

41. Restart the computer for Windows NT to setup and save the previous choices. Select Windows NT4.0
as your operating system. Press Enter.

4.1.1.3 Installing Windows NT Service Pack 5

Service Pack 5 was the current Service Pack issued by Microsoft and was used during the devel opment
and testing of FEMIS 1.4.7. It isrecommended this service pack be installed to ensure compatibility.

Toingtal Windows NT Service Pack 5, insert the FEMIS COTS CD into the CD drive, and complete the
following steps:

1. Logininto Windows NT as a user with Administrator privileges.
2. Close any open applications.

3. Click Start » Programs - Windows NT Explorer = D:\NT4SP5\UPDATE. Double-click
UPDATE.EXE to run the Update program.

4. Check Accept the Software License Agreement checkbox.

5. Check the other checkbox to backup your current filesto uninstall the Service Pack at alater time.
This requires more disk space.

6. Click Install to install the Service Pack.

7. Click Restart to restart the computer.
4.1.2 Installing an NFS System
For FEMISv1.4.7, you may install either NFS Maestro v6.2 and v6.2.0.2 patch or Solstice NFS

Client v3.2 for your NFS System. If you will be using Samba to map server drives on the PC, then no
NFS software needs to be installed on the PC.

CAUTION

Do not install an NFS system until after you have completely installed Windows NT, including
the network setup.

4-7
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Note: If NFSMaestro v6.0.1 or earlier was previoudly installed on the PC, it must be removed
before you install NFS Maestro v6.2 and v6.2.0.2 patch or Solstice NFS Client v3.2.

Versions of Maestro 6.1 or later can be upgraded.
If you have Maestro v6.2 installed, you only need to install the NFS Maestro v6.2.0.2 patch.
4.1.2.1 Identifying the Maestro Version

To know if you will need to upgrade to NFS Maestro v6.2 or only install the v6.2.0.2 patch, complete the
following steps.

1. Goto %WINDIR%\SYSTEM32\DRIVERS.

2. Right click on HCLNFS.SYS.

3. Select Properties.

4. Check the version of thefile in the Version tab.

Another way to verify if you currently have NFS Maestro v6.2, or later, isto aseeif the HCRPCLIB.DLL
filein located in %WINDIR%\SYSTEM32 directory. Itisanew file with NFS Maestro v6.2.

4.1.2.2 Uninstalling NFS Maestro v6.0.1 (or earlier)

Complete the following steps to remove NFS Maestro v6.0.1 (or earlier). If NFS Maestro has not been
installed on the PC, skip this section.

1. Loginto Windows NT as auser with Administrator privileges.
1. Click Start > Programs = NFS Maestro = Uninstall.

2. Click Yes onthe NFS Maestro Client — Uninstall window. The default radio button is set to Remove
completely from Systems for all Users.

3. Click Yes when prompted to remove the registry entries, program groups, and installation directory.
4. Click Yes “I Agree” on the License Agreement window.

5. Click Yes to restart the computer.

4.1.2.3 Installing NFS Maestro v6.2

Toinstall or upgrade to NFS Maestro v6.2, insert the FEMIS COTS CD into the CD drive, and complete
the following steps.

4-8
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1. Logininto Windows NT as Administrator.
2. Click Start > Run = Browse > D:\MSTRO62\SETUP.EXE. Click Open and OK to run the
SETUP.EXE program.
3. Select the language you want to use. English isthe default. Click OK.
4. Click Next on the Welcome Window.
5. Click Yes on the License Agreement window.
6. Select Custom for installation type. Click Next.
7. Click Yes to Allow All Users of this Machine to See this Installation. Click Next.
8. Specify the Maestro Home directory. Click Next to accept the default C\APROGRAM

FILES\MAESTRO.NT.

9. Specify the Maestro User directory. Click Next to accept the default C:\PROGRAM

FILES\MAESTRO.NT\USER.

10. Deselect the Jconfig daemon (Java component) from the list of itemsto ingtall by clicking on it.

Click Next and Finish.

Note: The Jconfig daemon requires Microsoft Java Virtual Machine, which is generally not
installed on FEMIS PCs. FEMIS does not require this software or daemon to be
installed.

11. Click the Skip on the Site Information window.

12. Click Finished on the Site Information window.

13. Click Next or Skip when prompted to create a shortcut on your desktop-thisis optional.

14. Click OK in the Scan for NFS Servers window.

15. Verify the following are in the NFS Magestro Client for Windows NT — Configuration window:
General Tab

1. Enter the name of your FEMIS server in the Default Authentication Server field.

2. Check TCP and DOS-style sharing under Default Links.
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3. Under Default Protection for User and Group check R W X (Read, Write, and Execute).

Note: If this PCisrunning the EMIS client, be sure the Filename Capitalization is set to
Lowercase.

Read/Write Settings Tab
1. Increasethe Default Read and Write Sizes to the maximum — 65536.
2. Click Close.

If you get a message about important user files that differ from previousfiles, click OK, and ignore
the message.

3. Click No when prompted to have setup close all applications and restart the computer.
Y ou are now ready to install the NFS Maestro v6.2.0.2 patch.

4.1.2.4 Installing NFS Maestro v6.2.0.2 Patch

Complete the following stepsto install the Maestro v6.2.0.2 Patch.

1. Loginto Windows NT asauser with Administrator privileges.

2. Click Start » Run > Browse - D:\NFSPATCH\NFS6202_NTI.EXE. Click Open and OK to run this
program.

3. Click Continue in Patch Installer window.

4. Click Next in Welcome window.

5. Click Yes in Software License Agreement window.
6. Click Next in Start Copying Files window.

7. Leave Yes selected to have Setup shutdown and restart computer or select No and manually restart
the computer after the installation.

8. Click Finish.
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4.1.2.5 Running the Parmset Configuration Program

The Parmset Configuration program will run automatically when you log onto the PC after the installation
of NFS Maestro 6.2. This program can be rerun anytime by using Start > Programs > NFS Maestro >
Parmset. The system has to have been rebooted since the Maestro installation for the Parmset
Configuration program to work correctly.

1. Select Continue and run the Parmset Configuration program after setting the following parameters:

Remote Host: <servername>
FileSystem: <serverpath>
UserName: <femis>
Password: <password>

Select TCP.
2. Click OK.

This program takes from 10 to 15 minutesto run. Accept the best transfer rate. The PC will need to be
rebooted for the changes to work correctly.

4.1.2.6 Installing Solstice NFS Client v3.2

For an upgrade or new installation of Solstice NFS Client v3.2 on a PC, insert the FEMIS COTS CD into
the CD drive, and complete the following steps:

1. Logininto Windows NT as Administrator.

2. Click Start » Run - Browse = D:\SOLSTICE\SUNWFILE.EXE. Click Open and OK to run this
program on the COTS CD.

3. Enter your Solstice NFS Client v3.2 serial number on the User Information window.
Note: If you are upgrading, your old serial number will display but might not work. If you
select Evaluation, your product will expirein 30 days, and FEMIS will not work
correctly.
Click Next.
4. Click Yes to continue on the Registration Confirmation window.
5. Accept the default installation directory on the Choose Destination Location window, and click Next.
If you are upgrading from Solstice NFS Client v3.1+, click OK for the setup to upgrade your current

installation.
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6. Select Typical installation on the Setup Type window that displays, and click Next.

7. Click Next to configure the software on the Setup Configuration Wizard window.

8. Click Next to accept the Windows Default Name Service.

9. Click Next to start copying files. If prompted, click Yes to overwrite read only files.

10. Select No, | will restart my computer later. Click Finish.

To properly configure Solstice, complete the steps in the following section, Configuring Solstice NFS
Client v3.2.

4.1.2.7 Configuring Solstice NFS Client v3.2
To configure Solstice NFS Client v3.2, complete the following steps:
1. Click Start & Settings - Control Panel - Network = Services tab.
If thisisanew installation, you will need to click Add, select the Solstice NFS Client, and click OK.
2. Select the Solstice NFS Client on the Servicestab, and click Properties.
3. Select the Security tab on the Solstice NFS Client Configuration window.

4, Select Read, Write, and Execute for the User and Group on the Default File Creation Permissions
section. For Other, only select Read and Execute.

5. Select the Use a Specific Authentication Server, and enter your EOC’s server. Click OK and Close
the Network window.

Note: The server needsto be running the Solstice pcnfsd daemon. See Section 2.1.4.4,
Installing Sun PC NFS Daemon.

6. Click Yes to restart the computer now.

Note: When the computer restarts and islogged into the network, the Solstice NFS Client will
try to validate the user name and password on the authentication server that was entered
in Step 6. If the user does not have an account on this server or passwords on the PC and
server are not the same, you will be prompted for a user name and password for Solstice
NFS Client aswell asyour NT workstation login.
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4.1.3 Installing Oracle Net8 Client v8.1.5 and ODBC Driver v8.1.5.5

If aprevious version of Oracle SQL* Net and the ODBC driver have been installed, they should be
removed. If applications other than FEMIS are using your previous version of Oracle, check with the
vendor for information on compatibility.

Oracle can be setup on a PC using multiple versions of Oracle using separate directories and Oracle
homes, which is not discussed in this procedure.

Since this procedure calls for the removal of the ODBC driver, any DSN (data source name) using the
Oracle 7 driver, other than ones created by the FEMIS install, need to be deleted using the ODBC Data
Source Administrator located in the Control Panel. Y ou should document the parameters for these DSNs

so they can be recreated using the new Oracle ODBC driver. The FEMISinstall will automatically
change the DSNs for the site you are ingtalling.

4.1.3.1 Uninstalling Oracle SQL*Net Client v2.3.4 and Oracle7 ODBC Driver

If either FEMIS or Oracle has previoudly been installed on the PC, you will need to perform this section.
If aprevious version of Oracle has not been installed on the PC, skip this section.

1. LogintoWindows NT asauser with Administrator privileges.

2. Click Start » Programs - Oracle for Windows NT = Oracle Installer.
The Oracle Installer shows your Oracle Home directory where Products Installed at.

3. Save copies of your TNSNAMES.ORA and SQLNET.ORA located in the <Oracle
Home>\NETWORK\ADMIN directory. If you have other files you wish to keep in the Oracle Home

directory, save them a so.

4. Select all Oracle Productsinstalled that are listed in the right column of the Oracle Instaler. You
can hold the Shift key down and select the first and last product to select them all.

5. Click the Remove button in the center of the window.

6. Click Yes to confirm removal of products.

7. Click OK in Informationa window that the Oracle Installer will not be removed.

8. Click Exit to close the Oracle Installer.

9. Deletethe Oracle Home directory.

10. Delete the Oracle for Windows NT program directory. Using Windows NT Explorer, browse to

C:\WINNT\PROFILES\ALL USERS\START MENU\PROGRAMS. Locate the Oracle for Windows NT
directory and deleteit.
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11. Click Start > Run. Enter regedit in the Open field, and click OK.

12. Right mouse click on the ORACLE key and select Delete under
My Computer\HKEY_LOCAL_MACHINE\SOFTWARE.

Note: Be careful when editing the Windows NT registry. Modifying the wrong items can result
in adysfunctional system.

4.1.3.2 Installing Oracle Net8 Client v8.1.5

Toingtal Oracle Net8 Client v8.1.5, insert the FEMIS 147 COTS CD into the CD drive, and complete the
following steps.

1. Loginto Windows NT as auser with Administrator privileges.

2. Click Start » Run > Browse - D:\ORACLES815\SETUP.EXE. Click Open and OK to run this
program.

The Oracle Universd Installer will start.
Click Next in the Welcome window.
3. Accept the defaultsin the Destination Path in the File Locations window.

e Destination Name: ORAHOMES81
e Destination Path: C:\ORACLE\ORAS81

Note: The Destination Name and Path can vary due to previous Oracle installations.
Click Next.

4. Click Next to install Oracle8i Client v8.1.5 in the Available Products window.

5. Choose Custom in the Installation Typeswindow. Click Next.

6. Check the following boxesin the Available Products window:

* Net8 Products 8.1.5.0.0
 Net8 Client 8.1.5.0.0

* Oracle Installation Products
e Oracle Universal Installer 1.6.0.9.0
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10.

11.

12.

13.

14.

Uncheck the following boxes:

*  Oracle Utilities

* Oracle Configuration Assistant
» Development Tools

*  Oracle Java Products

Note: These are the minimum required productsfor FEMIS. If you need additional items, they
can be also installed, but they may require additional configuration during setup that is
not covered in this document.

Click Next.

Click Next in Component L ocations window.

Ensure only TCP/IP is selected in the Oracle Protocol Support window by holding down the Ctrl key
and clicking on items to select or deselect them. Click Next.

Click Install in the Summary window.

After Oracle products are installed, the Configuration Tools window will appear, and the Net8
Configuration Assistant will run.

Click Cancel in Net8 Configuration Assistant Welcome window.

Click OK in Error window that appears.

Click Next in the Configuration Tools window.

Click Exit in the End of Installation window, and Yes on the message box that appears.

Restore your TNSNAMES.ORA and SQLNET.ORA to ORACLE_HOME\NETWORK\ADMIN directory
if you are upgrading from a previous Oracle installation.

4.1.3.3 Installing Oracle ODBC Driver v8.1.5.5

Oracle Net8 Client v8.1.5 must be installed before you complete the following stepsto install the ODBC
Driver 8.1.5.5.

1

2.

Click Start-> Programs - Oracle Installation Products = Universal Installer.

Click Next in the Welcome window.
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3. Click Browse = <COTS drive letter>:\ODBC8155\PRODUCTS.JAR in the Source... Path: field.
Click Open. Click Next.

4. Click Yes in the Dependencies window that appears.
5. Click Install in the Summary window.

6. Click Exit in the End of Installation window, and Yes on the message box that appears.

4.1.4 Installing ArcView GIS v3.1 and v3.1.1 Patch

Note: If youreinstall ArcView GIS after having aready installed FEMIS, the correct version of
the file DEFAULT.APR will be overwritten by the ArcView GISinstalation. Copy the
DEFAULT.APR file from your C:\FEMIS directory to the
<DRIVE>\ESRNAV_GIS30\ARCVIEW\ETC directory on the PC. If you cannot find
C:\FEMIS\DEFAULT.APR, then the file may be copied from /home/femis/pc/femmisc/ on
your server.

ArcView GISv3.1 must be installed on the computer before you install the v3..1.1 patch,
and the patch must be installed for FEMIS to work properly.

If an older version of ArcView GISis currently on the PC, remove it before installing ArcView GISv3.1.
Note: If morethan oneversion of ArcView GISisinstaled on the PC, FEMIS will find the
most recently installed version. If you have multiple versions of ArcView GISinstalled,

check the %WINDIR%\FEMIS.INI file after the FEMIS instalation is complete to make
sure that the file references the correct install ation.

4.1.4.1 Installing ArcView GIS v3.1

Y ou will need to have the ArcView GIS license number for thisinstallation. The CD key number is
located on the ArcView GISinstallation disk.

To Install ArcView GISv3.1, insert the FEMIS COTS CD into the CD drive, and complete the following
steps:

1. Loginto Windows NT as Administrator.
2. Click Start > Run = Browse - D:\AV3.1\SETUP.EXE. Click Open and OK to run this program.
3. Click Next in the Welcome window.

4. Click Yes in the License Agreement window.
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5. Choose Local install for installation type. Click Next.

6. Select Custom and other options you may want to install. Click Next.

10.

10.

11.

12.

13.

14.

15.

Note: If you are upgrading, click Yes to replace current instalation.

If you are attempting to upgrade and you are not prompted to replace the current
installation, click Back and verify the install destination has ArcView installed.

Deselect the Map data and Launch Seagate Crystal Reports 6.0 setup. Click Next.

Note: Map dataand Seagate Crystal Reports are not used by FEMIS but can be ingtalled if
desired.

Click Next to accept the defaults for Program Folders and Existing Folders. The Start Copying Files
window displays.

Click Finish to start copying thefiles.

Click OK in the information window.

Click Yes and Finish on the Setup Complete window to restart the computer.

Re-logon to the computer using the same user account that was used to install ArcView.
Click Start » Programs = ESRI = ArcView GIS version 3.1 = ArcView GIS version 3.1.

Enter the name and organization and the ArcView GIS license number. Click OK, and ArcView GIS
will start.

Deselect the Show this window when ArcView GIS Starts box on the Welcome to ArcView GIS
window. Click Cancel.

Click File > Exit to close The ArcView GIS v3.1 application.

4.1.4.2 Installing ArcView GIS v3.1.1 Patch

Note: ArcView GISv3.1 must beinstalled before installing ArcView GISv3. 1.1 patch.

To Install ArcView GISv3.1.1 patch, insert the FEMIS COTS CD into the CD drive, and complete the
following steps:

4-17



Federal Emergency Management FEMIS Installation Guide
Information Systems (FEMIS) May 26, 2000-Version 1.4.7
1. Loginto Windows NT as Administrator.

2. Click Start & Run = Browse = D:\AV3.1 PATCH\AV31PATCH.EXE. Double-click on theto run this
program.

3. Click Yes to continue the installation of ArcView GISv3.1.1 patch.
4. Click Next to accept the default Local Install.
5. Click Next to accept the default destination location.

6. Click Next in the Review Current Settings window that displays inside the Start Copying Files
window.

7. Click Finish and reboot the PC before using ArcView GISv3.1.
4.1.4.3 Creating the ArcView GIS Icon for All Users
The ArcView installation only installs the ESRI Program folder that contains the ArcView GIS 3.1 icons
for the user that installed the software. If you would like more than this user to run ArcView from
Program folders, you will need to copy the ESRI Program folder to the other users profile. FEMIS does
not require ArcView GISv3.1.1 bein Program folders. Y ou can copy the Program folder from the
installer’ s user profile to the All Users profile using the following procedure.
1. LogintoWindows NT asauser with Administrator privileges.
2. Click Start - Programs - Windows NT Explorer.

Note: You must use Windows NT Explorer to complete the following steps.
3. Browseto the %WINDIR%\PROFILES\<Installation user>\Start Menu\Programs.
4. Right click onthe ESRI folder and select Cut.

5. Browseto the %WINDIR%\PROFILES\AIl Users\Start Menu.

6. Right click on the Programs folder and select Paste.

4.1.5 Installing Microsoft Project 98 Service Release 1

If aprevious version of Microsoft Project has been installed, completely uninstall the previous version
before completing thisinstallation.
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Note: If the Microsoft Project 98 Service Release 1 installation was unsuccessful, it is because
the data access drivers on the PC have been corrupted. On the FEMIS COTS CD, usethe
mdac_typ.exe fileto replace the current data access drivers, and you should be able to
successfully install Microsoft Project. For more assistance call the IEM Help desk or
PNNL.

Y ou will need to have the Microsoft Project license number during the installation. The CD key number
islocated on your licensed Microsoft Project installation disk.

To instal Microsoft Project 98 Service Release 1, insert the FEMIS COTS CD into the CD drive, and
complete the following steps:

1. Logininto Windows NT as Administrator.

2. Click Start > Run > Browse - D :\msp98sr1\SETUP.EXE. Click Open and OK to run this program.
3. Select Continue on the Close Any Open Applications window.

4. Enter the name and organization information, if requested. Click OK.

5. Click OK to confirm the name and organization.

6. Enter the Microsoft Project CD key number.

7. Click OK to acknowledge the Product ID.

8. Accept the default destination folders.

9. Click Custom Install.

10. Click Data Access and Change Option. Select the Database Drivers Utility option, and click OK.
11. Click Continue to begin copying files.

12. Click OK when theinstallation is complete.

4.1.6 Installing Other COTS
The following COTS products should be installed using the installation documentation for each product.

E-mail application (if desired)
Use the standard product installation notes provided with the software.

Word processor (if desired)
Use the standard product installation notes provided with the software.
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Spreadsheet (if desired)
Use the standard product installation notes provided with the software.

Graphics Presentation (if desired)
Use the standard product installation notes provided with the software.

4.2 Configuring the FEMIS Setup Program

CAUTION

Configuration isonly done once at each EOC. Stop PC installation until all configuration
has been performed.

Several other files must be configured for your site or EOC. Most of these files should have been
configured during the FEMIS UNIX installation but should be validated before installing the FEMIS
application on the PCs.

Note: Directories specified below are from the PC. You will need to use the UNIX version of
these directoriesif you are editing files from the UNIX server.

4.2.1 Connecting the Network Install Drive

To connect the FEMIS network drive to the install directory, complete the following steps. The partsin
italics are what should be changed.

1. Obtain the shared name of the FEMIS account home directory from your from your System
Administrator. Example: Samba/Solstice — \\<server>\femis. Maestro — \\<server>\/disk#/femis.

2. Open the Windows NT Explorer.

3. Select Tools > Map Network Drive menu option, and fill in the fieldsin the Connect Network Drive
window asfollows.

Drive: I\

Path: \\<server >\femis

Connect as. femis

Enter <network password> when prompted.

The FEMIS network drive will be displayed in the All Folders pane on the left side of the Windows NT

Explorer window. Any available drive letter can be used in place of I:\ for the installation drive.
However, this documentation will assume that FEMIS is being installed from the I\ drive.
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4.2.2 Validating the 'N\CONFIGD\FSETUP.INI File

The FEMIS Setup program uses a configuration file to determine the defaults for the installation.
Validate that the IN\CONFIGD\FSETUP.INI file was correctly configured during the server installation.

The first section of the INI file, the [Setup Defaults] section contains entries that set defaults for the Setup
program. Starred items (*) are those that should have been configured by the UNIX ingtallation scripts.

Site* Default site code. This should be the FEMIS four letter code for
your site.

EOC* Default EOC code. This should be the FEMIS four letter code for
your site.

DestDir Default installation destination directory for new installations.

Re-installations and upgrades will default to the current FEMIS path.

Version Gives the version of FEMIS for which thisinstance of FSETUP.INI was
created.

DateThisFSETUPCreated Givesthe build date for this version of FEMIS.

mDriveNetPath* Path to the FEMIS M:\ drive that the FEMIS startup script will connect.
This does not need to be set if you use an alternate method to map the
M:\ drive. Enter this specification only if you desire to have fstartup.exe
attach the M:\ resources on the majority of PC installations.

LocalStartupScript Full path for alocal startup script to be run by the FEMIS startup script.
Thisisoptional.

EMIS_StartupScript Full path to the EMIS startup script file. The FEMIS startup script file
will run thisfile.

The second section of the INI file, the [Sites] section, is used to fill the Site drop-down list in the Select
Site and EOC window in the PC Setup program. Y ou can edit thislist to limit the possible selections
availablein Setup. Each site entry must be formatted as SiteNN=<SITECODE> where NN isatwo digit
integer and <SITECODE> all uppercase. If you shorten thelist of sitesto asingle entry, the user will be
forced to accept that entry when running Setup. If you edit the list, the numbering for the sites must be
sequential, starting at 01.

Subsequent sections are lists of EOCsfor each sitein the [Sites] section. Each sitelisted in the [Sites]
section must have a corresponding [<SITECODE> EOCs] section. These sections are used to fill the EOC
drop-down list in the Select Site and EOC window in the PC Setup program when the corresponding site
is selected on the same window. The EOC list sections can be edited in the same manner asthe Sitelist.
Each EOC entry must be formatted as EocNN=<EOCCODE> where NN is a two digit integer and
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<EOCCODE> must be all uppercase. If you shorten thelist of EOCs to a single entry, the user will be
forced to accept that entry when running Setup. If you edit the list, the numbering for the sites must be
sequential, starting at 01. EOC list sectionsthat do not have a corresponding site listed in the [Sites]
section will be ignored.

4.2.3 Verifying the GIS.INI Files on the Server—Maryland Only

The Maryland GIS has one set of INI files (small, medium, and large) for each EOC. Each of the other
sites has one set that isused by all EOCs. Consequently, an extra step is necessary in Maryland to ensure
that the correct set of INI files arein place before installing FEMIS on the PCs.

The /home/femis/gis/sbcc_apr directory on the server iswhere Setup will look for the INI files. This
directory has a subdirectory for each EOC that contains the three INI files. Before running Setup on the
PCs, log onto the server as the user femis and copy the files from the subdirectory for your EOC. For
example, at the MEMA EOC, you would log onto the server and enter the commands

%cd /home/femis/gis/sbcc_apr
%cp /mema/* ./

4.2.4 Validating the 1\CONFIGD\TNSNAMES.ORA File

The TNSNAMES.ORA file should be configured with the correct database names, listeners, and IP
addresses. Thisfile should be a copy of $TNS_ADMIN/TNSNAMES.ORA on the UNIX server. For each
listener on each server, it should contain asection like the following. The partsin Italics are what should
be changed. (See Section 2.3.3.2, Installing the Oracle Software, Step 10 to edit the var/opt/tnsnames.ora
file):

fi_ctoo =
(DESCRIPTION =
(ADDRESS_LIST =
(ADDRESS =
(COMMUNITY = TCP)
(PROTOCOL =TCP)
(HOST = ctoosun.utah.gov)
(PORT =1521)

)

)
(CONNECT_DATA =
(SID =fi_ctoo)
)
)

Note: The setup program will not copy the TNSNAMES.ORA fileto aPC if that PC aready has
aTNSNAMES.ORA file. See Section 15.2, FUPDATE.BAT in the FEMI S System
Administration Guide for more details on how to configure FUPDATE.BAT, if you need
to update the TNSNAMES.ORA file on al of the PCsthat will be running FEMIS.
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4.2.5 Validating the '\CONFIGD\ADDODBC.BAT File

FEMIS uses the \USER\ADDODBC.BAT batch file to add all the necessary ODBC data source names to
each PC. Verify that the mapping from EOC code to listener ID is correct for each line.

If any changes are made to thisfile after FEMIS has been installed on PCs, the I\USER\FUPDATE.BAT
file needs to be updated to propagate the updatesto all PCs.

4.2.6 Validating the I'\CONFIGD\AUTOEXNT.BAT File

During the installation process, the I\CONFIGD\AUTOEXNT.BAT fileis copied to the
%WINDIR%\SYSTEM32 directory, usualy C\WINNT\SYSTEM32. Thisfile should contain the following
commands. The <TEMPLATE_HOSTNAME> should have been changed to the name of the FEMIS
UNIX server.

net stop NetWorkTimeProtocol

%WINDIRY%\SYSTEM32\PING -w 60000 TEMPLATE_HOSTNAME
%WINDIRY\SYSTEM32\NTPDATE -b TEMPLATE_HOSTNAME
net start NetWorkTimeProtocol

The AUTOEXNT.BAT fileisinvoked at boot up. Its purposeisto synchronize time on the PC while
bypassing the usual NTP time adjustment algorithms. NTPDATE immediately sets the time on the PC to
be the same as on the UNIX server. After boot up, the usual NTP agorithms apply.

Note: Besurethat thelast line shown aboveispresent. Thisline may be deleted by the UNIX
setup script that configures the file with the UNIX server name.

4.2.7 Validating the '\CONFIGD\NTP.CONF File

During the installation process, the NTP.CONF fileis copied to the %WINDIR% directory, usually
C:\WINNT.

The NTP configuration file on the PC should contain at a minimum one drift file and one-or-more server
directives. Theformat of the drift file directive is driftfile %WINDIR%\NTP.DRIFT, where %WINDIR%
usually is C:\WINNT.

The format of the server directive is server <hostname>, where hostname is the name of the UNIX server
from which the PC isto acquire time synchronization. Generally, thisisthe UNIX computer located on
the same Local Area Network (LAN) asthe PC. PCs should acquire time synchronization first from the
closest UNIX computer and not from some distant host on the WAN or the Internet. Distant hosts can be
used as a secondary time synchronization source. To designate the primary NTP host, include the
keyword, prefer, in the server directive.
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As an example, the following NTP.CONF fileisthe preferred format for NTP configuration. It liststhe
local UNIX server asthe preferred time server and the other (far away) servers as secondary. Inthis
manner, if the preferred host is inaccessible, one of the secondary servers can provide time
synchronization:

server <IP address of UNIX server> prefer
server <IP addresses of other servers on WAN>
server <IP address of server on the Internet>
driftfile CAWINNT\NTP.DRIFT

The Network Time Protocol serviceis very sensitive to the format of thisfile. Occasionaly, in
transferring this file from between UNIX and Windows computers, extra carriage return characters will
be appended to the end of each linein thisfile. These extra characters are not detectablein a PC editor,
but show up as “~M” characters at the end of each linein aUNIX editor, such asVI. These extra
characters at the end of aline with a server directive will prevent the Network Time Protocol service from
loading correctly. If the Network Time Protocol service does not appear to be working, this should be
checked.

For more details on NTP set up and configuration methods, see Section 11.0, Server Network Time
Protocol (NTP) Set Up, inthe FEMI S System Administration Guide.

4.2.8 Validating the I'\USER Directory

Verify the following files are located in I\USER directory. FEMIS uses these filesto create the ODBC
Data Source Names (DSNs) that are used to connect to the Oracle relational database. Thesefilesare aso
used to update files on each PC as needed (see Section 15.2, FUPDATE.BAT in the FEMI S System
Administration Guide for more details on how to configure FUPDATE.BAT).

» ADDODBC.BAT
» FUPDATE.BAT
» ODBCSUB.VBS
» PFEMIS.VBS

4.2.9 Configuring the I\PC\FEMTOOLS\FEMIS.DB File

To configure the servers and routers to match your network configuration, you will need the server names
for dl EOCs at the site. If you have not previously configured a femis.db file, it will not exist. Your PC
needs to be able to resolve the host names of al the servers on the network either through a naming
service or HOSTS file.

1. Execute atelnet session to the FEMIS server by clicking Start - Run, and enter telnet <server>.
Logon using the femis account.
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10.

Change the Permissions on the /home/femis/pc/femtools directory and the femis.db file (if it exists)
by entering the following:

chmod 775 /home/femis/pc/femtools
chmod 777 /home/femis/pc/femtools/femis.db

Do not close the telnet session window.
Note: If the FEMIS.DB file' s attributes are set to read-only, then WS_WATCH.EXE will not be

able to save the new configuration you create, but it will not give any indication of an
error.

Run I\PC\FEMTOOLS\WS_WATCH on the PC.

Select File & Load, browseto I\PC\FEMTOOLS, select FEMIS.DB, and click Open. |f FEMIS.DB
does not exist, click Cancel.

If the FEMIS.DB you opened does not resemble your network architecture, close WS_WATCH.EXE,
delete \PC\FEMTOOLS\FEMIS.DB, and restart WS_WATCH.EXE.

Select Edit menu item and modify the grid to match your network. To add a system, select
Add = Host. Aniconwill display. Position the icon where you want it.

Click once on the new host, and the host information window displays. Enter the following
information.

Display Name: <server name>
Address/Name: <server name>
System Type: <server or router>
Type: TCP/IP

Click Accept.
Note: Repeat Steps 2 through 4 for all FEMIS servers, network routers, and other systems
significant to the network at your location. Usethe Edit > Add = Line to show

appropriate network connections between items.

Add lines between hosts to resemble network connections by selecting Add = Line and right click on
the beginning and end of the line position.

Delete hosts or lines by selecting Delete - Host/Line. Left click on the host to delete. Right click on
theline to delete.

Select END_EDIT, File > Save As. Savethefile as \PC\FEMTOOLS\FEMIS.DB. If it isnot saved
with this name and location, it will not be installed on the PC during setup.
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11. ExitWS_WATCHE.EXE.

12. Return to the telnet session to the FEMIS server. Change the Permissions on the
/home/femis/pc/femtools directory and the FEMIS.DB file located there by entering the following:

chmod 555 /home/femis/pc/femtools
chmod 444 /home/femis/pc/femtools/femis.db
exit

13. Close the telnet window.

4.2.10 Updating Files on All PCs Using FUPDATE.BAT

FUPDATE.BAT isautility that can be used to update any file(s) on al FEMIS PCs such asthe HOSTS
file or GIS datafiles. View the M:\\FUPDATE.BAT fileitself for specific instructions on how to configure
it to update files on all FEMIS PCs.

When updating GISfiles, it is necessary to know the path where the GIS was installed and sometimes the
size of the GIS that was installed. These can be determined by adding the following line to
FUPDATE.BAT.

call %FemisTopDir%\GIS\<site_code> ENV.BAT
Thiswill set two environment variable:

GisTopDir —Thisisthe top level directory for the GIS data. For example, it might be
C:\FEMIS\GIS\DCD1 if you were in DCD1 and had installed the GIS on your C:\ drive. This
environment variable can be useful for sites where people install the GIS on different drives.

GisSize — This environment variable will contain the relative size of the GIS (SMALL, MEDIUM, or
LARGE). Thisenvironment variable can be useful if you need to update the FEMISGIS.INI filesfor a
site where not everyone installed the same size GIS data.

See Section 15.2, FUPDATE.BAT inthe FEMI S System Administration Guide for more details on how
to configure FUPDATE.BAT.

4.2.11 Updating the PC HOSTS File

Depending on the DNS and TCP/IP configurations for the local PCs, it may be necessary or desirable to
update the HOSTS file on PCs as part of the FEMIS installation. If the PC does not have aHOSTS file
and one has been configured on the installation server in the /homeffemis/configd directory, the PC Setup
program will copy that file to the PC. However, if aHOSTS file aready exists on the PC, the PC Setup
program will not overwrite it.
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If it is decided to update the HOSTS file on all PCs, the update should be done using the FEMIS
FUPDATE tool. The FUPDATE tool isrun as part of the PC Setup program, so updates will beinstalled
when FEMISisinstalled. FUPDATE isalso run each time a user logs into a PC, so updates, that are
configured after one or more PCs have been installed, will ill be copied to those PCs.

Note: The setup program will not copy the HOSTS file to a PC if that PC already hasaHOSTS
file. See Section 4.2.10, Updating Files on All PCs Using FUPDATE.BAT, if you need
to update the HOSTS file on all of the PCs that will be running FEMIS.

4.3 Installing the FEMIS Client Software

This software is for the PC workstations that are connected to the FEMIS data server and contains the
FEMIS client software and a collection of GIS themefiles. The installation program for the FEMIS client
software assumes the necessary COT S packages have already been installed.

The FEMIS client software isinstalled over the network from a UNIX server. The client software
contains over 120 files representing approximately SOMB of file space.

The FEMIS executable and other FEMIS support files will be loaded to the following locations:

e current %WINDIR% directory, usualy C\WINNT
*  %WINDIR%\SYSTEM32 directory

e C:\FEMIS directory

*  Microsoft Project directory.

All files needed by the installation process should have previously been copied from the rel ease tape or
CD to the server. Thefiles specified in Section 4.2, Configuring the FEMIS Setup Program, should have
been configured or validated before the FEMIS client software is installed.

4.3.1 Preparation
To prepare for starting to install FEMIS v1.4.7, complete the following steps:

1. LogintoWindows NT as Administrator or to a Windows NT account that has Administrator
privileges. Setup will abort if it isrun from a Windows NT account that does not have Administrator
privileges.

2. Veify that al COTS needed by FEMIS are installed on the PC. At the minimum, the following
should be installed (the Setup program will also verify that these areinstalled). Y ou should also
consult the FEMI S Bill of Materials (BOM) and verify that the correct versions of the software
products are installed.
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e Microsoft Windows NT
e Oracle Net8

* Oracle ODBC Driver

* ArcView GIS (ESRI)

Note: FEMIS also requires software to allow the PC to map directories on the FEMIS server to
logical driveson the PC. If Sambais being used, no additional softwareis required on

the PC. If an NFS software package such as Hummingbird Maestro or Sun Solstice NFS
Client is being used, then the client software needsto beinstalled on the PC.

4.3.2 Running the Setup Program
The FEMIS Oracle database on the UNIX server must be operational before the setup programis run.
1. Closeall programsthat are running, especially all FEMIS programs, including KeyPrint.

2. Connect your I:\ drive as specified in Section 4.2.1, Connecting the Network Install Drive, if you have
not already done this.

3. Runthe \PC\SETUP\SETUP.EXE program. The setup will bring up severa windows that require
your response.

Select Site and EOC: This alows you to select the Site and EOC from drop-down lists. The
contents of the lists are controlled by the I\PC\SETUP\FSETUP.INI
file.

Select Components: This alows you to select which FEMIS components will be installed.

The GIS and Additional Ilcons components have options that are
accessed by highlighting the component and clicking the Change
button.

Select Program Folder: This alows you to specify which folder in the Start menu will be used
for the FEMISicons. The default isFEMIS.

Choose Destination Location: This alows you to specify the drive and directory where FEMIS will
beinstaled. If FEMIS has previoudy been installed on the PC, the
default isthe last place where FEMIS was installed. If thisisthe first
time FEMIS has been installed on the PC, the default location is
C:\FEMIS.
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4.

5.

GIS Data Path: Thisalows you to select a destination for the GISfiles. The default
location is C:\FEMIS\GIS\<site code>.

Note: You may seeimproved performance from the FEMIS GIS if you choose to install the
GIS on a separate physical disk than the one on which you are installing FEMIS.

Start Copying Files: This displays an information window showing the options that have
been selected. Select Next to begin copying files.

The next part of the Setup program will take several minutesto configure the PC. Y ou may receive
prompts or setup may wait for confirmation before performing some items. Watch and click OK or
press Enter, as needed. These configuration operations will

* Update the FEMIS.INI for the PC name, FEMIS and GIS directories, and COTS paths.
*  Open ArcView to convert the FEMISGIS.INI fileto v1.4.7 format (if applicable).
* Open ArcView to regenerate the FEMISGIS.APR file.

Note: Whenthe FEMISGIS.APR is generated, the system checksto seeif any private GIS
ViewMarks exist in the VIEWMARK.ODB filein the
M:\[SITECODE\[USERCODENGIS\VIEWMARKS directory. If afileexidts, itisassumed
valid and will be used so that no old ViewMarks are lost. If no VIEWMARK.ODB file
exigts, anew file is generated with only one default ViewMark. This same check process
is repeated for the shared ViewMarks.

* Add ODBC information for the FEMIS databases.

»  Start the NTP service to synchronize time on the PC with the server.

e Create the C:\WINNT\SYSTEM32\AUTOEXNT.BAT file.

e Set the system to use FEMIS's own GLOBAL.MPT file with Microsoft Project.
* Remove obsolete files from older FEMIS installations.

* Verify the required COTS packages are installed.

* Add FEMIS environment variables, if needed.

Select Yes, | want to restart my computer now. on the Setup Complete window. Click Finish.

Log back in as Administrator after the computer restarts.

4.3.3 Updating the FEMISGIS.INI File

If the GIS Upgrade option was selected, perform the following steps after the PC has been rebooted.
Otherwise, proceed to Section 4.3.4, Regenerating the FEMIS GIS Dynamic Themes.

1

Map the I\ drive on the PC to the /home/femis directory on the server. Connect to the drive as the
user femis.
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2. Openthe FEMISGIS_UTILITIES.APR in ArcView GISv3.1.1.

3. Select Check INI Themes from the Utilities menu. A file dialog box displays. Find the <PC FEMIS
GIS DIRECTORY>\<SITECODE>\FEMISGIS.INI file and click OK.

Thiswill create a message box and error log file of missing themes from the FEMISGIS.INI filesin
thelocal GISdirectory. See Section 3.1.5, Troubleshooting the Migration, if there are any missing
themes reported.

4. Click OK.
A message box will display reporting any duplicate theme names or theme legend names in the
FEMISGIS.INI file. If there are duplicate theme and/or legend names, open atext editor and change

the theme name and/or legend name to a unique name. Save the file and repeat Step 3 of above.

5. Closethe FEMISGIS_UTILITIES.APR.

4.3.4 Regenerating the FEMIS GIS Dynamic Themes

The FEMIS GIS has both static and dynamic themes. The Setup program installs the files for the static
themes. Thefilesfor the dynamic themes are generated by the FEMIS application from data stored in the
FEMISrelational database. These dynamic theme files need to be regenerated after installing (or
reinstalling) FEMIS on a PC.

To regenerate the dynamic GIS themes, complete the following steps:

1. Stat FEMISandlogin.

2. Click the Map button on the FEMIS Workbench to start the GIS, and wait for the GIS to load.

3. Click Utility on the menu bar, and select Regenerate Map Layers - Regenerate Point Map Layers.

4. Click the Utility on the menu bar, and select Regenerate Map Layers - Regenerate Polygon Map
Layers.

4.4 Configuring the PC

4.4.1 Setting Up FEMIS User Accounts on Windows NT and UNIX

For Windows NT to be able to connect to the required FEMIS drives |ocated on the FEMIS server, a

UNIX user account on the FEMIS server must be created for each Windows NT user account that will be
used to run FEMIS. Each of these UNIX user accounts must have the same username and password as its
corresponding Windows NT user account. These are separate from the usernames and passwords that are
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used to log into the FEMIS application. The usernames and passwords used to log into the FEMIS
application do not need to match the UNIX or Windows NT usernames and passwords.

Note: Both of the Windows NT and UNIX user accounts must have the same username and
password so that network drives can connect correctly. Windows NT and UNIX
usernames and passwords ar e case sensitive. For example: JSmith and jsmith will not
work.

You can set up individual user accounts (such as jsmith) on one or on al of the PCs and the FEMIS
server. Positional accounts (such as sheriff) can be set up on one or all of the PCs and the FEMIS server.
One global (such as femisuser) can be set up on all of the PCs and the FEMIS server, or some other
combination.

Note: Setting up and maintaining individua or positional accounts on al of the PCs and the
FEMIS server can be time consuming, especially if you have many accounts and many
PCs. If the password is changed for an account on one PC, it must be changed on all the
others so they can all still connect to the network drives correctly.

4.4.1.1 Adding User Accounts to Windows NT

To add aWindows NT user account on aWindows NT PC, log onto the system with an account with
Administrator privileges and complete the following steps.

1. Click Start > Program - Administrative Tools - User.
2. Select New User, and fill in the following fields on the User Manager window:

Username:

Full Name:
Description:
Password:

Confirm Password:

3. Check with your System Administrator to determine which of the following options should be
checked.

User must change Password at Next Logon
User cannot change Password

Password never expires

Account disabled

After creating the Windows NT account, verify the following two items.

»  The username and password entered are the same as those for this user on the UNIX server.
*  TheWindows NT account is at least in the Users group under the Groups button.
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4.4.1.2 Adding User Accounts to UNIX

Refer to Section 2.1.1.3, Creating Users and Groups, for instructions on adding usersto the UNIX server.

4.4.2 Running the FEMIS Startup Files

FEMIS requires that several network drives be connected in order for all itemsto work correctly.
Running the FSTARTUP.EXE program connects these drives, and this program should be run
automatically when a user logs into Windows NT. Depending on how your network and PCs are set up,
use one of the two methods listed below for the program to run automatically.

Note: Most sites should use Method 1 and only add the Windows NT user accounts that will
actually be running FEMIS and have corresponding accounts on the UNIX server.

If both FEMIS and EMIS are being installed on asingle Windows NT account, you will need
to edit the FEMIS.INI file. See Section 4.2.2, Validating I'\CONFIGD\FSETUP.INI File, for
details. This should be done once on the UNIX server before FEMIS isinstalled on the PCs.

Method 1: As a User Login Script

1. When the Setup program completes, select User Manager in Administrative Tools in the Program
Manager or Start menu.

2. For every Windows NT user account that will run FEMIS, select the user in thelist. Then select the
menu item Properties under User, and click the Profile button on the form that appears. If you use an
NT domain to manage user accounts, this should be done on the domain server. Otherwise, this
should be done on each PC that is used for FEMIS.

3. Inthe Logon Script Name field, enter FSTARTUP.EXE.
Method 2: In Startup Folder

1. Using Windows NT Explorer, open the C:\WINNT\PROFILES\ALL USERS\START
MENU\PROGRAMS\STARTUP folder. From the File menu, select New - Shortcut, and a Create
Shortcut dialog box displays. At the Command Line, enter
%WINDIR%\SYSTEM32\REPL\IMPORT\SCRIPTS\FSTARTUP.EXE, and click Next. Enter aname
for the shortcut, such as FEMIS Startup Script.

2. Follow the steps later to verify that the icon isin the common Startup folder instead of a personal
Startup folder.

See Section 4.2.2, Validating I'\CONFIGD\FSETUP.INI File if you wish to customize the startup. You

can specify additional drives to be mapped by the FEMIS startup script, and specify local startup scripts
to be run after the drives have been mapped.
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4.4.3 Verifying the Temporary Directory and Environment Variables

The GIS and other programs need a directory to store temporary files. Use the following steps to verify
that this process was completed correctly by the Setup program.

1

2.

5.

Click Start - Settings = Control Panel = System.
Select Environment.

Verify thereisaUser Variable named TEMP (usually C\TEMP). If not, enter TEMP in the Variable
field and C:\TEMP in the Value field. Click Set.

Verify that a FEMISTOPDIR environment variable exists in the System Variables box. If not, select
it and change the value in the Variable and Value text boxes, and click Set. The value of this variable
should be set to the directory in which FEMIS was installed.

If you change anything, you must log out of Windows NT and login again for the changesto take
effect.

Click OK to exit the System Configuration in the Control Panel.

4.4.4 Verifying the Clock Settings and Time Zone Settings

To set the date format preferences so that FEMIS can process the date correctly, compl ete the following
steps.

1.

2.

3.

6.

Click Start - Settings - Control Panel - Regional Settings.

Select the Date tab in the Regional Settings window.

Set your short date style to dd-MMM-yy (Day - Month - Y ear).

Select the Time tab in the Regiona Settings window.

Verify that you are either using a 24-hour clock (upper case “H” in the Time Style field) or a 12-hour
clock (lower case “h” in the Time Style field) set with the AM and PM symbols are set to AM and PM

(not case sensitive).

Verify the time zoneis correct in the Control Panel = Date/Time icon = Time Zone tab.

4.4.5 Verifying the Time Synchronization Services

To verify the time synchronization services, the files and services discussed in the following sections
should be verified.
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4.45.1 Verifying the AUTOEXNT.BAT File

The AUTOEXNT.BAT fileislocated in the %WINDIR%\SYSTEM32 directory, usually
C:\WINNT\SYSTEM32. Thisfile should contain the following commands.

net stop NetWorkTimeProtocol

%WINDIRY\SYSTEM32\PING —w 60000 TEMPLATE_HOSTNAME
%WINDIRY\SYSTEM32\NTPDATE -b TEMPLATE_HOSTNAME
net start NetWorkTimeProtocol

The AUTOEXNT.BAT fileisinvoked at boot up. Its purposeisto synchronize time on the PC while
bypassing the usual NTP time adjustment algorithms. NTPDATE immediately sets the time on the PC to
be the same as on the UNIX server. After boot up, the usual NTP agorithms apply.
Note: The batch file AUTOEXNT.BAT starts the Network Time Protocol service. Network
Time Protocol should not be started automatically by the control panel. See

Sections 4.4.5.2, Verify AutoEXNT Service and 4.6.3.4 Verify Network Time Protocol
(NTP) Service.

4.45.2 Verify the AutoEXNT Service

To verify that the AutoEXNT service was installed and configured correctly, complete the following steps:

1. Click Start & Settings = Control Panel - Services.

2. Select AutoEXNT. The Status should be blank, and the Startup should be Automatic.

3. Click Startup. Verify the radio buttons for Automatic, under Startup Type, and System Account,
under Log On As, are selected. Also verify the checkbox to Allow Service to Interact with Desktop is
checked.

4. Select Network Time Protocol. The Status should be Started, and the Startup should be Manual.

5. Click Close to return to the Control Panel window.

4.4.6 Verifying the Virtual Memory Setting

For FEMISto run as efficiently as possible, the computer should be set to have at least 250M B
(megabytes) of virtual memory. To check the virtua memory setting and increase it, if necessary,
complete the following steps while logged in as Administrator.

1. Click Start - Settings = Control Panel > System.

2. Select the Performance tab.
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3. Click Change.
4. Increase the Maximum size to 250MB, if necessary, click Set.

5. Click OK, click Close, and select Yes to reboot, if prompted.

4.4.7 Creating FEMIS Icons
The FEMIS Setup program creates a shortcut on the All Users’ desktop to the FEMIS folder on the Start
menu. If you wish to add more shortcuts to the FEMIS folder on the Windows Start menu, you can

simply add the shortcuts to the FEMIS folder on the desktop.

If you wish to have any of the FEMIS icons on the desktop, copy the shortcuts from the FEMIS menu on
the desktop to the C:\WINNT\PROFILES\ALL USERS\DESKTOP folder.

If you with to delete any of the shortcuts, right click on the shortcut to be deleted and select the Delete
option. Thiswill only delete the shortcut, not the program to which it points.

Note: If anicon or ashortcut is not created in the All Users profile, the FEMIS icon will only
show up for the user under whose profile the shortcut was created.

4.4.8 Final Steps for the FEMIS PC Installation and Configuration

Note: If thisisan upgrade installation, you may wish to clean up old icons from the Program
Manager. These may include old icons for the FEMIS program and old icons for running
the startup batch filesin the Startup group.

The following are the final steps for the FEMIS installation.

1. Logout of Windows NT.

2. Loginto Windows NT asthe appropriate user account. Run FEMIS.

3. Veify theinstallation of the first PC thoroughly by following Section 4.6, Validating the FEMIS PC
Installation, before any more PC installations are started. If you must edit any of the configured files

(e.g., ADDODBC.BAT, TNSNAMES.ORA), copy the corrected file back to the server and install again
to be sure that it will work correctly.

4.5 Configuring FEMIS for All PCs at an EOC

The following validation steps need to be performed one time at each EOC. Since these configuration
changes affect values stored in the FEMIS database for the EOC, they will take effect on al of the PCs
using the same database.
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4.5.1 Verifying the Zone Name Lookup for EMIS PAR

Note: If both of the following two conditions are true, you must complete this section:
1. You are currently installing FEMIS on an onpost PC.
2. EMISisused onpost at your site.

Y ou can skip this section if you are upgrading from an earlier version of FEMIS, and you
performed these steps when that version was installed.

Because EMIS allows users to change zone names at will, thereis a possibility that FEMIS and EMIS
zone names will not match exactly. It isimportant, however, for FEMIS to be able to map its zone names
to the zone names used in EMIS so that Protective Action Recommendations (PARS) may be shared
between the systems. For this reason, asimple utility named FZONES.EXE has been added to the list of
system administration software tools available on the PC. Thistool allows your FEMIS System
Administrator to set up the EMIS zone name aliases so FEMIS will be able to correctly map PAR
information sent from EMIS. If EMISis part of the site configuration, then this utility must be run on the
onpost FEMIS at installation and again whenever EMIS changes their zone names.

4.5.2 Using FZONES.EXE Tool

FZONES.EXE isasystem tool that runs on the PC. Before you can run thistool, you will need to install
at least one PC with system tools.

Thistool displays a two-column spreadsheet of zone information. In thefirst column, thereis aread-only
list of FEMIS zone names. In the second column, there is awritable copy of the EMIS zone names.
When you first start this utility, it will load the values currently in the database for the FEMIS and EMIS
zone names. If at any time during the editing process you wish to rel oad the spreadsheet based on the
valuesin the database, click the Reset Spreadsheet button.

To populate the FEMIS/EMIS zone lookup table, you will need to get alist of all the EMIS zone names
for thesite. Thisinformation may be found on the EMIS server in the following file:
/<disk>/emis3run/emisdyn/data/<site code>/emisgis/giszne.dat. The <disk> and <site code> will be site
specific. Once you have the EMISist of zones, the smplest way to popul ate the lookup tableisto run
the FZONES utility, and then type the EMIS zone names directly in the spreadsheet next to the
corresponding FEMIS zone name. When the spreadsheet is complete, click the Save button.

4.6 Validating the FEMIS PC Installation

To run correctly, FEMIS software relies on many integrated components: the FEMIS database,
commercial and government supplied software products, the FEMIS application, and system support
services. Therefore, it isimportant to ensure that the FEMIS system is fully operational. This section
will assist your System Administrator to validate that the FEMIS system has been properly installed and
is operating correctly.
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The FEMIS PC Validation Checklist, provided at the end of this section, includes items that need to be
checked to ensure that the FEMIS system is operating properly. The Checklist correlatesto the items
listed below. These items are tested from the PC to ensure access and integration into the FEMIS
application. This checklist provides a method to validate that the server and external communications are
properly installed.

If problems are encountered during the validation, refer to Section 16.0, FEMIS Application Error

Messages and Troubleshooting, in the FEMIS System Administration Guide for suggestions and
guidance.

4.6.1 One Time at EACH EOC
The following validation steps must be performed one time at each EOC.
4.6.1.1 Verify Default D2PC Case Exists

From the FEMIS Workbench or the Tracking Navigator, click D2PC. On the D2PC Interface window,
select Edit mode, and click File - Site Defaults = Revert to Site Defaults.

If amessage displays stating there is“no current D2PC case selected” or “no site defaults yet assigned
for this site”, then you will need to create a site default D2PC case.

STOP
If thereisnot a site default D2PC case, select a case that runs and make it the default case.

It isimperativethat you consult with the Hazard Analyst to make sure the new default caseis
modified to meet their needs and saved.

Oncethe EOC has a default case, repeat thisverification step.

4.6.1.2 Verify the Evacuation Command Server
To verify the Evacuation Command server isworking properly, you will need to import and run an
Evacuation case. Evacuation cases are located on the I:\data\evac directory where I\ is\\<server

name>\home/femis. Seethe FEMIS Help for guidance on importing and running acase. Make it your
current operational case (on the Evac main window, File > Make Case Current Operational).

4.6.1.3 Verify FEMIS/EMIS Data Exchange Interface (DEI)

Note: The definitive description of thisinterface can be found in Section 7.0, FEMIS Data
Exchange Interface (DEI), in the FEMI S System Administration Guide.
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To verify that DEI is operating, click the Status menu in Operations mode and the select Met Condition.
If the current meteorological (Met) data appearsin the table, then the DEI is probably running.

4.6.1.4 Create a Plan for Validation Testing

To create a planning dataset that is shared so it can be used for PC validation, complete the following
steps:

1. Click on Utiltiy = Planning Functions <> Planning.

2. Choose Create New Shared Dataset from the Dataset drop-down list.

3. Name the new dataset, and click OK. The Tracking Navigator displays.
4. Click on Plan > Select Plan.

5. Select Basic Template from the Select Plan spreadsheet, and click Select.
6. Click the New Data button.

From the Tracking Navigator, you will need to create a Protective Action Decision (PAD) and a
Community Condition as part of this validation test.

Complete the following stepsto create a PAD for the validation test.

1. Click onthe PAD function box and OK to the message box that displays.

2. Select the Edit radio button.

3. Create anew PAD by entering a name in the PAD Name field, and click OK.

4. Click the New Data button.

Compl ete the following steps to create a Community Condition for the validation test.
1. Click on the Community Function box and OK to the message box that displays.
2. Select the Edit radio button.

3. Create anew Community Condition by selecting Default from the Name drop-down list, renameit,
and click OK to create a new Community Condition.

4. Click the New Data button.
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Complete the following steps to create a VValidation plan.

1

2.

3.

4.

5.

5.

6.

Click on Plan = Copy Current Plan.

Enter aname for the new plan, and click OK.

Click on Plan - Select Plan

Click No to AutoCalc synchronization message that displays.
Select the plan name created in Step 2, and click Select.
Click the New Data button.

Click on Edit under Tasks, and click OK on the message box. Microsoft Project is displayed.

Complete the following steps to add atask in Microsoft Project.

1

2.

3.

5.

6.

Click on an empty row.
Click on the Task Details Form button (far left side of the toolbar).

Select items from the Agency and Stage drop-down lists, select the Times & Misc tab. Click Save to
save the task changes. Click Close on FEMIS Task Details.

Click on Save under Tasks on the Tracking Navigator to save this plan, which will be used to Verify
Electronic Planning (item 15 on the FEMIS PC Validation Checklist).

Click the New Data button.

Click on Exit Project under Tasks and click Y es on message window.

4.6.1.5 Testthe GIS on the Printer

Not al printers display graphics the same. For each printer to which you anticipate printing, use both
KeyPrint and the Print option on ArcView GISto print a GIS map that contains a D2PC case, Threat
Area, Risk Areaand one or more facilities under each. Review the printout to ensure that it prints
graphicsin such away that:

Risk and No Risk can be differentiated.

One feature does not totally obscure an underlying feature (e.g., Y ou can still see facilities located in
the Threat Area, and the Threat Area does not wipe out the D2PC isopleths.).
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4.6.1.6 Verify E-mail

Verify E-mail can be sent to usersin al other EOCs.

4.6.1.7 Verify the SEPR Icon Addressee

Verify the addressee in the SEPR (Software Enhancement/Problem Report) icon fileisthe desired

addressee for that EOC. Some EOCs want to compile/review the SEPRs before they send them to PNNL.

Check the palicy of the EOC and modify the SEPR template as needed. If they want it to go directly to

PNNL, use ranata.johnson@pnl.gov (Ranata Johnson’'s E-mail address) or blanche.wood@pnl.gov
(Blanche Wood' s E-mail address).

4.6.2 Cleanup AFTER Validation

Note: Do not perform thefollowing clean up procedures until completing the validation
stepsin Section 4.6.3, Perform on EVERY PC.

After completing the above validations steps, the following cleanup validation steps need to be performed
onetime at an EOC, not on every PC.

4.6.2.1 Delete Validation Datasets

Delete the planning dataset created for validation in Section 4.6.1.4, Create a Plan for Validation Testing,
aswell as any other planning datasets that were created for the purpose of installation or validation.

4.6.2.2 Ensure Exercise #1 Exists

Ensure Exercise #1, or whatever Exercise is recognized by EMIS has been created. Thiswill allow EMIS
to communicate with FEMIS in Exercise mode.

4.6.2.3 Remove Extraneous FEMIS User Accounts
Remove extraneous FEMIS user accounts that were created during installation and validation. Be sureto

leave the one user account, authorized by your System Administrator that will be used during the
Shakedown Test.

4.6.3 Perform on EVERY PC

The following validation steps should be performed on every PC.

Note: LogintoWindowsNT with Administrator privileges.
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4.6.3.1 Ensure FEMIS Login Security

If the PC has afemis account under Windows NT, make sure that the password is not set to femis.

4.6.3.2 Verify the PC Configuration

Verify each of the following items to make sure the PC’ s configuration is correct.

Icons |eft from previous installations of FEMIS but are no longer linked to a program should be
removed from the Start > Programs - Femis folder.

* KeyPrintisinthe Startup group for all users.
e Virtua memory maximum sizeis set to at least 250MB.
 TheFEMIS startup fileis caled either in each user’s profile or from the All User Startup folder.

e System Environment variable FEMISTOPDIR is defined and set to the directory where FEMIS is
installed.

4.6.3.3 Verify the PC Clock

Verify the PC clock by clicking Start - Settings = Control Panel-> Regional Settings. On the Date tab,
verify your date style is dd-MMM-yy (Day - Month - Year). On the Time tab, make sure you are using
either are a 24-hour clock (upper case “H” in the Time Style field) or a 12-hour clock (lower case “h” in
the Time Style field) with the AM and PM symbol fields set to AM and PM (not case sensitive).

4.6.3.4 Verify the Network Time Protocol (NTP) Service

To verify the Network Time Protocol (NTP) will synchronize with the server for small variationsin time
when the PC is booted up, complete the following steps:

e Click Start - Programs - Administrative Tools - Event Viewer to the Event View window. Under
the Log menu item, select Application. Check for warning or error messages (yellow or red icon) with
NTP asthe source. Troubleshoot as necessary.

» Verify the Network Time Protocol startup is set to Manual.

* Verify thefifth line of CAWINNT\SYSTEM32\AUTOEXNT.BAT has been changed to read
NTPDATE -b <hostname>, where <hostname> is the name of your UNIX server.

» Changethe PC clock to asignificantly different time (1 hour or more).
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* Restart the PC (Start » Shut Down - Restart the Computer).

» Login and verify that the PC clock has been reset correctly.

* FromaDOS prompt, enter the command ntptrace. This should return alist of the serversthat are
used to synchronize time to the PC. If this does not happen, see Section 4.2.7, Validating the
I'\CONFIGD\NTP.CONF File for more information on thisfile.

Note: Do not use Administrator privilegesto perform therest of the validation steps.

4.6.3.5 Verify Login

For Windows NT v4.0, check to make sure a shortcut to FEMIS exists.

» Validate the ability to access the FEMIS application by double clicking on the FEMIS icon.

e Confirm that the correct default Site/EOC is highlighted.

* Enter avalid usercode and password. The Select Mode window should display.

» If there are Oracle problems with FEMIS from a particular Windows NT machine, check its path
(Control Panel > System Environmental Variables). If thereisan Oracle directory (i.e.,
S:\EMISDYN\ORANT\BIN) referenced that is not pointing to where FEMIS installed Oracle (either on
the C:\ or D:\ drive), then this portion of the path must be removed. Check with the other software
vendors, as appropriate, to be sure thiswill not cause problems to their software.

* Veify the ability to enter Operations mode.

4.6.3.6 Verify Data Manager

Select Start © Programs - FEMIS - Data Manager to validate the accessto the FEMIS Data

Administration functionality. If theicon isnot available, select Start > Run and enter or browse to

CA\FEMIS\FDATAMGR.EXE.

4.6.3.7 Verify the System Administration Utility

Select Utility & System Utilities = System Admin from the main FEMIS menu bar to validate the access
to the system administration functionality.
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4.6.3.8 Verify D2PC
Complete the following steps to verify D2PC.

» Click D2PC on the Tracking Navigator. Be patient while the initial connection is made to the D2PC
application and the FEMIS database. D2PC should come up with a default case and should be ready
to run. Select Edit mode.

» Verify the Log Runs checkbox is checked and that you are in Edit mode. From the Run menu, select
the Run Model item. Y ou should quickly get a user interface window containing the results of the
D2PC run.

« Savethe D2PC case.

Note: Onpost users may get messages about sending the D2PC case offpost. Click Yes, and
close the D2PC window.

4.6.3.9 Verify Notification Server

On the Tracking Navigator, you should see a blinking icon (New Data button) that |ooks like a package.
A magenta bar on the D2PC Function box should aso appear. This means that FEMIS data notifications
are being sent and passing messages to your PC. Click the New Data button.

4.6.3.10 Verify GIS

Click the Map button from the FEMIS toolbar. The ArcView GIS application should start, and you
should see a base map displayed within an ArcView GIS window.

To check the link between FEMIS and the GIS, select Facilities theme on the left side of the GIS window.
Click the i+ button on the ArcView GIS toolbar; and then click afacility icon on the map. A view-only
facility/resource window should appear.

Do not closethe Gl Sasit will be used in the following steps.

4.6.3.11 Verify Evacuation

If the one-time validation steps have been successfully completed, there should be a current Evacuation
case displayed on the Tracking Navigator. Click the Evacuation Function box on the Tracking Navigator.
If Evacuation has not been previously executed on this PC, you will get a message telling you to create a
network. Under File, select Create Network. It should display on the GIS. If the network was previously
created on this PC, you will not get the message nor need to create the network. Y ou can merely observe
the network is displayed on the GIS.
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4.6.3.12 Verify Electronic Planning (Planning Mode)

To run FEMIS Electronic Planning in the Planning mode, you must have Microsoft Project |oaded on
your PC and a FEMIS Access Database properly attached. To validate this, click on Utility - Planning
Functions... and select the validation dataset created in the one-time steps (see Section 4.6.1.4, Creste a
Plan for Validation Testing,). Examine the Tracking Navigator window to be sure a Plan has been
selected. Click on Edit under Tasks, which is next to the Plan on the FEMIS Tracking Navigator

(Planning) window. Microsoft Project will open and display the selected Plan. If you can do this without
any errors or error messages, and tasks appear in the grid; then the FEMIS Planning software should work

properly.

The Microsoft Project calendar should be set to a 24-hour clock and a 7-day calendar. Select Tools >
Change Working Time. Every day isgray, and the working timeis 12:00 am. to 12:00 am.

4.6.3.13 Verify Help
Click Help to activate the online Help to verify the Help subsystem is working properly.
4.6.3.14 Verify Printer

Verify KeyPrint was enabled at login. Use KeyPrint or the Print Screen button on any FEMIS window
to ensure the PC is properly connected to a printer.

4.6.3.15 Verify E-mail

Select the MAIL button from the FEMIStoolbar. This should bring up your E-mail application. Verify
that you can send an E-mail message to another PC.

4.6.3.16 Verify SEPR Icon
Send atest SEPR message.
4.6.3.17 Verify FEMIS Tools

Verify on aFEMIS PC with System Toolsinstalled. Click on each of the FEMIS Tools (FEMIS
Monitor PC, FEMISMon Watcher, and Network Monitor) to ensure they are operational.
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Machine Name:

Admin Password:

Task Initials | Notes
1 |4.11Installing Windows NT 4.0
2 |4.113Instaling Windows NT Service Pack 5
3 |4.1.2Instaling an NFS System (Maestro and Patch or Solstice)
4 14.1.3Ingtaling Oracle Net8 Client v8.1.5 and ODBC Driver v8.1.5.5
5 |4.14.1Ingtaling ArcView GISv3.1.1
4.1.4.2 Ingtalling ArcView GISv3.1.1 Patch
6 |4.15Installing Microsoft Project 98 Service Release 1
7 |4.16Instaling Other COTS; Site Specific
8 | 4.2 Configuring the FEMIS Setup Program (Once at Each EOC)
9 |4.2.11 Updating the PC HOSTSFile
10 | 4.3Instaling the FEMIS Client Software
11 | 4.4.2 Running the FEMIS Startup Files
12 | 4.4.3 Verifying Temporary Directory and Environment Variables
13 | 4.4.4 Verifying Clock Settings and Time Zone Settings
14 | 4.4.5 Verifying the Time Synchronization Services
15 | 4.4.6 Setting Virtual Memory Setting (Maximum to at least 250)
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PC Name:

Validated using NT Login:

One Time at Each EOC: Initials Notes
1 | Verify Default D2PC Case Exists
2 | Verify the Evacuation Command Server
3 Only on the server with the depot database, Verify FEMIS/EMIS Data
Exchange Interface (DEI)
4 Create a Plan for Validation Testing
5 | Test the GIS on the Printer
6 | Verify E-malil
7 | Verify that SEPR Icon Addressee
Clean Up AFTER Validation:
1 Delete Validation Datasets
2 Ensure Exercise #1 Exists or Whatever Exercise is Recognized by EMIS
3 Remove Extraneous User Accounts
Perform on Every PC:
1 Ensure Windows NT Login FEMIS/FEMIS Does Not Exist
2 | Verify the PC Configuration
3 | Verify the PC Clock
4 | Verify Network Time Protocol (NTP) Service
5 | Verify Link to M:\ Drive
6 | Verify Login
7 | Verify COTS Software
8 | Verify Data Manager
9 [ Verify System Administration
10 | Verify D2PC
11 | Verify Notification Server
12 | Verify GIS
13 | Verify Evacuation
14 | Verify Electronic Planning
15 | Verify Help
16 | Verify Printer
17 | Verify E-Mall Package:
18 | Verify SEPR Icon
19 | Verify colors are 65,536
20 | Verify FEMIS Tools on Appropriate PC(s)
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5.0 Remote Evacuee Registration and Point to
Point Protocol

5.1 Remote Evacuee Registration

The Remote Evacuee Registration (RER) application can be used in shelters where a network connection
isnot available. It isalso suited for use on portable PCsin situations where the user is required to be
mobile. Evacuee information can be entered and then uploaded to a site's database using a standard
phone connection and PC modem. Use of the application does not require that the user install the entire
FEMIS product line.

To run Remote Evacuee Registration via Dial-Up, your site must have a modem and Point to Point
Protocol (PPP) dia-up software and hardware installed as well as properly configured on the server.

5.2 Installing Remote Evacuee Registration

Remote Evacuee Registration can be installed on a PC as an option using the setup program that installs
FEMIS. If you also need FEMISto run on the PC, use the installation instructions in Section 4.0, FEMIS
PC Installation. Be sure and check the Remote Evacuee Registration checkbox when selecting
components during installation (see Section 4.3.2, Running the Setup Program).

Remote Evacuee Registration needs the following COTSin order for it to be installed and operate
properly:

e  Windows NT Service Pack 5— Section 4.1.1.3, Installing Windows NT Service Pack 5

* NFS software or Samba server daemon (to install Remote Evacuee Registration only) — Section
4.1.2, Installing an NFS System

* Oracle Net8 Client v8.1.5 and ODBC Driver v8.1.5.5 — Section 4.1.3, Installing Oracle Net8 Client
v8.1.5and ODBCVv8.1.5.5

The FEMIS Oracle database on the UNIX server must be operational before the Setup Programis run.
1. Closeall programsthat are running.

2. Connect your I:\ drive as specified in Section 4.2.1, Connecting the Network Install Drive.

3. Runthe \PC\SETUP\SETUP.EXE program.

4. Select your EOC from the drop-down list, and click Next.
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5. Check the Remote Evacuee Registration box.

If you will be installing Remote Evacuee Registration without other FEMIS components (which isan
option), deselect those components (FEMIS and GIS are selected by default).

Click Next.
If the FEMIS GIS s not installed, the following prompt will display: Set Default FEMIS Database
Cannot find the GIS data for <EOC> Do you want to proceed anyway? Click Yes, and then OK to the

warning that follows.

Remote Evacuee Registration needs Dial-Up Networking installed and a Phonebook entry configured for
your EOC’ s dialup service if you intend to use Dial-Up for evacuee registration.

5.3 Setting Up Dial-Up Networking for Windows NT

Setting up Dial-Up Networking for Windows NT consists of verifying the modem has been installed,
configuring the dial-up networking, and connecting via the dial-up network.

5.3.1 Verifying Modem Installation

To verify the modem installation, complete the following steps.

1. Loginto Windows NT as Administrator.

2. Click Start - Settings = Control Panel, and double-click the modem icon.
3. Verify the modemisinstalled.

If no modem isingtalled, the Install New Modem program will execute. Use the vendor’s
recommendation for installing the correct drivers for Windows NT v4.0.

5.3.2 Configuring Dial-Up Networking

Complete the following steps to configure the dial-up network.

1. Loginto Windows NT as Administrator.

2. Click Start - Programs - Accessories = Dial-Up Networking.

3. Follow the promptsto install the software from the Windows NT v4.0 CD if the Dial-Up Networking
has not been previoudly installed.
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8.

9.

If it has been installed but not configured for use, you will be prompted to add a phone book entry.
Click OK.

If you do not get either of these prompts, click the New button on the Dial-Up Networking window.
Enter aname for the phonebook entry you will use to connect to the server. Click Next.

The parameters used to configure your phonebook entry need to be provided to you by the
administrator of the dial-up server on the network you will connect to.

Note: If you do not enter a DNS server, be sure the IP for the FEMIS server and other systems
you wish to connect to on its network are in your hoststable located in the
<WINDIR>\SYSTEM32\DRIVERS\ETC\HOSTS file.

Click Finish to save your phonebook entry.

L ocate an analog phone line that you will connect to your modem.

Click the Location button in the Dial-Up Networking window.

Click New if you have previously configured dialing locations.

Edit the | am dialing from to reflect the location/phone line you are using.

10. Edit all applicableitemsin thiswindow, and click OK.

5.3.3 Connecting Via Dial-Up

Complete the following steps to connect the dial-up network.

1

2.

3.

Login to Windows NT.
Click Start - Programs - Accessories = Dial-Up Networking.

Select your phonebook entry and dialing from location. Be sure your modem is plugged in, and click
Dial.

Enter your user name, password, and domain as required by Dia-Up Server, click OK. The modem
will then attempt to dial the Dial-Up Server.

If you get an After Dial Terminal Window, enter the required user name and password, and click
Done. Contact the Dial-Up Server administrator, if you cannot logon.

To test your connection, bring up a DOS window, enter a ping <FEMIS server>, and verify you get
aresponse.
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5. Disconnect from the server by right clicking on the Dial-Up Networking Monitor icon in the
Task Bar - Hang up - Phonebook entry.

5.4 Verify Remote Evacuee Registration

To test Remote Evacuee Registration viathe Dial-Up do the following steps.

1. Start the Remote Evacuee Registration application. Answer No to the question about being on
the Network.

2. Select the phonebook entry for the FEMIS server in the Profile drop-down window, and click the Dial
& Sync button when the Exchange Server Dial Assistant dialog is displayed.

3. Enter your user name, password, and domain as required by Dial-Up Server, click OK. The modem
will then attempt to dial the Dial-Up Server.

If you get an After Dial Terminal Window, enter the required user name and password, and click
Done. Contact the Dial-Up Server administrator, if you cannot logon.

4. Select your EOC on the FEMIS Login window, and enter your FEMIS user name and password.
Click OK.

5. Select the mode that you would like to test in: either Operations or Exercise (by selecting one of the
available Exercises). Click OK.

The Auto Download Data from Server dialog is displayed. This application will take advantage of the
dialup connection by downloading the contents of the Lookup tables. Downloading the Lookup table
contentswill only take place if the number of records in the Lookup table on the server and the
Lookup tablein the local database are different. Y ou will be warned if there is no data for one of the
tables on the server.

6. Click Close on the Auto Download window. The Dial-Up connection will automatically disconnect
and the FEMIS Remote Evacuee Registration window will close.

7. Exit FEMIS Remote Evacuee Registration.
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6.0 Stand-Alone Installation of FEMIS v1.4.7

The following section contains instructions on the installation of a stand-alone Oracle database and
the configuration of the FEMIS v1.4.7 application on the stand-alone system. Additional
documentation and software that will be required to complete thisinstallation are as follows:

e Oracle8i Server for Windows NT v8.1.6 or Personal Oracle8i v8.1.6.

* FEMISvV1.4.7 COTSCD.

6.1 Stand-Alone PC System Requirements

Since the stand-alone PC will be running an Oracle database as well asthe FEMIS application and
COTS software, the system hardware should be as robust as possible. The following hardware
requirements should be used as minimum reguirements:

* IBM compatible PC with Windows NT v4.0 and Service Pack 5
*  Pentium 266MHz

* 128MB of RAM

*+ CD ROM Drive

* Network Adapter or PC Card

* 800X600 pixels and 256 color Display Graphics

» 2GB of free hard disk space.

6.2 Location of Oracle
The Standalone requires that Oracle8i v8.1.6 database software be installed on the PC. Based on the
space requirements for Oracle8i and Personal Oracle8i for v8.1.5, the amount of disk space required

for aminimal installation of these productsis

o« ~586MB for Oracle8i or Persona OracleS8i
« ~500MB-900MB for FEMIS datafiles.

Space requirements for v8.1.6 were not available at this time.

6.3 Stand-Alone PC Installation Process

The following sections provide instructions for installing the Oracle database and configuring the
FEMIS v1.4.7 application.
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6.3.1 Removing Existing Stand-Alone Database
If you have an existing Oracle7 database ingtalled on the PC, complete the following steps.

1. Delete all shortcuts from the Startup folders. The All User Startup folder islocated in
%WINDIR%\PROFILES\ALL USERS\START MENU\PROGRAMS.

2. Remove the exigting Oracle instance by running the Instance Manager
ORACLE_HOME\bin\oradim73.exe. Select instance and click Delete.

6.3.2 Installing PC COTS and FEMIS v1.4.7

Follow the instructions in Section 4.0, FEMIS PC Installation, to instal the FEMISv1.4.7 COTS and the
FEMIS application.

Be sure to follow the stepsin Section 4.1.3.1 Uninstalling Oracle SQL*Net Client v2.3.4 and Oracle7
ODBC Driver during the install ation of the PC COTS and FEMIS v1.4.7. Y ou should not restor e your
TNSNAMES.ORA and SQLNET.ORA.

Install the Oracle Net8 products at the same location you expect to install Personal Oracle or Oracle8i
Server and keep in mind the space requirements required for the software.

6.3.3 Installing Oracle8i Server or Personal Oracle8i

Toingtal Oracle8i Server Enterprise Edition, Oracle8i Server, or Personal Oracle8i, complete the
following steps:

1. Insert the Oracleinstalation CD into the CD drive.

2. Sdlect Install/Deinstall Products in the window that appears or click Start - Run, and enter
<CD DRIVE>:\ SETUP.EXE.

3. Click Next in the Oracle Universal Installer — Welcome window.

4. Verify the destination Name and Path of the Oracle Home directory (typicaly OraHome81 and
C:\ORACLE\ORA81), and click Next.

Note: You should install Oracle to the same Oracle Home Name and Path as the Net8 Client
was installed during the COTS ingtallation. Thiswill upgrade the installed v8.1.5
componentsto v8.1.6.

5. Select Oracle8i or Personal Oracle8i. Click Next.
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6. Select Minimal Installation Type, and click Next.
7. Select No in the Select Starter Database window, and click Next.
8. Click Install in the Summary window.
Note: You may receive messages the message—Error in writing to file
C:\winnt\system32\<filename>.dll—when the install is copying files to the PC. Browseto
the location of thefile, right click on the file and select properties. Uncheck the Read-
only box and click OK. Then return to the message, and click Retry.
9. Click Cancel in the Net8 Configuration Assistant Welcome window that displays after the installation
iscomplete.
10. Click OK in the Error window that follows.
11. Click Next in the Configuration Tools window.
12. Click Exit in the End of Installation window.

6.3.4 Configuring Oracle Network Components

Before the database instance can be installed, the Net8 components and Listener need to be configured.
Complete the following steps to configure these.

1

2.

Click Start & Programs - Oracle Oracle-OraHome81->Network Administration->Net8 Assistant.
Go to Net8 Configuration = Local, and select Profile.

Go to the Naming section, and select the Methods tab. Use only TNSNAMES as Selected Methods.
To add or remove selected items, use the < and > buttons.

Click the Oracle Names tab, and enter World as Default Domain.
Click File on the menu bar, and select Save Network Configuration.
Click on File, and sdlect Exit.

Click Start - Programs - Oracle Oracle-OraHome81 - Network Administration - Net8
Configuration Assistant.

Select Listener Configuration in the Net8 Configuration Assistant: Welcome window, and click Next.

Select Add, and click Next.
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10. Usethe default Listener name, LISTENER, and click Next.

11. In the Select Protocols window, TCP should be the only item in the Selected Protocols field. Usethe
< and > buttons to add or remove Selected Protocols. Click Next.

12. Use the standard port number of 1521 for the TCP/IP port number. Click Next.
13. Select No for Would you like to configure another listener? Click Next.
14. Click Next for Listener configuration complete!

Y ou will be returned to the Net8 Configuration Assistant: Welcome window.

15. Click Finish.

6.3.5 Building the Database
Complete the following to build the database:

1. Click Start > Programs - Oracle Oracle-OraHome81 - Database Administration - Database
Configuration Assistant.

2. Select Create a database, and click Next.

3. Select Custom for type of database to create. Click Next.

4. Select Multipurpose for Primary type of application that will be used. Click Next.
5. Enter 1 for Concurrently connected users, and click Next.

6. Select Dedicated Server Mode for mode in which you want your database to operate by default.
Click Next.

7. Desdlect the Oracle JServer and verify that only the following items are checked for the Select
Options that will be configured for usein your database window.

Advanced Replication
SQL*Plus Help

Click Next.
8. Enter fi0.world for the Global Database Name. fi0 will be automatically entered for the SID. Accept

the default Initialization Filename location. For Compatible Parameter, select 8.1.0. Do not select
Change Character Set. Click Next.
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0.

10.

11.

12.

13.

14.

15.

16.

17.

18.

Enter a password in the Password and Confirm fields for the Internal privileged account. Keep track
of the password for later use. Click Next.

Accept the default locations and parameters for the Control Files if you are installing on a system that
has only one physical disk. If you have multiple disks, locate the control files on separate disks,
whenever possible. To change the drive location, only change the drive letter and leave the file
location path intact. Click Next.

Change each to the following for the Size parameter of the tablespaces. Each tablespace that is going
to be created by the Oracle Database Configuration Assistant is represented by atab in this window.
Use the default Name, File, Extent and Storage parameters for all tablespaces.

System - 100MB

Tools — 3MB <only in Oracle8i Enterprise Edition>
User — 3MB

Rollback — 50MB

Index — 3MB

Temporary — 20MB

Click Next.
Accept the default location and parameters for the Redo Logs. If you have multiple disks, locate the
Redo Logs on the separate disks, whenever possible. To change the drive location, only change the

drive letter and leave the file location path intact. Click Next.

Accept the defaults Checkpoint Interval and Checkpoint Timeout. Do not check Enable Archive Log.
Click Next.

Accept the default SGA parameter information, and click Next.
Accept the default Trace File Directory locations, and click Next.
Check Create database now. Click Finish.

Click Yes on the Message box that follows to create the instance. This can take up to 1 hour
depending on the speed of your PC.

Note the password information for sys and system in the Oracle Database Configuration Assistant
Alert that displays after the database has been created. Click OK.
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6.3.6 Creating Stand-Alone Working Directory

Complete the following steps to create aworking directory to store the export file, scripts, and log files
which are needed to create a FEMIS database.

1. Click Start > Programs = Windows NT Explorer.

2. Browseto the base directory where Oracle was installed, usually C:\ORACLE.

3. Sdlect the Oracle directory, click File on the menu bar, and select New - Folder.
4. Enter STANDALONE for name of your working directory.

5. Insert the FEMISv1.4.7. COTS CD into the CD drive.

6. Copy the contents of the STANDALONE directory from the CD to the STANDALONE directory on
the PC.

6.3.7 Creating FEMIS Database Tablespaces

To prepare the database for FEMIS data, additional tablespaces and public rollback segments need to be
created.

1. UseWindows NT Explorer to browse to the stand-alone working directory, usually
C:\ORACLE\STANDLALONE.

2. Useatext editor, such as Notepad, to open the CR_TABLESPACE.SQL file.

3. Moaodify, if necessary, the path locations for the FMAIN, FINDEX, FSNAPSHOT, and FSNAPLOG
DATAFILES to be located in the ORADATA folders created by theinstance installation. If you have
multiple hard drives on which to install, preferably locate them on drives other than the drive where

Oraclewasinstalled. If you had three drives, for example:

Oracleinstalled drive C:\ORACLE\ORAS81

FMAIN D:\ORACLE\ORADATA\FIO\FMAINO1.DBF
FINDEX E:\\ORACLE\ORADATA\FIO\FINDEX01.DBF
FSNAPSHOT D:\ORACLE\ORADATA\FIO\FSNAPSHOTO01.DBF
FSNAPLOG E:\\ORACLE\ORADATA\FIO\FSNAPLOGO1.DBF

4. Ensurethe paths specified in the CR_TABLESPACE.SQL exist. If not, create them.
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5. Verify you have sufficient disk space for the datafiles Size parameter in the CR_TABLESPACE.SQL
and room for additional growth when FEMIS datais imported.

Note: Disk space requirementswill vary depending on the amount of FEMIS data that has been
inputted at your site. FMAIN or FSNAPSHOT can exceed 300MB in some installations.

6. Verify at the Command Prompt window that you are located in the stand-al one working directory,
C:\ORACLE\STANDALONE.

7. Enter sglplus system/manager @cr_tablespace.sql a the command prompt.

The script will take afew minutes to create the data files and rollback segments and will exit to the
command prompt when done.

8. Locatethe Instance initidization file, INITFIO.ORA, located in the <INSTALL
DRIVE>\ORACLE\ADMIN\FIO\PFILE.

9. Edit thefile to match the following. Thiswill uncomment the line for private rollback segments.

ROLLBACK_SEGMENTS = (RBSO0, RBS1, RBS2, RBS3, RBS4, RBS5)

6.4 Importing or Changing FEMIS Data

The stand-alone database can use data from the FEMIS database |ocated on the server using export files it
generates. Thisallows you to use current data or specify atime when certain data you wish to usewasin

the database but may have been archived. After astand-alone database has been created, you can use this
section to either make the stand-alone current using the latest exports generated by the server or use ol der
FEMIS v1.4.7 database exports to review older data.

6.4.1 Removing Database Data Owners
Complete this step only if you previously imported datainto the stand-alone database.
1. Click on Start > Programs - Command Prompt. The Command Prompt window will display.
2. Change directories to the stand-alone working directory you created.
cd c:\oracle\standalone<enter>
3. At the command prompt, enter sqlplus —s system/<password> @dropusers.sq|

This script will take several minutes to complete.
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6.4.2 Obtaining FEMIS Database Export

The data needed to create a FEMIS database on the PC is located on the FEMIS server where your EOC's
database resides. Y ou will need to know the password for the oracle account on the server to complete
thisstep. To abtain a FEMIS database export file, complete the following steps:

1. Click on Start > Run. Enter telnet <femis server>.

2. Enter oracle at the login prompt, and press Enter.

3. Enter the oracle user password for the FEMIS server at the password prompt.

4. Enter cd $ORACLE_EXPORT.

5. Enter the command pwd to display your current path and note this for later use.

6. Enter the command Is -l to list the files in the current directory.

7. Determine the FEMIS database export file you wish to use for the database. If you want the most
current data, use the file with the latest date.

Note: The database exports are created nightly by Oracle provided the cron jobs have been
enabled. Thesefilesremain on the system until the oracle cron deletes the ol der files. If
you wish to use older database exports than those that are present, you will need to
restore them from tape backup. The export files are created and named
system_<fi#_date>.dmp and then compressed adding the .Z extension on theend. You
can verify the export was created successfully by viewing the .log file with the same
name.

8. Enter uncompress <export_file.Z> to uncompressthefile. Thiswill take afew minutes depending on
the size of the export file. The export file will the no longer have the .Z extension after it is
uncompressed.

9. EnterIs I to seethe size of the export file you have uncompressed.

10. Go back to the PC, and click on Start>Programs—=>Command Prompt. The Command Prompt
window will display.

11. CD to the stand-alone working directory you created (usually C\ORACLE\STANDALONE).
12. Enter ftp <femis server>.

13. Logon using the oracle user and password.
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14.

15.

16.

17.

18.

19.

20.

Enter cd <export path>. Thisisthe path you observed from the pwd command in Step 8.
Enter bin to establish binary mode.

Enter get system_<fi#_date>.dmp. Thiswill take afew minutes depending on size of export file and
the speed of your network.

Enter quit to return the command prompt after the ftp has successfully finished.
Return to the telnet <femis server> window initiated earlier in this section.
Enter compress system_<fi# date>.dmp. Thiswill take afew minutes.

Enter exit to close the telnet window when the prompt returns.

6.4.3 Importing FEMIS Data into the Database

To import the FEMIS data into the database, complete the following steps. During the execution of the
scripts, ignore the import message “ IMP-00015: following statement failed because the object already
exists:”.

In the command prompt window, you should be located in the stand-alone working directory (usually
C:\ORACLE\STANDALONE).

1

Enter the following at the command line:

imp system/<password> file=system_<fi# date>.dmp inctype=system full=y log=system_import.log
The database configuration assistant assigns the system password to manager. Use this password for
your first import. Thisfirst import will overwrite the system and sys passwords with the passwords
asthey exist in the database on the FEMIS server. Y ou should obtain these passwords from the
System or Database Administrator to use in further imports.

Enter the following at the command line;

imp system/<password> file=system_<fi# date.dmp> inctype=restore full=y log=restore_import.log

Thisimport will take considerably longer than the first import.

The replication jobs imported from the FEMIS database need to be removed to prevent accidental
replication of data from the stand-alone system to the CSEPP site operational servers.

Enter the following at the command line;

sqlplus —s system/<password> @delete_rep_jobs.sql
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Note: Itisessential that the delete_rep_jobs.sql script runs successfully. If not, the database
could potentialy try to replicate data with the FEMIS servers at other EOCs or depot.

6.5 Configuring FEMIS Installation for Stand-Alone Database

When FEMIS was installed from the server, your system was configured for connecting to the server.
The following procedure describes the changes needed for FEMIS to run in a stand-alone mode.

6.5.1 Creating a Local USER Share

To create alocal user share, complete the following steps:
1. Open the Windows Explorer as Administrator.

2. Create adirectory %FEMISTOPDIR%\USER, if it does not already exist. By default thisis
C:\FEMIS\USER, but the actual location will depend upon where FEMIS was installed.

3. Right-click on this directory with your mouse, and select Sharing... from the menu that appears.

4. Select the Shared As: radio button. The Share Name field should have a default value of USER.
Do not change the default value.

5. Click the OK button.

6.5.2 Editing SETSTANDALONE.BAT

The SETSTANDALONE.BAT file needs to be edited so that it can redirect the Oracle Data Source Names
(DSNs) for each EOC to the stand-alone database residing on the local PC.

1. Open %FEMISTOPDIR%\SETSTANDALONE.BAT using atext editor, such as Notepad, to edit the
file.

2. Add callsto ADDODBC.VBS dfter the line stating “ Add calls here:” as documented in the file. You
need one such call for each EOC you plan to log into using the stand-alone database. Y ou may want
to add acall for each EOC at your site.

3. Savethefile and exit.

6.5.3 Running SETSTANDALONE.BAT and SETNETWORKED.BAT

Once it has been configured, the SETSTANDALONE.BAT script file will configure your PC to run FEMIS
in stand-alone mode. The configuration changes made to your PC are
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» changesthe Oracle DSNsto point to the local database listener.
e connectsthe M:\ drive to the USER share on the local PC.

Note: If you do not have a Network card installed on the PC, you may not be able to map drives
even to the local machine. If this occurs, you will need to manually modify your
FEMIS.INI and change all referencesto M:\ to the path of your shared USER directory
i.e., CA\FEMIS\USER. You may want to save your old FEMIS.INI to use when a network
card isreinstalled.
* setsthe RunAsStandAlone entry in the [Notification Service] section of FEMIS.INI to TRUE. Thiswill
cause the FEMIS Notification Service to run in stand-alone mode.

Run the SETNETWORKED.BAT script to return a PC to the standard, networked configuration. Running
SETNETWORKED.BAT will

* runthe FEMIS startup script (%WINDIR%\SYSTEM32\REPL\IMPORT\SCRIPTS\ FSTARTUP.EXE)
to reconnect the M:\ drive to the USER share on the FEMIS server, and run the FEMIS update tool
(FUPDATE.BAT).

e runthe M:\ADDODBC.BAT fileto set the Oracle DSNs to connect to the networked database.

» set the RunAsStandAlone entry in the [Notification Service] section of FEMIS.INI to FALSE. Thiswill
cause the FEMIS Notification Service to run in networked mode.

Note: If you are going to be changing a PC’s configuration between networked and stand-alone
mode, the TNSNAMES.ORA file must be configured for the listener installed on the local
PC and the listeners on the networked FEMIS servers. Use the Net8 Assistant to modify
this file by adding Service Names for your local configuration using the following
parameters:

Net Service Name — fi#.world
Protocol — TCP/IP
Host Name — FEMIS server

Port Number — 1521
(Oracle8i) Service Name — fi#

6.5.4 Correcting D2PC DOS Environment

When the network cable is disconnected from the PC, D2PC cases may take considerably longer to load.
To correct this, the DOS environment needs modified for the D2PC.PIF so it will run correctly.

1. UseWindows Explorer to browse to the WINNT\SYSTEM32 directory.
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N

Edit the AUTOEXEC.NT file using text editor, such as Notepad, and change the line.
Ih %SystemRoot%\system32\dosx

to

REM lh %SystemRoot%\system32\dosx

3. Click on File > Save As, and enter AUTOEXD2.NT for File Name. Click Save, and then close the
text editor (Notepad).

4. Browseto the directory where FEMISisinstaled. Right click on the D2PC.pif and click Properties
(D2PC.pif will have a DOS shortcut icon and may not show the .pif extension).

5. Click onthe Windows NT PIF Settings button in the Program folder.

6. Modify the Autoexec filename to point to %SystemRoot%\SYSTEM32\AUTOEXD2.NT. Click OK,
and close the D2PC.pif Properties window.

6.5.5 Testing the Setup

Y ou should test the stand-alone system by shutting the PC down and removing the system from your
network. After restarting the PC, check to seeif you can start FEMIS. Dataon this PC is completely
separate and different from a PC running FEMI S that connects to the operational database at your EOC.
If your system is not connected to the network, and you have Remote Access Service (RAS) installed,

you might receive a Dial-Up Networking prompt if Auto-Dial isenabled (It is enabled by default.). See
Section 6.6, Remote Access Service, for instructions on disabling Auto-Dial.

6.6 Remote Access Service

If you have Remote Access Service (RAS) installed on the PC (used with Remote Evacuee Registration
[RER]), you may be prompted to use Dial-Up Networking whenever you attempt to connect to the local
database. If you receive this prompt, you can disable this Auto-Dia feature by choosing the following
options:

1. Sdect Yes, Dial when the Dial-Up Networking window displays.

2. Click OK to add an entry, and in the Phonebook entry wizard, click Cancel if you received a prompt
that your Phonebook is empty.

3. Closethe Dia-Up Networking window.
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4. Select Yes to disable the Auto-Dial feature when you receive the foll owing message:
Auto-Dial attempt failed. Do you want to disable auto-dial from this location?

Y ou can turn this feature off before attempting to install the stand-alone database by doing the following:
1. Select an entry to dia from the Phonebook list in Dial-Up Networking.

2. Click on More, and select User Preferences.

3. Clear each location listed in the Enable Auto-Dial by location list on the Dialing tab.

4. Turn on Auto-Dial by reselecting alocation in the Enable Auto-Dial by location list.

6.7 Verifying the Stand-Alone Installation

To verify that the stand-alone installation is complete and that FEMISis fully operational, see

Section 4.7, Validating the FEMIS PC Ingtallation. The FEMIS PC Validation Checklist (at the end of
Section 4.7) includes items that need to be checked to ensure that FEMIS is operating properly.

Because thisis a stand-alone installation, the following items on the checklist do not need to be verified:

OneTimeat Each EOC:

2 Verify the Evacuation Command Server

3 Only on the server with the depot database, verify FEMIS/EMIS Data Exchange Interface (DEI)
6 Verify E-mail

7 Verify SEPR Icon Addressee

Perform on Every PC:

13 | Veify Evacuation

14 | Veify Electronic Planning (Planning M ode)
17 | Veify E-mail

18 | Verify SEPR Icon Addressee

20 | Verify FEMIS Tools on Appropriate PC(s)

If you have adisplay problem with the D2PC window (cannot see the Edit/View and Close buttons at the
bottom of the D2PC window), you will need to change your system display fonts. Click Start >
Settings - Control Panel - Display = Settings tab, and change the Font Size field to Small Fonts.
Reboot the PC to activate this change.
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